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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This document is protected under copyright law. An authorized licensee of Avid ISIS 2000 may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for Avid ISIS 2000. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without 
notice.

Copyright © 2012 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

http://www.apache.org/
http://jcifs.samba.org/
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Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Apple, Macintosh, and Safari are either registered trademarks or trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. HP is a registered trademark of Hewlett-Packard Company. Intel is a registered trademark of Intel Corporation. Java 
is a trademark of Sun Microsystems in the United States and/or other countries. Kingston is a registered trademarks of Kingston 
Technology Corporation. All other marks may be the property of their respective titleholders. Windows is either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein 
are the property of their respective owners. 
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Using This Guide

The Avid ISIS® media network provides a high-performance distributed file system that contains 
high-capacity shared media storage for workgroups of connected Avid® editing workstations.

n This document describes features and setup information for the Avid ISIS 2000 shared storage 
network. Your system might not contain certain features that are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. Follow 
the guidelines in this document or on the unit itself when handling electrical 
equipment.

> This symbol indicates menu commands (and subcommands) in the order you 
select them. For example, File > Import means to open the File menu and 
then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Macintosh), 
or (Linux)

This text indicates that the information applies only to the specified 
operating system, either Windows Macintosh OS X or Linux.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published.

New information would be found in the ReadMe file supplied on your Avid software 
installation kit as a PDF document and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

Accessing the Online Documentation

The Avid ISIS online documentation contains all the product documentation in PDF format. You 
can access the documentation in the AvidISISDocumentation folder on the Avid ISIS installer 
kit. You need to download and install Acrobat Reader on your Avid ISIS before you can access 
the PDF documentation.

n You need to download and install Acrobat Reader on your Avid ISIS before you can access the 
PDF documentation.

To access the online documentation from the installer kit:

1. Insert your Avid ISIS USB flash drive with the Avid ISIS software kit into the USB port.

2. Navigate to the [USB flash drive]:\.AvidISISDocumentation folder, and double-click the 
PDF file for the document you want to view.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/US/support
http://www.avid.com/US/support
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Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support


1 Avid ISIS 2000 System Overview

The Avid ISIS® 2000 system is a nearline product that provides lower cost per gigabit (GB) 
disk-based storage than the ISIS 7500 | 7000 and ISIS 5500 | 5000 real-time storage systems 
(online). This nearline system provides rapid access to material for which real-time output is not 
required, but the performance and accessibility of tape archival storage is not suitable. Avid ISIS 
network storage systems are built for media and entertainment. They enable multiple clients to 
share, capture, play, and edit video and audio media. 

Clients access any combination of ISIS online systems (ISIS 5500 | 5000 and ISIS 7500 | 7000) 
and ISIS nearline systems (ISIS 2000) system through external switch connections. The ISIS 
2000 Management Console provides the same workspace and user functionality offered in all 
ISIS environments. The ISIS 2000 nearline system workflows provides basic video playback of 
low bit rate media and high-speed file transfers to online ISIS systems. 

Avid ISIS 2000 Engines are available in two configurations:

• ISIS 2000-240 — 82, 3 TB drives, providing 240 TB of raw storage which equates to 
192 TB of usable storage

• ISIS 2000-120 — 42, 3 TB drives, providing 120 TB of raw storage which equates to 96 TB 
of usable storage

A typical ISIS 2000 workflow is to move media that is no longer being used in the ISIS 
7500 | 7000 and ISIS 5500 | 5000 online systems to ISIS 2000 Workspaces for longer term 
storage. This frees up faster storage elements for higher performance work. 

The ISIS 2000 is not intended to be used for real time editing of high resolution material, 
although real time playback of resolutions of up to 3 Mb/s or less is supported.

Information that applies to specific models is specified in that section. This chapter provides an 
overview of the Avid ISIS 2000 system and the basic function of each ISIS component. Other 
chapters in this guide describe the cable connections between the ISIS 2000 System Director, the 
ISIS 2000 Engines, and configuring the system.

The following sections explain these components and some basic client configurations:

• System Director

• Engine

• Storage Configurations
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• Client 

• Client 

• Network Zone Configurations

• Cabling

System Director

The Avid ISIS 2000 System Director uses the Windows® Storage Server 2008 R2 operating 
system with Service Pack 1. The Avid ISIS client operating systems that are supported in your 
ISIS software release is listed in the Avid ISIS ReadMe. 

n The Windows Product Key Certificate of Authenticity is attached to the top cover of the Avid ISIS 
System Director.

The System Director is 1U (rack unit) in size (see “System Director Front Panel” on page 16) 
and manages the metadata by storing directory information and file attributes. The System 
Director does not store the data used by share clients (for example media files), these data files 
are stored on the drives within the Engine. 

n The System Director password is preset to is-admin. Not to be confused with the System Director 
Web Page Administrator user whose default password is blank.

System Directors, workgroup servers, and clients must all be synchronized with a common 
time-of-day. For information on setting the Network Time Protocol (NTP), see “Setting-Up the 
Network Address On the Engine” on page 55.

The System Director connects to the ISIS switch through either a 1 Gb or 10 Gb connection. This 
depends mostly on the availability of 10 Gb ports on the ISIS switch. You must use a 10 Gb 
connection to the switch if you plan on using the built-in File Gateway capabilities. The File 
Gateway feature allows you to connect CIFS and FTP clients. When setting up CIFS clients, see 
“Configuring the Server for CIFS Access” on page 111. When setting up FTP clients, see 
“Configuring the Server for FTP Access” on page 116.

The System Director provides a location to coordinate file access modes (read/write), file 
locking, range locking, performance data collection, logging, file lookup, and directory change 
tracking for client systems. Examples of what the System Director is able to provide to a client or 
storage element are:

• Identity of all storage elements connected to the system

• Information about the drives, power, cooling and Engine Controllers in the configuration.

• List of workspaces to include name and their unique ID number



System Director

16

• List of users and groups within the system

• Identity of all System Directors in the system (if you have more than one System Director)

Avid ISIS assures media protection and availability using the following techniques:

• Mirrored system drives are used for system operation and System Director metadata storage.

• A failed system drive can be replaced without interrupting the operation of the Avid ISIS. 

• The 82 media drives are configured into eight RAID 6 groups with two drives reserved as 
hot spares. If any of the RAID drives fail, the Avid ISIS automatically uses the spare drive to 
rebuild the RAID group. The failed drive can be removed and replaced with a new drive 
without interrupting the operation of the Avid ISIS.

System Director Front Panel

The following figure shows the front view and control panel of the System Director.

System Director Front View 

The following table describes the control panel shown in the previous figure.

System disk (ID 1)System disk (ID 0)

ID

ID

Control panel

B CA G HD FE

HALT RST

System Control Panel

Lette
r Component Description

A Universal Serial Bus (USB) 
port

USB 2.0 device port on the front of the system supports one USB 
device. Recommended for use when re-imaging the system drives 
or loading software. Two more USB ports are located on the back 
of the system.
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System Director Rear Panel

The following figure shows the rear panel of the System Director and the function of each 
connection. The System Director comes with a Myricom dual-port 10 Gb network board 
installed in the System Director. Also include is an SFP+ optical transceiver for the port.

B Halt or Non-maskable 
interrupt (NMI) button

The halt or NMI signal halts the processor, which effectively halts 
the server. A NMI is the highest priority interrupt and cannot be 
masked by software. 

c If the Halt/NMI button is pressed, the NMI signal locks 
the system and the system must be restarted to clear the 
interrupt.

C System reset button Performs a soft reset when pressed. Do not use this button unless 
the system has had a fatal error and you need to restart. A soft 
reset restarts the system; it clears all active program memory (you 
lose unsaved work) and shuts down all active programs.

D Four green network activity 
LEDs

Illuminates green when a good network connection is established 
and blinks when there is network activity on the four built-in 
1-GB network ports.

The number beside the LED corresponds with the number beside 
the network port on the rear of the enclosure. For example, 
Connector 1 is LED 1 on the front, see “System Director Rear 
Panel” on page 17.

E Red System error LED Illuminates red when an error is detected with the system (fan, 
power supply, temperature, voltage).

F System Drive activity LED Indicates drive activity from the onboard SATA controller and 
blinks when either of the system drives is being accessed.

G System ID button When pressed it illuminates (blinks) blue and also illuminates an 
LED on the rear of the enclosure. The rear LED is also blue and is 
visible on the lower left-hand side of the Ethernet ports inside of 
the enclosure. It is used to identify a system for servicing when it 
is installed in a high-density rack/cabinet populated with several 
other similar systems.

H Power button Press to power on the enclosure. Power button illuminates green 
when the power is on.

System Control Panel (Continued)

Lette
r Component Description
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System Director Rear View 

Second System Director

You can purchase a second System Director and configure it on the same subnets as the original 
System Director. This provides a redundant System Director that is in constant contact with the 
original System Director. The second System Director automatically takes over if the original 
System Director fails (For more information see “Configuring System Director Resiliency” on 
page 91). 

Engine

The Engine is 5U (rack unit) in size and stores the data shared by the ISIS clients. Up to five 
Engines are supported in the ISIS 2000 environment providing 1.2 petabyte (PB) of raw storage 
(960 TB usable storage). Avid ISIS 2000 Engines are available in two configurations, see “ISIS 
2000-240 Media Drive Configuration” on page 25 and “ISIS 2000-120 Media Drive 
Configuration” on page 26. Both models of Avid ISIS 2000 Engines are populated with 
3 terabytes (TB) SAS drives. These media drives are configured for redundant array of 
independent disks (RAID) 6 storage protection.

Engines can be configured as separate Storage Groups or be added to existing Storage Groups. If 
you choose to add the new Engines to an existing Storage Group, a redistribution of the existing 
data is initiated to spread the data evenly across all drives in the Storage Group. 

The data flows to and from the Engine through the Engine Controller using a 10-Gb Ethernet 
connection. Only the left connector (as seen from the rear of the Engine Engine Rear View) is 
used to connect the Engine to the ISIS switch. This connection provides access to the data on 
media drives to the System Director and clients. The 10-Gb Ethernet ports on both the switch 
and Engine Control require SFP+ transceivers. For instructions on see “Connecting Network 
Cables with a 10 Gb System Director Connection” on page 60.

The Engine contains the following components:

• Engine Front View

• Engine Control Panel

• Engine Rear View

Power supplies Serial 1 Gb Ethernet VideoUSB 10 Gb Ethernet 



Engine

19

• Cooling Modules

• Power Supplies

Engine Front View

Each drawer in the Engine allows access to 42 drive slots. The number of media drives populated 
in each drawer varies depending on your ISIS 2000 Engine configuration (ISIS 2000-240 or ISIS 
2000-120). The first drive slot is located in the front-row, left-side of the top drawer and the last 
drive is in the last row on the far-right portion of the drawer. The second drawer is ordered in the 
same way; left-to-right in each of the three rows starting in the front and ending in the back right 
corner. For more information on the drive slot configuration, see “ISIS 2000-240 Media Drive 
Configuration” on page 25 and “ISIS 2000-120 Media Drive Configuration” on page 26.

Each drive can be removed and replaced separately with the power on. 

n If you replace a drive with power on, the LEDs in all of the drives go off momentarily. This does 
not represent a problem. All functions are still active and working properly.

Engine Control Panel

The following figure shows the ISIS 2000 Engine control panel.

Tamper proof locks (x4)

Control panel

Drawer 1 status and activity indicators

Drawer 2 status and activity indicators
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ISIS 2000 Engine Front Panel 

The following table describes the control panel shown in the previous figure.

Unit ID display

Input switch

Power on / standby

Module fault

Logical status

Drawer 1 fault

Drawer 2 fault

Engine Control Panel

Component Description

Unit ID Display Displays the unit number assigned to the Engine. When a signal is sent 
from the software, the ID number blinks to identify the Engine. This 
helps locate the Engine when it is installed in a high-density 
rack/cabinet populated with several other similar systems.

Input Switch Press to power on the enclosure. 

Power on / Standby Indicator Illuminates green when the power is on. A power switch is located on 
each of the two power supplies on the back of the Engine.

Module Fault Indicator Illuminates amber when an error is detected with the system. The 
following are possible faults.

• On: with single beep, then double beep — power on test state.

• On: any power supply, voltage, fan, module, or temperature (over or 
under) fault 

• Flashing: logical fault — unknown, invalid, or mixed module type 
installed, bus failure (inter communication failure), or EBOD VPD 
configuration error.

• On: Drive failure causing loss of availability or redundancy

• Flashing: when both the Module Fault and Logical Status LEDs are 
flashing, the unit ID number is different from “Start of Day.”
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Engine Rear View

The following figure shows the rear of the Engine in a configuration that contains the following: 

• One Engine Controller (only supported in the left slot as seen from the rear of the Engine)

• Five cooling Modules

• Two power supplies

Cooling Modules

Five cooling modules are powered on when the power supplies are on. They contain fans that 
cool the system. The system only needs three of the five cooling modules to supply the needed 
cooling for the Engine to function properly. You can remove and replace a cooling modules 
while the system is running if one fails.

Logical Status Indicator Flashes amber when arrays are performing a background function. 
When both the Module Fault and Logical Status LEDs are flashing, the 
unit ID number is different from “Start of Day.”

Drawer 1 Fault Indicator Illuminates amber when an fault is detected with a drive, cable, or fan in 
the top drawer. 

Drawer 2 Fault Indicator Illuminates amber when an fault is detected with a drive, cable, or fan in 
the bottom drawer. 

Engine Control Panel (Continued)

Component Description

Engine Controller Cooling module (x5)

Power supply unit (x2)

10 Gb Connection
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c Leave failed modules in place until you have a replacement so you maintain the proper 
airflow. You need to obtain a replacement as soon as possible. 

w Only trained Avid qualified service personnel should remove and replace modules while the 
Engine is running. Since power to the Engine is still applied internally to the midplane, you 
must always keep your hands external to the Engine when a module is removed from the 
Engine.

Power Supplies

The power supplies are powered on when the power cord is plugged in and the power switch is 
on. The power supplies not only provide power, but they also contain fans that cool the system. 
The system only needs one of the two power supplies to supply the needed power to function 
properly. You can remove and replace a power supply temporarily while the system is running if 
one fails.

c Leave failed modules in place until you have a replacement so you maintain the proper 
airflow. You need to obtain a replacement as soon as possible. 

w Only trained Avid qualified service personnel should remove and replace modules while the 
Engine is running. Since power to the Engine is still applied internally to the midplane, you 
must always keep your hands external to the Engine when a module is removed from the 
Engine.

Release latch

Module OK

Battery fault

Fan fault
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Release latch

Power OK

Power supply fault

AC fault

Power Switch

Engine Power Supply Panel

Component Description

Release Latch Displays the unit number assigned to the Engine. When a signal is sent 
from the software, the ID number blinks to identify the Engine. This 
helps locate the Engine when it is installed in a high-density rack/cabinet 
populated with several other similar systems.

Power Supply Fault Indicator Illuminates amber when an error is detected with the system. The 
following are possible faults.

• On: with single beep, then double beep — power on test state.

• On: any power supply, voltage, fan, module, or temperature (over or 
under) fault 

• Flashing: logical fault — unknown, invalid, or mixed module type 
installed, bus failure (inter communication failure), or EBOD VPD 
configuration error.

• On: Drive failure causing loss of availability or redundancy

• Flashing: when both the Module Fault and Logical Status LEDs are 
flashing, the unit ID number is different from “Start of Day.”

AC Input Fault Indicator Flashes amber when arrays are performing a background function. When 
both the Module Fault and Logical Status LEDs are flashing, the unit ID 
number is different from “Start of Day.”

Power on / Standby Indicator Illuminates green when the power is on. A power switch is located on 
each of the two power supplies on the back of the Engine.

Power Switch Press to power on the enclosure. 
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Storage Configurations

Avid ISIS 2000 Engines are populated with 3 terabyte (TB) SAS drives using parity protected 
disk storage utilizing a RAID 6 (redundant array of independent disks, level 6) algorithm. The 
ISIS 2000-240 is a fully populated configuration with 82 media drives providing up to 192 TB. 
These 82 media drives add up to 240 TB of raw storage which equates to 192 TB of usable 
storage (80%) after configuring the RAID set. 

The ISIS 2000-120 is populated with 42 drive between the two drawers. These 42 media drives 
add up to 120 TB of raw storage which equates to 96 TB of usable storage (80%) after 
configuring the RAID set.

Storage Group Size

An ISIS 2000-120 Engine provides one Storage Element. If you have an ISIS 2000-240 then you 
have two Storage Elements. The Storage Element is used to create a Storage Group in the ISIS 
file system (one Storage Group per Engine). The media drives in each Engine are bound into 
Storage Groups. A fully populated ISIS 2000-240 Engine can be bound into one or two Storage 
Groups or you can combine multiple Engines to be a single Storage Group.

If you have Engines configured as in a single Storage Group and want to make two Storage 
Groups, you must delete the Storage Group and create two new Storage Groups. Data is stored in 
the Storage Group in 4 MB chunk sizes. You cannot change the chunk size of a Storage Group.

c When you delete the Storage Group all data on the Storage Group is lost.

RAID-6 Storage Groups, Single Drive

When there is a single drive failure in an ISIS Storage Group configured with RAID protection, 
the Storage Group continues to function normally at a lower bandwidth. 

• Upon the initiation of the single drive removal, all new writes to the Storage Group have the 
full benefit of RAID-6 protection (dual-parity protection). 

• Upon completion of the drive remove process and the RAID set is repaired, existing data in 
the Storage Group is once again fully protected. Prior to completion, if another drive were to 
fail, the Storage Group would be in an unprotected state (though no data would be lost).

RAID-6 Storage Groups, Dual Drive Failure

It is considered an “unprotected state” if you have two failed drives in a RAID-6 Storage Group. 
In an unprotected state with no additional failures, read operations continue to function normally 
at a lower bandwidth. 
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It is highly recommended that you replace any failed drives immediately, to create new hot 
spares for possible future drive failures. This ensures full protection of all stored data at the 
earliest possible time.

Drive Array and Slot Locations

Avid ISIS 2000 Engines are available in two configurations; both configurations are populated 
with 3 TB SAS drives. These media drives are configured for redundant array of independent 
disks (RAID) 6 storage protection.

New installations are created using a common slot configuration. However, once a disk has 
failed, the initial layout changes and the default configuration no longer applies. The numbers 
assigned to the slots and the group numbers are not displayed in the ISIS software. 

• ISIS 2000-240 Media Drive Configuration — 82 media drives providing 240 TB of raw 
storage which equates to 192 TB of usable storage with two spares.

• ISIS 2000-120 Media Drive Configuration — 42 media drives providing 120 TB of raw 
storage which equates to 96 TB of usable storage with two spares.

ISIS 2000-240 Media Drive Configuration

The ISIS 2000-240 has 82 media drives with two drives reserved as hot spares. The drives are 
configured into eight RAID 6 groups (10 drives in each group) in each Avid ISIS-240 Engine. 
The hot spares are automatically used whenever a RAID set detects a degraded drive. This results 
in continued access to your workspace data with no data loss during the failure and repair. 

c The spare drives are created at the end of the last RAID group in bottom drawer when the 
RAID groups are initially configured. Once a drive group has used a spare drive and a new 
spare is established, the original configuration no longer applies. 

240 TB, Drawer 1 (Top) — Initial Media Drive Slot Locations and RAID Groups  
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240 TB, Drawer 2 (Bottom) — Initial Media Drive Slot Locations and RAID Groups  

ISIS 2000-120 Media Drive Configuration

The ISIS 2000-120 has 42 media drives with two drives reserved as hot spares. The drives are 
configured in the Avid ISIS-120 Engine as four RAID 6 groups (10 drives in each group). The 
hot spares are initially created in the bottom drawer and are automatically used whenever a 
RAID set detects a degraded drive. This allows for continued access to your workspace data with 
no data loss during the failure and repair. 

c The spare drives are created in the bottom drawer when the RAID groups are initially 
configured. Once a drive group has used a spare drive and a new spare is established, the 
original configuration no longer applies. 

c When replacing a failed media drive, you must install the replacement drive in the slot 
where you removed the failed drive. Do not install replacement drives in the slots identified 
as “Not Used” in the following illustrations. 
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120 TB, Drawer 1 (Top) — Initial Media Drive Slot Locations and RAID Groups  

120 TB, Drawer 2 (Bottom) — Initial Media Drive Slot Locations and RAID Groups  

Client

The Avid ISIS 2000 systems support 200 ISIS clients using either 1 Gb, dual 1 Gb, and 10 Gb 
connections at any client Type setting. The client communicates with the drives through the 
switch to create, modify, and read files stored in the actual drive. 
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A client uses mechanisms specific to the operating system to display, create, and delete files 
within the Avid ISIS shared storage network system. For example, when viewed from a 
Windows operating system, the system sees a server containing many shares that are mapped to 
drive letters. 

CIFS and FTP Clients

The ISIS 2000 also includes a File Gateway providing unlimited Common Internet File System 
(CIFS) clients, without using Avid ISIS client licenses. This client connection enables network 
users to access the ISIS Workspaces in a non-realtime scenario. Depending on the access 
permission, network users can read, write, and delete files on Workspaces without using ISIS 
client licenses. For instructions on setting up CIFS clients see, “Configuring the Server for CIFS 
Access” on page 111.

n Only System Directors with a 10 Gb connection to the switch support CIFS and FTP clients. 
When using a 1 Gb connection between the ISIS 2000 System Director and the switch, you must 
turn off the CIFS service after you have installed the ISIS 2000 software. Disable the CIFS 
service as described in “Turning Off the CIFS Service With a 1 Gb Connected System Director” 
on page 79.

A client uses mechanisms specific to the operating system to display, create, and delete files 
within the Avid ISIS shared storage network system. For example, when viewed from a 
Windows operating system, the system sees a server containing many shares that are mapped to 
drive letters. The maximum number of Workspaces that can be shared out as a CIFS share is 22 
Workspaces.

You can also configure the System Director to share ISIS Workspaces over the network using the 
File Transfer Protocol (FTP) function controlled by the Microsoft’s Internet Information 
Services (IIS) and the FTP Service. For instructions on setting up FTP clients see, “Configuring 
the Server for FTP Access” on page 116.

Network Zone Configurations

All clients in the shared storage network are classified by zones, depending on how they connect 
to the network. The following list defines the clients in each network layer by their zone 
classification:
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n ISIS 2000 systems typically are integrated with ISIS 7500 | 7000 or ISIS 5500 | 5000 
environments. The ISIS 2000 System Director and ISIS 2000 Engine are connected to ISIS 
7500 | 7000 or ISIS 5500 | 5000 switches that have been configured with a separate VLAN for 
the ISIS 2000 components. See your site network administrator for assistance with configuring 
the separate VLAN on your switch. 

• Zone 1 Client — No Zone one client connection is available in ISIS 2000 (direct connect to 
ISIS 2000 Engine)

• Zone 2 Client — Connected to ISIS VLANs via a 1 Gb or 10 Gb port on an Avid qualified 
layer-2 switch (non-routed)

• Zone 3 Client — Connected to an Avid qualified layer-3 switch (routed) with known Quality 
of Service (QoS); traffic routed to ISIS (one hop) and load-balanced across ISIS VLANs 
(approximately a 60/40 ratio)

• Zone 4 Client — Connected to the house network using an edge or a core switch with 
unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and 
load-balanced across ISIS VLANs (approximately a 60/40 ratio)

Support for different client and device types vary by zone:

• Zone 1 — Not applicable

• Zone 2 — AirSpeed, editors, Interplay

• Zone 3 — Instinct, Assist, certain editors (for example, Avid NewsCutter); typical formats 
include DV25, DV50/IMX-50, MPEG-2 proxy (2 Mb/s)

• Zone 4 — Instinct, Assist; typical formats include DV25, MPEG-2 proxy (2 Mb/s)

The following four examples show different types of Avid ISIS configurations. 

Zone 1 Clients (Direct Connected)

The ISIS 2000 does not provide any client connections directly to the Engine or System Director. 
Client connections are only available through a switch. 

Zone 2 Clients (Indirect Connect) Configuration 

Clients that are connected to a switch are referred to as Zone 2 clients. Zone 2 clients are not 
routed. For a list of supported switches, see the Avid ISIS ReadMe.

A Zone 2 configuration consists of a group of clients, connected to an Ethernet switch with a 
10-Gb port connected to the ISIS 2000 Engine. The System Director also connects to the switch 
using a 1-Gb port or 10-Gb port. Each client connects to the ISIS switch using either a 1 Gb or 
10 Gb connection.
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Avid ISIS Zone 2 Network Configuration

Zone 3 and Zone 4 Client Configuration 

A Zone 3 (indirect connect) configuration consist of a group of clients, connected to an Avid 
qualified layer-3 switch (routed), with known Quality of Service (QoS); traffic routed to ISIS 
(one hop) and load-balanced across ISIS VLANs (approximately a 60/40 ratio).

A Zone 4 (indirect connect) configuration consists of a group of clients, using an Ethernet switch 
with unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and 
load-balanced across ISIS VLANs (approximately a 60/40 ratio).

The house switch should have uplinks to the Avid Production Network through an Ethernet 
switch that contains a 10-Gb port connected to the Engines. The ISIS 2000 System Director also 
connects to the switch using a 1-Gb port or 10-Gb port. The ISIS 2000 can connect to the same 
APN switches as the primary ISIS 7500 | 7000 or ISIS 5500 | 5000, but must use a different 
subnet to other ISIS storage systems.

VLAN Zone 2

Intel Pro 1000 

PT board
Client systems

in Zone 2

1 Gb or 10 Gb Ethernet

10 Gb Ethernet

Zone 2 switch with 

1-Gb and 10-Gb Ports

Engine

System Director
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Avid ISIS Zone 3 and Zone 4 Network Configuration

Cabling

For a list of cables qualified with the Avid ISIS system, see “Supported Cabling” on page 192. 
The following sections provide cabling information you should know when cabling your Avid 
ISIS stack. 

Zone 4

Zone 3
House switch

Zone 3 client 

routed VLAN 40

Zone 4 clients 

corporate network

ISIS 7000

Client systems

in Zone 1
Chassis 

interconnect

ISS VLAN 10 ISS VLAN 20

Engine

Engine

System Director

ISS VLAN 20ISS VLAN 10 

System Director

Zone 2

Avid Production Network (Zone 1, 2, and 3)

1 Gb Ethernet

VLAN 10 VLAN 20

VLAN 40

Zone 3 layer 3 switch

(Layer 3 routed/switched)

VLAN 10 VLAN 20
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2 Connecting the ISIS Equipment

This chapter explains how to rackmount and connect the system hardware. To do this, a system 
installation check list is provided to help you perform the installation in the correct order. The 
installation check list continues past the information in this chapter and points you to the correct 
area in this document or the ReadMe file to continue the installation. 

This chapter contains the following information:

• Rack-Mounting the Equipment

• Opening and Closing the Media Drive Drawers

• Installing the Media Drives

• Installing the Cooling Modules

• Installing the Power Supplies

• Installing the Engine Controller

• Connecting Power to Equipment

• Connecting a Keyboard, Monitor, and Mouse

• Setting-Up the Network Address On the Engine

• Connecting Network Cables with a 1 Gb System Director Connection

• Connecting Network Cables with a 10 Gb System Director Connection

n For information on connecting and configuring two System Directors for failover, see 
“Configuring System Director Resiliency” on page 91.

Rack-Mounting the Equipment

This chapter describes how to install and connect the System Director and other workgroup 
hardware. 

c Information concerning power and dimensions are provided “Specifications and Notices” 
on page 190. 
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Rack-Mounting Example

The following example shows a typical ISIS 2000 rack configuration with a System Director and 
Engine. 

ISIS 2000 System Director and Engine

Installing Rack-Mount Rails and Brackets

The System Director is designed for 19-inch (483-mm) rack configurations and requires one EIA 
rack units (1U), or 1.75 inches (44.45 mm) of rack space. The rail kit installs into rails that are 
between 23-inches (584.2-mm) to 31-inches (787.4-mm) inches deep. An optional rail kit is 
available for racks that are up to 37 inches deep.

The System Director includes rack mounting slide rails. If instructions are included with your 
rail kit, use them instead of the instructions included in this section. The standard rail 
configuration is for racks with square mounting holes. Optional brackets are included for racks 
with threaded holes. The rack-mounting kit requires inner slide rails be mounted to the server 
and the outer slide rails are mounted to the rack. Once both the inner and outer rails are in place, 
slide the server with the inner rails attached into the outer rails. Secure the server in the front of 
the rack using the supplied screws so it does not slide forward. 

c The System Director is designed to be installed horizontally in a rack. Installing the System 
Director on an angle or in a sloped console causes the internal drives to wear faster than 
the intended life of the drive.

w To ensure the stability of the rack enclosure, start with heaviest equipment installed at the 
bottom of the rack enclosure. Lighter equipment goes towards the middle and top.

System Director 

1 rack unit
ID

ISIS 2000 Engine

5 rack units
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The following are recommendations you should take into account prior to rack-mounting Avid 
ISIS equipment:

• Avid recommends that you leave a 1U or .5U space between each piece of equipment 
mounted in the racks. This allows for better airflow and cable access, and helps stop 
vibration in any equipment being transferred to spaces above and below. 

n The 1U System Director has vent holes on the top of the enclosure. Avid has performed thermal 
testing with the top vent holes blocked, and the results indicated that even with the top vent holes 
blocked, the 1U System Director still operates within the temperature tolerances.

• Avid recommends that you leave an 8 to 12 inch space at the bottom of the rack. This allows 
for better airflow and lowers the possibility of dust or dirt being picked up by the devices.

• For normal operation, you’ll need to maintain approximately 2 feet (0.6 meters) of open 
space in front of and behind the rack. This allows free access to the components in the rack 
for operating changes or adjustments. For service, you need approximately 3 feet (1 meter) 
of open space in front of the rack and 2 feet (0.6 meters) of open space behind the rack. This 
allows for the removal of any component that needs to be replaced.

Rack-mount Requirements

• Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, the 
operating ambient temperature of the rack environment might be greater than room ambient. 
Therefore, consider installing the equipment in an environment compatible with the 
maximum ambient temperature (Tma) specified by the manufacturer.

• Reduced Air Flow — Installation of the equipment in a rack should be such that the amount 
of air flow required for safe operation of the equipment is not compromised.

Avid ISIS airflow is from the front of the enclosure to the rear. Make allowances for cooling 
air to be available to the front panel surface and no restrictions at the rear.

• Mechanical Loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

Make sure your rack enclosure is stable enough to prevent tipping over when one or more 
Avid ISIS servers are extended on the sliding rails.

• Circuit Overloading — Consideration should be given to the connection of the equipment to 
the supply circuit and the effect that overloading of the circuits might have on overcurrent 
protection and supply wiring. Appropriate consideration of equipment nameplate ratings 
should be used when addressing this concern.

• Reliable Grounding — Reliable grounding of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other than direct 
connections to the branch circuit (for example, use of power strips).

• Inside Enclosure Access — If you want to extend the enclosure, and remove the top cover, 
you must allow 0.5 in (1.3 cm) clearance on top of the enclosure for cover removal.
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Positioning the server in the Rack

The following information helps you decide where to install the System Director in the rack. 

To position the System Director in the rack enclosure:

t Select a position in the rack where the System Director is at the proper baseline position.

Positioning the System Director

Separating the Slide Rails

You need to separate the slide rails and attach the inner “movable” section to the System Director 
and the outer “fixed” section to the rack rails. 

To separate the slide rails:

1. Slide the slide rail completely open.

2. Press the spring clip on the inner slide rail as shown in the illustration.

n The blowup of the spring clip shown in the illustration is on the bottom side of the slide rail.

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

1U

2U

3U1 3/4 in

1 3/4 in

1 3/4 in
Baseline position is between 
two 1/2inch holes.

Rack mounting rail 
hole spacing

EIA rack unit

Rack mounting rail

System Director
front panel mounting hole
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Separating the Slide Rails

3. Pull and separate the two halves.

4. Repeat these steps to separate the second slide rail.

Attaching Inner Slide Rails to the System Director

Attach the inner slide rails that were separated from the outer slide rails to the System Director.

To attach the inner slide rails:

1. Position the inner slide rail against the side of the server so that the screw holes are toward 
the rear of the server, and front of the slide rail fits over the tab at the front of the server.

2. Secure the inner slide rail to the server with two of the small screws.

n You might find more screws in the rail kit than is needed, and described in this procedure.
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Attaching the Inner Slide Rails

3. Repeat this procedure to attach the other inner slide rail on the other side of the server.

Attaching the Outer Rails to a Square-Hole Rack

After separating the slide rails as previously described (see “Separating the Slide Rails” on 
page 35), perform the following procedure. If your mounting rails have threaded holes, see 
“Attaching the Outer Rails to a Threaded-Hole Rack” on page 39. 

To attach the outer slide rails to the rack with square holes:

1. Align the outer slide rail bracket assembly with the front rack-mounding holes.

n You should have someone helping you hold the slide rails level while you are positioning them in 
the rack.

2. Slide the square tabs through the holes in the front, vertical rack-mounting rail. 
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Positioning the Outer Slide Rail with the Front Rack-Mounting Rail

3. Push the outer rail towards the outside of the rack, to secure the outer rail in place

Insert the Outer Slide Rail to the Front Rack-Mounting Rail

4. Adjust the outer slide rail bracket assembly to the rear mounting rail.

5. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.
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Securing the Outer Slide Rail to the Rear Rack-Mounting Rail

6. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 

Attaching the Outer Rails to a Threaded-Hole Rack

After separating the slide rails as previously described (see “Separating the Slide Rails” on 
page 35), perform the following procedure. If your mounting rails have threaded holes, you first 
need to clip on the threaded hole adapter. 

To attach the outer slide rails to the rack with threaded holes:

1. Locate the four threaded hole adapters (which ship in the accessory kit's plastic bag, not in 
the rack mount kit box) and position the adapter on the end of the outer slide rail bracket 
assembly as shown in the following illustration. 

Attaching the Threaded Hole Adapter to the Bracket Assembly 

Round hole adapter

Outer slide rail bracket assembly

Bracket assembly tabs
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2. With the bracket assembly tabs aligning with the cut-out in the threaded hole adapter, swing 
the adapter so that the holes face the front of the bracket assemble as shown in the following 
illustration. 

Positioning the Threaded Hole Adapter

3. Slide the outer slide rail bracket assembly onto the side rack-mounting rail so that the 
threaded hole adapter is over the rack rail. 

n You should have someone helping you hold the slide rails level while you are positioning them in 
the rack.

Insert the Outer Slide Rail to the Front Rack-Mounting Rail

4. Insert the small (10-32) Phillips-head screws through the threaded-hole adapter and 
mounting rail, into the bracket. If the rack holes are different size, you need to supply your 
own screws
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Securing the Outer Slide Rail to the Rack-Mounting Rail

5. Adjust the outer slide rail bracket assembly to the rear mounting rail.

6. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.

7. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 

Securing the System Director in a Rack

c You should have someone helping you lift the System Director while you are positioning it 
into the slide rails.

To secure the server to the rack enclosure:

1. Lift and position the server so that the inner slide rails (secured to the System Director) are 
aligned with the outer slide rails secured to the rack.

2. Push the front of the System Director server flush against the front mounting rail. The holes 
in the server front panel align with the holes in the front mounting rail.

3. From the front of the rack enclosure, insert the large Phillips-head screw through the System 
Director and front mounting rail. 

- Square hole racks — the middle hole of the outer rail kit is where the screw anchors the 
server front panel to the vertical rail. A M6x10 screw in the parts kit is included to 
secure the front panel with square hole racks.

- Threaded hole racks — the server front panel attaches to the vertical rail of the rack. Use 
a truss head screw or hardware that come with your rack to secure the front panel with 
threaded hole racks.
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Front Panel Screws

Mounting the Engine

The ISIS 2000 Engine is designed for 19-inch (483-mm) rack configurations and requires five 
EIA rack units (5U), or 8.75 inches (222.25 mm) of rack space. The ISIS 2000 rackmount rails 
are designed for racks with square or threaded holes. This procedure focuses on racks with 
threaded holes. Additional instructions are included on a decal located on the side of one of the 
bracket rails. 

n Do not lift the Engine by the handles on the power supply units, cooling modules or Engine 
Controllers – they are not designed to take the weight. 

w Lifting the Engine with the drives, cooling modules, and power supplies installed can cause 
an injury. The Engine must have all modules and drives removed prior to lifting. Avid 
recommends that two people be used whenever lifting the empty Engine. 

Rack enclosure 

front mounting rail
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To mount the Engine into the rack:

1. (Option) If using racks with threaded holes, you need to unscrew and remove the five round 
pegs on each end of the bracket rail. 

2. Loosen the four slide adjustment screws so that the bracket rail side allows you to adjust the 
bracket rail to the depth of your rack.

The adjustment screws are highlighted in a colored circle around the screw.

3. Position the bracket rail between your rackmount rails and adjust the length of the bracket so 
that is meets the inside of both the front and rear rails as shown in the following figure.

Slide adjustment screws

Round pegs

Bracket rail

Rack mount screws

Bracket rail

Rack enclosure

Mounting rails
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4. Secure the bracket rail to the front and rear mounting rails using either the screws that come 
with the rack mount kit of your rack screws (five screws in the front and the rear). 

n  Leave the top most holes on the front of the rail empty so you can use those holes to screw 
through the ears on the Engine to keep it from sliding forward once racked.

5. Tighten the four slide adjustment screws.

6. Repeat steps 1 through 5 to install the other bracket rail on the opposite side of the rack.

7. Make sure that the media drives are not installed in the Engine.

8. Using two people, lift the Engine and place the rear of the Engine onto the brackets as shown 
in the following figure. 

9. Position the bracket extender on the outside of the rear mounting rail so that the sliding nut 
in the bracket extender inserts into the rack mounting tab on the Engine. Using the short 
screws included in the rack mount kit, secure the bracket extender to the rack mounting tab 
on the Engine as shown in the following figure.

The rack mount kit provides two sets of bracket extenders: a long pair and short pair. Use the 
pair of bracket extenders that are most appropriate for your rack. Racks with less depth, 
would need the longer bracket extenders.
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10. Screw the front of the Engine to the front of the rack through top and bottom holes of the 
plastic end caps on each side of the Engine as shown in the following figure using the screws 
included in the rack mount kit.

Bracket extender

Rack mounting tab

Sliding nut

Plastic covers

Plastic end caps
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11. Secure the rear stabilizer brackets to the rear rackmount rails through top and bottom holes 
in the extender bracket as shown in the preceding figure using the screws included in the 
rack mount kit or your rack screws.

12. Snap the left and right plastic covers over the plastic end caps on the front Engine as shown 
in the preceding figure.

Opening and Closing the Media Drive Drawers

This section covers how to open the media drive drawer and replace a media drive. The 
procedure is the same for both drawer 1 and drawer 2. 

w To ensure the stability of the rack enclosure, The Engine includes a mechanism that only 
allows one drawer to be open at a time. If both drawers were open at the same time, there is 
a risk that the rack could tip. 

To open a drive drawer:

1. Make sure the anti-tamper locks are not engaged. The red arrows on the locks will point 
inwards if the locks are disengaged. Unlock them if necessary by rotating them 
counterclockwise using a screwdriver with a Torx T20 bit.

2. Push the drawer latches inward and hold them.

3. Slowly pull the drawer all the way out until it locks open.
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To close a drive drawer:

1. Pull and hold both of the white latches on the sides of the drawer.

n You might need to pull the drawer completely open before pulling the white latches. 

2. Push the drawer in slightly.

3. Release the white latches.

4. Slowly push the drawer all the way back into the Engine, making sure it clicks in place.

c Take care not to push the drawer in hard or to slam it shut, doing so could potential 
damage the drives or the drawer.
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Installing the Media Drives

This section describes how to install a media drive. The procedure for installing the media drives 
is the same for both drawer 1 and drawer 2. The location on where the media drives get installed 
is different between the two ISIS 2000 Engine configurations.

• ISIS 2000-240 Media Drive Configuration (1 Engine, with 82 drives) — There are 41 drives 
in each drawer. 

• ISIS 2000-120 Media Drive Configuration(1 Engine, with 42 drives) — There are 28 drives 
installed in the front-most slots of the top drawer. The last 14 drives are installed in the 
front-most slots of the bottom drawer. 

c The ISIS 2000-120 media drive configuration is mandatory. You must install the drives in 
the slots specified, This is an air-flow requirement and is enforced with the software.

To insert a media drive:

1. Make sure the anti-tamper locks are not engaged. The red arrows on the locks will point 
inwards if the locks are disengaged. Unlock them if necessary by rotating them 
counterclockwise using a screwdriver with a torx T20 bit.

2. If the appropriate drawer is not already open, open it using the instructions in section 
Opening and Closing the Media Drive Drawers.

3. Lower the Media Drive into the slot, with the drive capacity label facing towards you.
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4. Push the media drive downwards and hold it down while sliding the drive carrier plate in the 
direction shown in the following figure. This locks the drive in place.

5. Repeat this procedure to install the remaining media drives in the open drawer as follows; 
depending on your ISIS 2000 Engine configuration.

t ISIS 2000-240 — using the following illustration, populate 41 media drives in each 
drawer. Do not populate the Drive 0 and Drive 42 slots. For more information on drive 
slots, see “ISIS 2000-240 Media Drive Configuration” on page 25.

t ISIS 2000-120 — using the following illustration, populate 28 media drives in the 
front-most slots of the top drawer (drive slots 0 to 27). Populate 14 media drives in the 
front-most slots of the bottom drawer (drive slots 42 to 55). For more information on 
drive slots, see “ISIS 2000-120 Media Drive Configuration” on page 26.

c Do not open both drawers simultaneously.
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6. After populating one drawer, close it and populate the second drawer, see “Opening and 
Closing the Media Drive Drawers” on page 46.

Installing the Cooling Modules

This section describes how to install the cooling module. 

To insert a cooling module:

1. Position the cooling module so that the red release latch and handle are on the right-hand 
side.

2. Slide the cooling module into its slot until the latch clicks in place. 

3. Repeat this procedure to install the remaining four cooling modules into the cooling module 
slots. 

Installing the Power Supplies

This section describes how to install the power supplies. 

To insert a power supply:

1. Position the power supply so that the red release latch and handle are on the left-hand side.

2. Slide the power supply into its slot until the latch clicks in place. 
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3. Repeat this procedure to install the second power into the second power supply slot. 

Installing the Engine Controller

This section describes how to install the Engine Controller. 

n The Engine Controller must be in the left slot (when viewed from rear of Engine). The software 
does not run if Engine Controller is in the right slot.

To insert an Engine Controller:

1. Position the Engine Controller so that the release latch is at the bottom.

2. Open the release latch and rotate it to its most open position.

3. Slide the Engine Controller into its slot until it will go no further.

4. Close the latch until it clicks in place. This will lever the module into its connector on the 
midplane. The Engine will automatically detect the new unit.

n The Engine Controller shown in the illustration is for reference only, the actual Engine 
Controller used in the ISIS 2000 Engine varies from the model shown in the picture.
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Connecting Power to Equipment

The Avid ISIS 2000 System Director and Engine include each two power supplies for 
redundancy. At least one of the power supplies must be operational for the either the System 
Director or Engine to function. If a power supply fails, leave it in place until you have a 
replacement. The System Director and Engine can each operate on one power supply, but you are 
running in an unprotected mode. 

The ISIS 2000 Engine cooling modules provides airflow for the Engine. A failed module should 
be left in place until a replacement is available in order to ensure proper airflow is maintained.

The power cable that comes with the ISIS 2000 Engine is a C19 to C20 power cable. The C19 
end is a female connector which plugs into the power supply on the Engine. The C20 end is a 
male connector, used to plug into a Power Distribution Unit (PDU) with C19 style connectors. 

An example of a PDU is the APC® Basic Rack PDU with C19 208-240V outputs and a twist lock 
NEMA LP6-30 input: 
http://www.apc.com/products/resource/include/techspec_index.cfm?base_sku=AP9570

http://www.apc.com/products/resource/include/techspec_index.cfm?base_sku=AP9570
http://www.apc.com/products/resource/include/techspec_index.cfm?base_sku=AP9570
http://www.apc.com/products/resource/include/techspec_index.cfm?base_sku=AP9570
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n Avid is not recommending any specific vendor or model of PDU. A PDU is a rackmount ready, 
high current power strip that can offer a variety of plug types. Purchase a model that suits the 
needs of the equipment in your rack. 

Each ISIS 2000 Engine power supply draws a maximum of 13 amps of current using 220 Vac. 
Each power supply in the Engine should be connected to a different 30-amp circuit. This allows 
the system to continue running if one of the two circuits fail. 

Each System Director has two power supplies rated at 5.8 amps each. Avid recommends each 
power supplies be on a separated 20-amp circuit. 

Connecting Power Cords

When using two circuits for the System Director and Engine they should be configured as 
follows:

To connect the power cords to the System Director and Engine:

1. Plug two power cords into the back of the System Director and then plug the other ends into 
120v power outlets on separate circuits.

2. Plug two power cords into the back of the Engine and then plug the other ends into 220v 
power outlets on separate circuits.

Power Connections

Turning System On and Off

To turn the ISIS system on or off, use the following order. Do not turn off the Avid ISIS 
components until they have completely powered on.

System Director

220 Volts

30 Amps

Engine

220 Volts

30 Amps

120 Volts

20 Amps

120 Volts

20 Amps
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To turn your system on:

1. Turn on the Engine by switching the power switch to the on position on each power supply 
module. Allow enough time for the lights on the front panel to turn Green.

2. Turn on the System Director.

3. Clients should restart their systems and use the Client Manager software to log on and mount 
workspaces.

To turn your system off:

1. Exit the Client Manager on all clients.

2. Stop the System Director service using the System Director Control Panel.

3. Turn off the System Director. 

4. Turn off the Engine using the switch on the power supply module.

Connecting a Keyboard, Monitor, and Mouse

An industry standard USB keyboard, USB mouse and VGA monitor are used to access the 
System Director. When installed in a rack with several servers an optional KVM switch can also 
be used. The keyboard, monitor, and mouse connections use the same ports described in the 
following procedure. Follow the instruction supplied with your KVM switch. You need to supply 
KVM cables that are compatible with your KVM switch.

n There are only two USB ports on the rear of the System Director. When you purchase your KVM, 
consider a USB splitter cable so that both your keyboard and mouse can plug into the splitter 
cable and use a single USB port on the System Director.

To connect a keyboard, monitor, and mouse to the Avid ISIS:

1. Install your KVM switch in a suitable slot next to the System Director in the rack. 

You can also place the monitor on a shelf, and the keyboard and mouse on a sliding tray in 
the rack. These items are optional and can be purchased locally or from Avid.

c Do not place the monitor on top of the Avid ISIS.

2. Attach the VGA connector on the monitor cable to the 15-pin video port on the back of the 
Avid ISIS. Secure the connector with the thumbscrews on the connector. For exact locations 
see “System Director Rear Panel” on page 17.

3. Insert the connector on the keyboard and mouse cables into a USB splitter cable.

n If you do not have a USB splitter cable, plug your keyboard and mouse cables directly into the 
USB ports on the rear of the System Director.
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4. Insert the other end of the USB splitter cable into a USB connector on the back of the 
System Director. 

Setting-Up the Network Address On the Engine

The following procedure describes how to configure the Engine. 

To configure the engine:

1. Ensure the Engine has been powered on. 

You should allow about 2 minutes for the Engine to reach a ready status. 

2. Power on the System Director.

3. You are asked for the user name and password. Type administrator for the user with a 
password of is-admin.

n The System Director password is preset to is-admin. The System Director Management Console 
Web Page Administrator user whose default password is blank.

The following static IP addresses have been pre-configured on the ISIS 2000 Engine.

- IP addresses 192.168.0.10

- Subnet mask 255.255.255.0

n Make sure no DHCP servers are assigning addresses in the Avid ISIS range. 

4. Using a System Director (or computer running a Windows operating system), assign a static 
IP address of 192.168.0.11 to the 1 Gb Management Port of the System Director and 
attach it to the management port of the Engine (left 1 Gb port on Engine Controller).

The following example shows the physical connection between a System Director and 
Engine for configuring the IP Address of the Engine Controller. 
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System Director 1 Gb and Engine 1 Gb Management Ports Connections

5. Open a browser and navigate to the ISIS 2000 Storage Manager Agent Web page via the 
following address: https://192.168.0.10:5015.

6. You are asked for the password. Type se-admin.

7. Click Network in the left pane of the System tab. 

The ISIS 2000 Storage Manager Agent page appears.

1 Gb connection 1 Gb managment ports
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8. Type the following into the Basic Network Configuration window:

- Type the Hostname you want for you Engine Controller.

- (Option) If using a Gateway, select the Default Gateway checkbox and enter the 
IP addresses of your default gateway.

If you are going to be using a Zone 3 environment you must set the default gateway 
addresses for the Engine. These addresses must come from the site’s IS department.

n Make sure no DHCP servers are assigning addresses in the Avid ISIS range.

- Enter an IP addresses and Netmask address in the Data Interfaces in the gx0 text boxes. 

9. Click Submit.

A dialog box might appear with an informational warning to restart the Engine; click the 
restart button, enter the “se-admin” password, and the system will restart. 
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10. Return to the ISIS 2000 Storage Manager Agent page again and click Time in the left pane 
of the System tab and do one the following. 

t If using a network time servers, enter the IP addresses of your network time servers.

If your network has a network time protocol (NTP) server, you can enter the IP address 
of that server in the Chassis Configuration window. NTP Server 1 is for the primary 
NTP server and if you have a secondary NTP server, enter the secondary IP address in 
NTP Server 2.

t If not using a network time server, manually enter the Date, Time, and Time Zone or 
Enable network time protocol.

11. Click Submit.

A dialog box might appear with an informational warning to restart the Engine; click the 
restart button, enter the “se-admin” password, and the system will restart. The Engine is now 
properly addressed.

12. Assign appropriate static IP address to the network port of the System Director.

13. Attach the System Director to the switch and verify that you can ping the System Director 
from another system on the network.

Connecting Network Cables with a 1 Gb System 
Director Connection

Connect the ISIS 2000 System Director with a 1 Gb cable and the Engine with a 10 Gb Ethernet 
cable to the switch as described in this section.

n Only System Directors with a 10 Gb connection to the switch support CIFS and FTP clients. 
When using a 1 Gb connection between the ISIS 2000 System Director and the switch, you must 
turn off the CIFS service after you have installed the ISIS 2000 software. Disable the CIFS 
service as described in Turning Off the CIFS Service With a 1 Gb Connected System Director.

n The network switch used in the illustrations in the section is the Force10 S4810 switch. For an 
up-to-date list of ISIS 2000 switches, see the Avid ISIS ReadMe.
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To cable the ISIS 2000 system using 1 Gb port:

1. Connect a CAT 5e or CAT 6 Ethernet cable to the lower right-hand 1 Gb port on the rear of 
the System Director. No other 1 Gb port on the System Director has been configured for this 
connection. 

System Director’s 1 Gb Connection

2. Connect the other end of your network cable to the appropriate port on your ISIS 2000 
switch. 

The following example shows the physical connections between a System Director, Engine, 
and a Force10 S4810 switch. 

System Director 1 Gb and Engine 10 Gb Network Connections to Switch

1 Gb managment port 1 Gb Ethernet 

1 Gb connection

10 Gb connection 

To client - 

1 Gb connection  

Force10 4810 switch with 

1 Gb and 10 Gb connections 

10 Gb Ethernet LC to LC connection
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3. Connect a 10 Gb optical network cable to left 10 Gb port (as seen from the rear of the 
Engine) on the Engine Controller of the ISIS 2000 Engine. No other 10 Gb port on the 
Engine has been configured for this connection.

The 10 Gb port on the ISIS 2000 Engine Controller requires an SFP+ transceiver. When 
using SFP+ transceivers, Short Range (SR) is the preferred choice over Long Range (LR).

4. Connect the other end of the 10 Gb network cable to a 10 Gb port on your ISIS 2000 switch. 

Depending on the type of switch you have, an X2 or SFP+ transceiver might be needed for 
the switch port.

n The Force10 S4810 switches need SFP+ transceivers with an LC to LC cable connection. The 
Cisco 4900M switches need an X2 transceiver for the SC type connector with an LC to SC cable 
connection. 

5. When using a 1 Gb connection between the ISIS 2000 System Director and the switch, you 
must turn off the CIFS service after you have installed the ISIS 2000 software. 

a. The first time you set up the ISIS 2000 Engine you must connect to the Management 
port to on the Engine Controller to configure the IP address, see “Setting-Up the 
Network Address On the Engine” on page 55.

b. Install the ISIS 2000 software as described in Loading the Software.

c. Disable the CIFS service as described in Turning Off the CIFS Service With a 1 Gb 
Connected System Director.

Connecting Network Cables with a 10 Gb System 
Director Connection

Connect the ISIS 2000 System Director and Engine to the switch using 10 Gb Ethernet cables as 
described in this section.

Depending on the type of switch you have, an X2 or SFP+ transceiver is needed for your 10 Gb 
port connections. When using SFP+ transceivers, Short Range (SR) is the preferred choice over 
Long Range (LR). The 10 Gb ports on the System Director and the Force10 S4810 switches need 
an SFP+ transceiver for LC type connectors. The Cisco 4900M switches need an X2 transceiver 
for SC type connectors. For more information on ISIS cables and transceivers, see “Supported 
Cabling” on page 192.

n The network switch used in the illustrations in the section is the Force10 S4810 switch. For an 
up-to-date list of ISIS 2000 switches, see the Avid ISIS ReadMe.
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To cable the ISIS 2000 system:

1. Connect an optical cable to the 10 Gb port on the System Director.

a. Insert an SFP+ transceiver into either 10 Gb Ethernet connector in the Avid ISIS 2000 
System Director.

b. Connect the optical cable into the SFP+ transceiver you inserted into the 10 Gb port on 
the ISIS 2000 Engine. 

System Director’s 10 Gb Connection with SFP+ Transceiver

2. Connect the other end of your network cable to the appropriate port on your ISIS 2000 
switch. 

Depending on the type of switch you have, an X2 or SFP+ transceiver might be needed for 
the switch port.

n The Force10 S4810 switches need SFP+ transceivers with an LC to LC cable connection. The 
Cisco 4900M switches need an X2 transceiver for the SC type connector with an LC to SC cable 
connection. 

The following example shows the physical connections between a System Director, Engine, 
and a Force10 S4810 switch. 

1 Gb managment port 10 Gb Ethernet 1 Gb Ethernet 
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System Director and Engine 10 Gb Network Connections to Switch

3. Connect a 10 Gb optical network cable to left 10 Gb port (as seen from the rear of the 
Engine) on the Engine Controller of the ISIS 2000 Engine. No other 10 Gb port on the 
Engine has been configured for this connection.

The 10 Gb port on the ISIS 2000 Engine Controller requires an SFP+ transceiver.

4. Connect the other end of the 10 Gb network cable to a 10 Gb port on your ISIS 2000 switch. 

Depending on the type of switch you have, an X2 or SFP+ transceiver might be needed for 
the switch port.

n The Force10 S4810 switches need SFP+ transceivers with an LC to LC cable connection. The 
Cisco 4900M switches need an X2 transceiver for the SC type connector with an LC to SC cable 
connection. 

5. Repeat steps 3 and 4 if connecting a multiple ISIS 2000 Engines (up to five ISIS 2000 
Engines are supported). 

Force10 4810 switch with 

1 Gb and 10 Gb connections 

10 Gb Ethernet LC to LC connection

10 Gb Ethernet 

LC to LC connections

1 Gb connection

10 Gb connection 

Optional 1 Gb Ethernet connection to house network

1 Gb managment port
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6. Finish the setup as follows: 

a. The first time you set up the ISIS 2000 Engine you must connect to the Management 
port to on the Engine Controller to configure the IP address, see “Setting-Up the 
Network Address On the Engine” on page 55.

b. Install the ISIS 2000 software as described in Loading the Software.



3 Installing Software and Configuring

This chapter describes how to connect and configure the System Director and other Avid ISIS 
hardware. 

If you have questions, please call your Avid representative or your local ACSR.

c Before you start the procedures in this chapter, you should be familiar with the information 
in previous chapters and the Avid Network and Switch Guide.

This chapter contains the following sections:

• Software Installation

• Adding a Remote Host for Zone 3 and 4 Clients

• Avid Interplay Authentication

Software Installation

Your System Director and Engine should be cabled and attached to an ISIS network switch. to 
both internal subnets similar to the “Connecting Network Cables with a 10 Gb System Director 
Connection” on page 60. 

If you are upgrading an existing ISIS 2000 to the latest version of ISIS software, see “Avid ISIS 
2000 Upgrade Guidelines” on page 123. 

Configuration Overview

The following list summarizes the System Director and Engine setup. 

1. Assign an IP addresses to your Engine, see “Setting-Up the Network Address On the 
Engine” on page 55. 

n The ghost image on the System Directors does not set the IP addresses of the onboard network 
ports or the dual 10 Gb network ports on the PCI bus; the system is set for DHCP. 

2. Load the System Director software. This software is used to create a file system on the 
System Director, bind the drives to the software on the System Director, create Storage 
Groups, and administer the Avid ISIS system. See “Loading the Software” on page 65.
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3. Perform administrative functions: bind Engines (Storage Elements), create Storage Groups, 
and do other administrative functions. See “Creating an Active File System on the System 
Director” on page 71. 

4. Load the client software; see “Loading Client Software” on page 82. 

Loading the Software

The System Director software is loaded onto the System Director using a USB flash drive. The 
system ships with two USB flash drives:

• One USB flash drive is your Avid ISIS software installation kit. 

n Any USB flash drive is supported for loading the software kit as long as it has at least 2 GB of 
storage. 

• The second USB flash drive is used as a bootable USB flash drive with Avid ISIS Product 
Recovery image. 

To load the Avid ISIS software:

1. Log in to the System Director as Administrator (default password: is-admin). 

n The Avid ISIS 2000 product documentation is in PDF format. You can access the documentation 
in the AvidISISDocumentation folder on the Avid ISIS installer kit. You need to download and 
install Acrobat Reader on your Avid ISIS 2000 before you can access the PDF documentation.

2. Make a folder for the software kit on your root directory (C:\) of your System Director.

3. Insert the USB flash drive with software kit into any of USB ports on your System Director.

n You can run the software installer from the USB flash drive. The advantage of copying the 
software kit to the Avid ISIS is that you have easy access to kit files if you should ever need them 
in the future.

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid ISIS 2000 system. 

4. (Option) The Avid ISIS 2000 software kit is also available on the Avid Download Center 
(www.avid.com/support/downloadcenter). Uncompress (unzip) the downloaded software kit 
in the new folder on the Avid ISIS 2000 system. 

5. Double-click the Autorun.exe file in the software kit.

The installer splash screen appears.

http://www.avid.com/support/downloadcenter/index.asp
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n Avid highly recommends that you click the Documentation link. This displays the ReadMe file 
that provides the latest information regarding the Avid ISIS 2000 system. You must have Adobe 
Reader installed to view the PDF.

6. Select ISIS 2000 System Director from the “Select Software Package” menu. 

When setting up the ISIS 2000 Engine for the first time, the RAID set configuration is 
performed when you Upgrade the Storage Managers in the Management Console. This 
function is not performed if your RAID set has already been configured. Typically this is the 
case when upgrading the software version.

n When you initially install the Avid ISIS 2000 system and initialize the RAID set, it will take 
approximately 72 hours regardless if you have an ISIS 2000-240 TB or ISIS 2000-120 TB Engine 
configuration. During this initialization, the system is functional and able to support a limited 
amount of client traffic. Client traffic can significantly increase the initialization time. For more 
information about the initialization time, see the Avid ISIS Performance Guides.

The following table describes the installer options and their functions.
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Installer Dialog Box  

Selection Function

Package Selection Select the ISIS software kit from the “Select Software Package” menu. 

• ISIS 2000 System Director — Selects the ISIS 2000 software kit. Select 
this menu item to install the Avid ISIS 2000 software on the System 
Director. 

• ISIS 5500 | 5000 Engine — Select this menu item if you are loading the 
software on optional storage enclosers. Once you have the System 
Director software on one of your enclosures, all of the additional 
enclosures are optional. These enclosures are referred to as Engines. 
Optional enclosures include just the Engine Software.

• ISIS 5500 | 5000 Engine/ System Director — Select this menu item if you 
have one enclosure or have multiple enclosures but want this enclosure to 
be the System Director which includes the software that runs the 
Management Console and tracks the metadata stored in all the media 
drives.

• ISIS 7500 | 7000 System Director — Selects the ISIS 7500 | 7000 
software kit. Select this menu item to install the Avid ISIS 7500 | 7000 
software on the System Director. This software cannot be installed on the 
same server as the File Gateway’s software.

• System Director Client Installers — Select this menu item to install the 
Avid ISIS client installer software for the ISIS clients. 

• ISIS Windows Client — Select this menu item to install the Avid ISIS 
client software on Windows clients. This installer detects the Windows 
client’s operating system, and installs the appropriate client software. If a 
previous ISIS client software is installed, the old version is uninstalled 
and the new version is installed. 
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• ISIS File Gateway — Select this menu item to install the Avid ISIS File 
Gateway software on a standalone File Gateway server. This software is 
included with the ISIS 2000 System Director software and cannot be 
installed on the same server as the ISIS 7500 | 7000 or ISIS 5500 | 5000 
System Directors. If setting up the ISIS File Gateway, see the Avid ISIS 
File Gateway Setup and User’s Guide. 

• Remove ISIS Software — Select this menu item to uninstall the Avid ISIS 
software. You do not need to run the uninstaller if upgrading your ISIS. 
The ISIS installers automatically detect your ISIS software and uninstalls 
the necessary components before installing the selected ISIS software. 
Use this menu selection if an attempt was made to install the ISIS 
software without using installer splash screen. Components that are left 
behind are detected and uninstalled properly. You can also use this menu 
selection if planning to remove all the ISIS software without installing 
other ISIS software. This one selection saves you from selecting several 
software components in the Windows Control panel.

Software 
Installation

System Director 
Software

Select “ISIS 2000 System Director” from the menu to install the ISIS 2000 
System Director software which runs the Management Console and tracks the 
metadata stored in all the media drives.

• Intel Network Connections — Installs the Intel driver supported in the 
release. This driver is installed on the System Director and Engines. 

• Myricom Network Connection — Installs the Myricom driver supported 
in the release. This driver is installed on the System Director and Engines. 

• System Director Software — Installs the System Director software used 
to run the media drives and creates the file system for the media drives. It 
also provides the ISIS Management Console and error logging. The 
installer detects the operating system (Windows 64-bit) and installs the 
appropriate software and creates the file system used by the Engines; it 
also provides the ISIS Management Console and error logging. 

Installer Dialog Box (Continued)  

Selection Function
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• ISIS Client Installers — Installs the “client installers” on the System 
Director. Clients can then install the latest software on the clients from the 
System Director Management Console window. These installers are 
accessed when you click the Installers icon in the Management Console.

• Avid ISIS Client — Installs the Avid ISIS client software required on the 
ISIS 2000 System Director for the File Gateway services. 

• ISIS File Gateway — Installs the Avid ISIS File Gateway software. The 
File Gateway software enables network users to access Avid ISIS 
Workspaces in a non-realtime scenario. Depending on the access 
permission, network users can read, write, and delete files on Workspaces 
without using up ISIS client licences. 

• ISIS Engine Installers — Installs the code used to upgrade the ISIS 2000 
Storage Manager in the Engine. Storage Manager is then upgraded using 
the System Director Management Console. This code is applied when 
you click the Upgrade button in the Management Console > Storage 
Manager page.

• ISIS SNMP Extension Agent — Installs software to support Simple 
Network Management Protocol (SNMP). It is used with network 
management to monitor network-attached devices for conditions that 
warrant administrative attention. These SNMP monitoring agents are 
used with an OpenNMS user interface to support the Avid System 
Monitor. 

Avid System Monitor is an option for ISIS 2000 systems covered by the 
“Avid Uptime Support” contract option. The software required for the 
monitoring solution is provided as part of the Avid PS installation 
engagement. 

• Avid License Control — Installs the Avid License Control tool software 
on the System Director. The Avid ISIS software can be installed without 
licensing the software but you cannot make an Active File System or 
connect any clients until you run the Avid License Control tool and 
activate the ISIS software. For instructions see “Avid ISIS Software 
Licensing” on page 104.

Installer Dialog Box (Continued)  

Selection Function
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7. Click Apply.

8. Follow the screen prompts accepting the defaults and License agreement.

• Engine Configuration — Configures the Intel and Myricom driver 
settings required for the release. There is no need to open network 
Properties and make changes to the setting. This configuration is 
performed on the System Director and Engines. 

n If you have made a change to the Intel or Myricom settings and want to 
set them back to the Avid defaults, re-run the ISIS software installer 
(autorun.exe) and the Avid network settings are re-applied.

Resources

Documentation This is a link that brings you directly to the AvidISISDocumentation folder 
on the Avid ISIS installer kit. This folder can be wherever the installer files 
have been saved. This folder has all of the Guides that are included with the 
release.

Avid recommends that you read all the information in the ReadMe file 
thoroughly before installing software or attempting to use the Avid ISIS 
system. This ReadMe provides information that is not in the other Avid ISIS 
documentation.

n Search the Avid Knowledge Base for the most up-to-date ReadMe file, 
which contains the latest information that might have become 
available after the documentation was published. To view the online 
version, visit the Knowledge Base at www.avid.com/readme.

The document provides hardware and software requirements, a limitations 
and known issues, and other important information. You can access the 
documentation in the top-level AvidISISDocumentation folder on the Avid 
ISIS installer kit. 

Browse Content This is a link that brings you directly to the Avid ISIS installer kit. From here 
you can access all the files included in the kit. This folder can be wherever the 
installer files have been saved. 

Kit Contents Displays the version numbers of the Avid ISIS software included in this kit. 

Technical Support This link brings you to the Avid support web site (www.avid.com). If you do 
not have internet access on the computer running this software installation, 
Page not found is displayed. 

Contact Displays the Avid corporate address. 

Installer Dialog Box (Continued)  

Selection Function

http://www.avid.com/readme
http://www.avid.com
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n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the 
removal of the File Gateway software. Type Y to confirm the removal.

9. Once the installation is complete, click Finish.

10. After the ISIS 2000 software is installed, you must restart the System Director.

Separate VLAN on Switch for ISIS 2000

ISIS 2000 systems typically are integrated with ISIS 7500 | 7000 or ISIS 5500 | 5000 
environments. Each ISIS system should be in a different broadcast domain /VLAN. The ISIS 
2000 System Director and ISIS 2000 Engine are connected to ISIS 7500 | 7000 or ISIS 
5500 | 5000 switches that have been configured with a separate VLAN for the ISIS 2000 
components. See your site network administrator for assistance with configuring the separate 
VLAN on your switch

Activating the License Key

You need to activate your Avid ISIS software before you can make an Active File System. After 
installing your software, see “Avid ISIS Software Licensing” on page 104

n Previous versions of Avid ISIS software use an application key plugged into the System Director 
to allow clients to connected to the ISIS infrastructure. New ISIS systems ship with software 
licensing that is activated online. Software licensing is only required with new ISIS installations. 
Clients cannot access the Avid ISIS software until the license key has been activated.

If configuring a Dual System Director for metadata redundancy, you will need a second 
application key with the second System Director, For more information, see “Configuring 
System Director Resiliency” on page 91. 

Creating an Active File System on the System Director

After the software installation and the System Director has restarted, new installations must be 
initialized by creating an Active File System on the System Director. 
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To create an Active File System:

1. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel. 

2. Click Stop System Director.

 The Configure File System button becomes active.

3. Click Configure File System.

The File System Configuration dialog box opens.
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c When you Create Active File System, this action results in the loss of all media assets on the 
system. This is a non-recoverable action and extreme caution should be exercised when this 
command is invoked.

4. (First System Director) Select Create Active File System and click OK. 

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

5. (Option) If creating a Standby System Director in an metadata redundancy configuration, 
see “Configuring System Director Resiliency” on page 91. 

Installing Software on the Engine

After you have loaded new software on the System Director you need to upgrade the software on 
the Engine. You can use Management Console from anywhere to perform the following 
functions, but you usually do it from the System Director:

• Upgrade the Storage Manager with the proper/latest software

• Create Workspaces
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To load the Engine software:

1. Go to http://IP address of System Director (or virtual name).

2. Log into the System Director.

n The default Administrator password is blank.

The ISIS Management Console opens.

3. Click Storage Manager.

4. Select the Storage Manager in the list.
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5. Click Upgrade.

The Upgrade Storage Managers window opens.

6. Select the .zip file, and click Upgrade.

The Storage Manager installation takes approximately 10 minutes.

n Once the Storage Manager upgrade has completed, the software automatically starts building 
the RAID sets in the ISIS 2000 Engines. Due to the size and number of drives in the Engine, the 
RAID configuration takes a couple days to complete. Clients can use the ISIS 2000 system during 
this time although, the more client activity on the Engine, the longer it takes to finish the RAID 
configuration.

7. Select a Storage Manager from the list and click Details.

Upgrade .zip file

Upgrade
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The Status for the upgrade is shown in the Details pain at the right of the window. Click the 
Refresh button whenever you want the updated upgrade Status. When the Status is empty, 
the upgrade is complete.

8. (ISIS 2000-240) Double-click the IP address of the original Storage Element in the Details 
pane to open ISIS 2000 Storage Manager Agent Web page. 

9. (ISIS 2000-240) You are asked for the password. Type se-admin.

10. (ISIS 2000-240) Click Network in the left pane of the System tab. 

The ISIS 2000 Storage Manager Agent page appears.

Refresh Details
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11. (ISIS 2000-240) Enter an IP address in the gx0:1 and Netmask text boxes in the Data 
Interfaces section. 

The ISIS v4.5 release provides dual IP addresses for the Engine Controller in the ISIS 2000 
Engine. This new IP Address must be in the same subnet as the original IP address. 

n A second physical cable is not needed, both IP address are handled through the existing 10 Gb 
connection between Engine Controller and the switch. 

12. (ISIS 2000-240) Click Submit.

a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

b. A second dialog box appears, type se-admin. in the password box and click Reboot. 

13. (ISIS 2000-240) When the Engine has restarted, open the Storage Manager page in the 
Management Console.

n You will notice there are now two Storage Managers in the Storage Managers page.
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Binding the Storage Managers

After you have created an Active File System you need to bind the Storage Managers using the 
Management Console. If you have more than one Engine in your ISIS 2000 configuration, they 
appear listed in the Storage Manager page. One or multiple Storage Managers can be bound. 

n This procedure assumes you are creating an Active File System on a new unused Engine. If you 
attempt to create a File System on an Engine that has been used before, your Storage Managers 
might enter an Orphaned state. To remove an Orphaned state, search the Avid ISIS 
Administration Guide for instructions on “Removing Orphaned Storage Managers.”

To bind the Storage Managers:

1. Type http://IP address of System Director in your browser. 

If already logged into the System Director, click the Management Console icon in the 
Launch Pad.

2. Log into the System Director and access the Management Console.

n The default Management Console Administrator password is blank (no password).

3. Click the Storage Managers icon or click the unbound Status message in the System Status 
console.

n If you have an ISIS 2000-120 configuration, one Storage Manager is displayed. Two Storage 
Managers are displayed for each ISIS 2000-240 Engine.

4. Select the Storage Managers listed in the Storage Managers page. 

Multiple Storage Managers can be selected and bound.

5. Click Bind.

6. Click Yes to confirm the request.

7. Click Refresh to see the status circle next to the Name change to green when complete.
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Creating a Storage Group

You can only create a Storage Group after you have bound the Storage Managers see “Binding 
the Storage Managers” on page 78. A Storage Group requires at least one Storage Manager. The 
ISIS 2000-120 Engine can be configured for one Storage Group, the ISIS 2000-240 Engine can 
be configured for one or two Storage Groups. If you have multiple Engines, all the Storage 
Managers can be configured as single Storage Group. 

To create a Storage Group, click the Storage Group icon in the Management Console. See the 
Avid ISIS Administration Guide for additional information about creating a Storage Group.

Creating Workspaces

Workspaces are locations to store and segregate data. They appear as network drives to the 
clients. You can allow users to access some or all of the workspaces, and assign permissions for 
how each user can access the data in a workspace.

Create Workspaces after you have created your Storage Group. To create Workspaces, click 
Workspaces icon in the Management Console. See the Avid ISIS Administration Guide for 
information on creating Workspaces.

Creating User Accounts

User accounts allow individual users, or groups of users, access to the workspaces. These 
accounts allow users to mount or map Avid ISIS workspaces on their workstations.

To add users, click the User icon in the Management Console. See the Avid ISIS Administration 
Guide for additional information about creating new users.

Turning Off the CIFS Service With a 1 Gb Connected System Director

If you are using a 1 Gb connection between the ISIS 2000 System Director and the switch, you 
must turn of the CIFS service. By default ISIS software starts the CIFS service using the 10 Gb 
port. 

c Only System Directors with a 10 Gb connection to the switch support CIFS clients. If you 
reconfigure your System Director to use a 10 Gb connection between the System Director 
and the Switch, you must reset this service to run automatically. 

n If you upgrade or reload the ISIS software, this default CIFS setting is reset to automatically 
start. You need to disable the setting each time the software is installed on the ISIS System 
Director.
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To Start and Stop your CIFS service:

1. Right-click on the My Computer icon and select Manage. 

The Server Manager window opens.

2. Expand the Configuration menu in the left pane and select Services. 

3. Right-click AvidISISFileGateway in the right pane and select Properties.

4. Select Disabled from the “Startup type” menu.
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5. Click Apply, and then click OK.

6. Close the Server Manager window. 

Checking the Status of the System Director

After you have installed the System Director software, an Avid ISIS Launch Pad is displayed on 
the System Director Desktop.

To open and close the Launch Pad:

1. If the ISIS Launch Pad is not displayed on the Avid ISIS System Director Desktop, click the 
ISIS Launch Pad icon in the Taskbar’s System Tray to display or hide the Launch Pad. 

n You can also open other ISIS tools by clicking the icons in the Launch Pad.

The ISIS Launch Pad is displayed.
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2. Start or stop the System Director by clicking one of the following icons in the ISIS Launch 
Pad. 

t Click the blue square icon to stop the System Director.

t Click the blue triangle icon to start the System Director.

Loading Client Software

Avid ISIS client software is supported on Windows, Macintosh and Linux clients. For 
information on using your client software see the Avid ISIS Client Guide. You can load the Client 
software in the following ways:
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n If upgrading the Client Manager software using the file in the software kit or Installer page of the 
Management Console, you must first uninstall the Client Manager software using the Windows 
Control Panel before installing a new version of Client Manager. Macintosh clients can just 
install the new client software over the old version and no reboots are required.

• You can use the a Browser to reach the ISIS Management Console and load it from the 
System Director.

n If the client does not have Flash installed, you won’t be able to access the Management Console. 
A prompt is displayed with a link to the Flash installer. 

• Download the client installers from the Management Console and copy the software to a 
USB flash drive.

• You can store the client software somewhere on the network and allow everyone who needs 
the software to gain access to it and load it.

• You can load the ISIS software kit on the Windows client and double-click the 
Autorun.exe file. Select the “ISIS Windows Client” installer from the Select Software 
Package menu.

n The installer automatically uninstalls an earlier version of software.

To access the client software using a browser:

1. Start your browser application.

2. Run your Windows Update and accept all “High-priority Updates.”

3. Type http://IP address of System Director in your browser.

n If your Avid ISIS network includes a Domain Name System (DNS), you can type the System 
Director’s name in the browser (default Virtual name is AvidISIS).

The ISIS Management Console opens. 

4. Type your ISIS user name and password.

5. Click the Installers icon.

An Installer Downloads screen opens.
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6. Click the appropriate client installer.

The installer might ask if you want to save or run the installation software; either is 
acceptable.

n If you were able to access the Management Console it means that your client already has Flash 
installed.

To install your Avid ISIS Windows client software from the software kit:

1. Log into your Windows client system as a user with Administrative privileges.

2. Load the new software kit on you Windows client system.

3. Double-click the Autorun.exe file in the software kit.
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The installer detects the existing version of the installed client software (if any) and displays 
the components that need to be upgraded in the splash screen. 

4. Select the “ISIS Windows Client” installer from the Select Software Package menu.

5. Click Apply.

n The installer automatically uninstalls an earlier version of software without having to use the 
Windows Control Panel and installs the new software with a single click.

6. Install the client software following the on-screen prompts. Accept the defaults when 
uncertain of any choices.

7. Restart the client when prompted.

The client software starts automatically when restarted. 

8. You might need to update the Intel Pro driver on your client system, see Avid ISIS ReadMe.

9. Repeat this procedure on each Avid ISIS Windows client.

n You can manually copy the client installers to a USB flash drive. The installers are in the Avid 
ISIS software kit located on [drive]:\AvidISISClientInstallers. You can also log into the 
Management Console and access the Installers link and download the appropriate client 
installer.

When manually installing the ISIS client software, you need to uninstall the previous version of 
the ISIS client software using the Windows Control Panel, restart, install ISIS client, and restart 
the Windows client. 

To install your Avid ISIS Macintosh client software:

1. Copy and save the new AvidISISClient_MacOSX_x.x.x.dmg file from the:

t \AvidISISClientInstallers folder in software kit to your Macintosh client system.

t Management Console > Installer page to your Macintosh client system. 

2. Double-click the AvidISISClient_MacOSX_x.x.x.dmg file. 

3. Double-click the AvidISISClient.mpkg file to run the installer.

Follow the on-screen instructions.

n The installer replaces earlier versions of the software (if any).

4. Repeat this procedure on each Avid ISIS Macintosh client.

n You can manually copy the client installers to a USB flash drive. 
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c The Macintosh client software installs an uninstaller application located at Applications 
> Avid_Uninstallers > AvidISIS. Use this application only when you want all Avid 
client files removed; including Client Manager preferences.

To install ISIS Linux client software:

1. Copy and save the new AvidISISClient_el6.x86_x.x.x.bin file from the:

t \AvidISISClientInstallers folder in software kit to the user’s home directory of 
your Linux client system.

t Management Console > Installer page to the user's home directory of your Linux client 
system. 

2. Open the Terminal application: Application > System Tools > Terminal on your 
Linux client.

n When using the Terminal program, file names and paths are case sensitive.

3. Type cd [user’s home directory] and press Enter.

4. Do one of the following.

t If you are not the root user, type sudo ./AvidISISClient_el6.x86_x.x.x.bin and 
press Enter. You will need to enter your password.

t If you are the root user, type ./AvidISISClient_el6.x86_x.x.x.bin and press 
Enter.

n The installer replaces earlier versions of the software (if any).

n You can manually copy the client installers to a USB flash drive. 

5. Restart the Linux client.

Configuring Client Software

To mount workspaces on the client do the following:

1. Load the client software as explained in “Loading Client Software” on page 82.

2. Do one of the following:

t (Windows) If the Client Manager icon is not available in the Windows taskbar, select 
Start > Programs > Avid > ISIS Client > ISISClientManager.

t (Windows) Click the Client Manager icon in the Windows taskbar.

t (Windows) Right-click the Client Manager icon and select Avid ISIS Client Manager.
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t (Macintosh) If the Client Manager alias icon is not available, select Go > Applications, 
and then double-click the AvidISIS folder. In this folder, double-click the 
ISISClientManager.app file.

The ISIS Client Manager opens.

3. The first time you login, you might need to select a Remote Host (Avid ISIS system). For 
information about adding a remote host, see the Avid ISIS Client Guide. 

4. Select the ISIS system in the Systems panel.

5. Click the Connect button in the Systems panel.

6. Login using the Username and Password assigned to you by the Avid ISIS administrator. Do 
one of the following:

t (Windows) Type your account name in the Username text box, and type your password 
in the Password text box.
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t (Windows) If your ISIS system is configured to use the Windows user name and 
password for your local system, select OS Login. By default, the Username and 
Password text boxes are inactive when you select this option.

(Optional — Windows only) If you used the OS Login option, and you want to connect 
to the network automatically every time you start your system, select the Auto-Connect 
checkbox.

t (Macintosh) Type your Avid ISIS account name in the Username text box, and type your 
password in the Password text box.

t (Linux) Type your Avid ISIS account name in the Username text box, and type your 
password in the Password text box.

When the connection is successful:

- Workspaces you have been given access to are listed in the Workspaces list.

- The Client Manager buttons become active.

Adding a Remote Host for Zone 3 and 4 Clients
If your client is not on the same subnet as the ISIS shared storage network, you need to add the 
name of your System Director in order for the Client Manager to connect to it. If your system 
does not use a DNS server to configure your network connections, you can also type the IP 
addresses of the remote host, but you cannot use the virtual server name or virtual IP addresses.

n Clients on the same subnet as the ISIS System Director, automatically have the System Director 
listed in the toolbar of the Client Manager window. 

n You need to add the name of all Active and Standby System Directors in your network. For 
System Directors that are dually-connected to the network, you need to add both subnet 
addresses.

To add a remote host:

1. Open the Client Manager (see “Configuring Client Software” on page 86).

The Client Manager opens.

2. Click the Remote Host Settings button.

The Remote Hosts dialog box opens.
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3. In the text box, type the actual server name or IP address of the Avid ISIS System Director to 
which you want to connect. 

You cannot use the virtual server name or the virtual IP address of the remote host.

4. Click the Add button.

The Input dialog box opens.

5. In a Dual System Director configuration, you need to type the actual server name or 
IP address of the Standby System Director. 

You cannot use the virtual server name or the virtual IP address of the Standby System 
Director.

6. Click the Add button.

n The Client Manager user interface could take up to 30 seconds to display changes made in the 
Remote Host Settings. 

7. Click the green check mark to apply the settings or the red X to close the dialog box without 
any changes.
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Avid Interplay Authentication

Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The 
System Director’s virtual name must not match the actual host name and must be entered in the 
General Configuration Options dialog box even if your Avid ISIS system configuration only has 
one System Director. For instructions on adding the virtual name, search the Avid ISIS 
Administration Guide for General Configuration Options.



4 Configuring System Director Resiliency

This chapter explains how to enable the software for a failover using two System Directors.

n The Active and the Standby System Directors must be using the same image on the server, you 
cannot mix images.

System Director Failover

When using two System Directors, one is referred to as Active System Director and the other one 
is the Standby System Director. The File System on the Standby System Director is kept 
up-to-date with the Active System Director. If the Active System Director fails, a failover 
function switches to the Standby System Director. There might be a brief interruption in client 
connectivity but all clients re-connect automatically when the Standby System Director becomes 
active. In an attempt to keep the procedure easy to use, we use the following nomenclature:

• When adding a new System Director to an existing Avid ISIS system or creating a failover 
system configuration, the original System Director is called the existing System Director and 
the new System Director is called new. 

• When installing two new System Directors to create a failover system configuration, one 
System Director is called Active and the other Standby. 

The System Director crossover cables must be connected to the 1 Gb on-board 82567LM-4 and 
82574L ports. These two 1 Gb ports are the left two 1 Gb System Director ports (when facing the 
rear). The 1 Gb Intel Pro 1000 ports on the right side are not used when configuring dual 
ISIS 2000 System Directors. Connect the two System Directors under the following conditions:

• After you have physically configured the system and loaded the Avid ISIS software on both 
System Directors. 

• When the System Director service is stopped on both systems.



System Director Failover

92

Cabling Dual System Directors

To connect dual System Directors:

1. Connect the two System Directors using a 1 Gb cable (straight or crossover) as shown in the 
following figure. 

Connect the two bottom-left ports of the System Directors with one Ethernet cable and 
connect the two top-left ports of the System Directors with a second Ethernet cable.

2. Enable the software on both systems, see “Configure a Failover Connection” on page 93.

n The configuration information for the notification service (SMTP information, contacts, and 
filters) is stored in the registry on the System Director. This information is not currently 
replicated to the failover System Director and must be entered manually on both System 
Directors. For information on setting up the notification service, see Setting up Error 
Notification in the Avid ISIS Administration Guide.

Force10 4810 switch 

10 Gb Ethernet uses 

LC to LC connections

System Directors 

Optional 1 Gb house network connection 

1 Gb connection

10 Gb connection 

Engines
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Setting IP Addresses for Crossover Link

Avid recommends the System Director IP addresses for failover configurations that are listed 
below. If you use different addresses, be sure to note them and have them available before 
proceeding. You set the IP addresses in the Network Connections dialog box, which you access 
from the Windows Control Panel. For information on setting Windows IP addresses, see the 
documentation that came with your operating system.

To set IP addresses:

1. Go to Start > Control Panel > Network Connections for each System Director.

2. Set the Existing System Director to the following TCP/IP addresses for ports 1 and 2:

- Onboard Ethernet port 1 (ETH1) - 192.168.1.1 netmask 255.255.255.0

- Onboard Ethernet port 2 (ETH2) - 192.168.2.1 netmask 255.255.255.0

3. Set the New System Director to the following TCP/IP addresses for ports 1 and 2:

- Onboard Ethernet port 1 (ETH1) - 192.168.1.2 netmask 255.255.255.0

- Onboard Ethernet port 2 (ETH2) - 192.168.2.2 netmask 255.255.255.0

Configure a Failover Connection

Setting up the ISIS system for a System Director failover is done on two System Directors. The 
first System Director is referred to as the Active System Director and the second System Director 
is referred to as the Standby System Director. 

n Make sure all clients are notified that you are stopping the System Director.

To set up a failover connection on the Active System Director:

1. Load the ISIS software on the Active System Director as described in “Loading the 
Software” on page 65.

2. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel.
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3. Click Stop System Director.

The Configure File System button becomes active.

4. Click the Change button beside the Virtual System Director Name and type a name in the 
Virtual System Director Name text box and click OK.

n The same virtual name must be assigned to both System Directors.

5. Click Configure File System.

The File System Configuration dialog box opens.
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6. (First new System Director) Select Create Active File System and click OK. 

c If you already have a running System Director do not create a new file system and skip this 
step. If you create a new file system on a System Director that already has a file system all 
of your existing data will be lost.

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

7. Click Stop System Director.

The Configure Dual System Director button becomes active.

8. Click Configure Dual System Director.

The Dual System Director Configuration dialog box opens.
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9. Select “Enable Dual System Director Configuration.”

10. Configure the Virtual Addresses on both systems by doing the following:

a. Choose two unused static IP address that are used as the Virtual IP addresses for both 
System Directors. This example uses 192.168.10.253 and 192.168.20.253.

b. Map the Virtual IP address to the corresponding real IP address for each of the System 
Directors. This example uses 192.168.10.100 and 192.168.20.100.

c. Register both of the Virtual IPs in DNS with the Virtual System Director Name.

11. In the Local Machine area leave the Monitor port set to 5000. If you have another 
application that uses port 5000, change the Monitor port to an available port number. This 
port number must be the same on both the existing and the new System Directors.

12. Set the Local Machine First Path IP address to local IP 1: 192.168.1.1.

13. Set the Local Machine Second Path IP address to local IP 2: 192.168.2.1.

14. Set the Remote Machine First Path IP address to: 192.168.1.2.

15. Set the Remote Machine Second Path IP address to: 192.168.2.2.

The Active System Director has now been configured. Leave the Active System Director as 
is; stopped and with the ISIS Control Panel and Dual System Director Configuration 
window open.

16. Continue with “To set up the resiliency connection on the Standby System Director:” on 
page 97.

Enable Dual System
Director Configuration
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To set up the resiliency connection on the Standby System Director:

1. Load the ISIS software on the Standby System Director as described in “Loading the 
Software” on page 65.

2. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel.

3. Click Stop System Director.

The Configure Dual System Director button becomes active.

4. Click the Change button beside the Virtual System Director Name and type a name in the 
Virtual System Director Name text box and click OK.

n The same virtual name must be assigned to both System Directors.

5. Click Configure File System.

The File System Configuration dialog box opens.
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6. Select Create Standby System Director and click OK. 

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

7. Click Stop System Director.

The Configure Dual System Director button becomes active.

8. Click Configure Dual System Director.

The Dual System Director Configuration dialog box opens.
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9. Select “Enable Dual System Director Configuration.”

10. Configure the Virtual Addresses on both systems by doing the following:

a. Choose two unused static IP address that are used as the Virtual IP addresses for both 
System Directors. This example uses 192.168.10.253 and 192.168.20.253.

b. Map the Virtual IP address to the corresponding real IP address for each of the System 
Directors. This example uses 192.168.10.101 and 192.168.20.101.

c. Register both of the Virtual IPs in DNS with the Virtual System Director Name.

11. In the Local Machine area leave the Monitor port set to 5000. If you have another 
application that uses port 5000, change the Monitor port to an available port number. This 
port number must be the same on both the existing and the new System Directors.

12. Set the Local Machine First Path IP address to local IP 1: 192.168.1.2.

13. Set the Local Machine Second Path IP address to local IP 2: 192.168.2.2.

14. Set the Remote Machine First Path IP address to: 192.168.1.1.

15. Set the Remote Machine Second Path IP address to: 192.168.2.1.

The Standby System Director has now been configured. Leave the Standby System Director 
as is; stopped and with the ISIS Control Panel open.

16. Continue with “To validate the connections:” on page 100.

Enable Dual System
Director Configuration
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To validate the connections:

1. Validate the crossover connections by clicking Validate Send on the Active System Director 
and Validate Receive on the other System Director.

2. On the Sending System Director, you see the Red Box turn Green for each connection.

The numbers in the Packets Received boxes indicate the number of packets received from 
the first System Director On the Receiving System Director you see the packets received 
number incrementing for each connection.

3. On each system, click Exit.

Green

Packets received
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4. Repeat this validation procedure clicking Validate Send on the Standby System Director and 
Validate Receive on the other System Director.

Verify you are getting the same results (green indicators and correct number of received 
packets).

5. On each system, click Exit.

Binding Order for Health Monitoring

When you have your System Directors in a Failover configuration and use the Interplay Health 
Monitor with the Interplay Framework, the VLAN 10 and VLAN 20 network interface cards 
must be the first and second entries in the Network Interface Binding order to communicate 
properly. 

n If a network crossover connection is the first entry, the System Director Health Monitor will not 
display information regarding the System Director.

To set the network connection bindings order:

1. On the System Director, click Start > Settings > and double-click Network Connections.

2. Click the Advanced menu in the Network Connections window and select Advanced 
Settings.

3. Click the Adapters and Bindings tab.

4. If the connections for the VLAN 10 and VLAN 20 network interface cards are not in the first 
and second position, select them and press the Green Up arrow to move them to the top of 
the list.

5. Make sure the two crossover connections are at the bottom of the list.

Stopping and Restarting the System Directors

In a ISIS 2000 failover configuration, you can stop the Active System Director and watch the 
Standby System Director become the Active System Director. When you restart the System 
Director that was previously Active, that System Director now becomes the Standby System 
Director. If you stop and restart the Standby System Director it remains the Standby System 
Director. The following procedures describes how you to stop and start the System Directors. 

n If you have a failed System Director, stop and restart that System Director. Very often a single 
stop and start of the System Director corrects the problem. 
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To stop and start the System Director using the Launch Pad:

1. If the ISIS Launch Pad is not displayed on the Avid ISIS System Director Desktop, click the 
ISIS Launch Pad icon in the Taskbar’s System Tray to display or hide the Launch Pad. 

n You can also open other ISIS tools by clicking the icons in the Launch Pad.

The ISIS Launch Pad is displayed.

2. Start or stop the System Director by clicking one of the following icons in the ISIS Launch 
Pad. 

t Click the blue square icon to stop the System Director.

t Click the blue triangle icon to start the System Director.
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To stop and start the System Director using the ISIS Control Panel:

1. Click Control Panel icon in the Launch Pad or Start > Programs > Avid > ISIS System 
Director and select Control Panel. 

2. Start or stop the System Director by clicking the appropriate buttons in the ISIS Control 
Panel. 

t Click Stop System Director to stop the System Director.

t Click Start System Director to start the System Director.



5 Avid ISIS Software Licensing

When installing a new Avid ISIS system, you need to activate the ISIS software with the Avid 
License Control tool. If you have a dual System Director environment, you need to repeat the 
procedure for each System Director. 

c If you change your system configuration — for example, by replacing your hard drive, 
replacing a network adapter, or by upgrading your operating system — you must first 
deactivate your Avid software. For information on deactivation, see “Deactivating the 
License” on page 109.

• New installations — if you are a new user and have never installed the Avid software on 
your system, use the following instructions.

n Your network administrator might need to open a few ports that are used during the licence 
activation. The Avid License Control tool utilizes both port 3443 and port 443 for license request 
and response communication. Port 3443 is the primary port, but if this port is blocked, the 
Activation Service tries port 443 (which is more likely to be open for web communication).

• Existing installations — if you are upgrading from a previous version of the Avid ISIS 
software, your Avid ISIS software license remains activated. You do not need to reactivate 
your Avid ISIS software license as long as you've previously activated a licence or have a 
valid ISIS application key (dongle) connected. 

• Host name changes — if you change the host name of your system Director you must first 
deactivate your license, delete the license binding file, and reactivate the license with the 
new name, see “License Requirement with Host Name Change” on page 110.

What You Need to Activate the ISIS Software License

Identification (ID) Numbers Where you can find them:

Activation ID The Activation ID is provided on an Activation ID and System ID card 
shipped with your new ISIS system. The Activation ID is used to 
activate the software license and has been linked to your System ID.
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License Activation Using an Internet Connection
To activate the ISIS software license from the System Director with an Internet connection:

1. Locate your System ID and Activation ID card included with your new System Director. 

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > 
Avid License Control.

The Avid License Control tool opens. 

n After your Avid software is activated, the License Profile tab displays your System ID, 
Activation ID, and Device ID. 

System ID The System ID is provided on an Activation ID and System ID card 
shipped with your new ISIS system. The System ID is used for 
expediting warranty verification and customer service.

Once activated, the License Profile tab of the Avid License Control 
tool displays information about your system. Click “Copy to 
Clipboard” to copy the information to your Clipboard. You can then 
cut and paste from the clipboard to an e-mail or create a text file. This 
is helpful if you need to save this information for your records or need 
to send system information to Avid Customer Support.

Device ID The Device ID is only needed if you are activating your software on a 
system that is not connected to the Internet. This is provided through 
the Avid License Control tool during activation.

Identification (ID) Numbers Where you can find them:
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3. Click Activate next to the Avid ISIS software.

4. Select “I am connected to the Internet and will use this computer” and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 107.

5. Enter your system identification number in the System ID text box. 



License Activation Without an Internet Connection

107

6. Enter your activation identification number in the Activation ID text box. 

7. Click Activate.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the button 
changes to Deactivate.

8. (Option) If you are planning a dual System Director configuration, you need to repeat this 
procedure to Activate your software license on your second System Director.

n If you have purchased a “Resilient” System Director, both System Directors use the same 
System ID in a dual System Director configuration. You do need a separate Activation ID for 
each System Director.

License Activation Without an Internet Connection

When you do an indirect activation, you are given a “.bin” activation file. This file is only good 
for a single activation. If you have done an indirect activation, and deactivate your license for any 
reason, you cannot use the same activation file to reactivate your license. You must repeat the 
“License Activation Without an Internet Connection” procedure and obtain a new “.bin” 
activation file.

To activate the ISIS software license from a separate computer:

1. Locate your System ID and Activation ID card included with your new System Director. 

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens. 

3. Click Activate next to the Avid ISIS software.

4. Select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet,” then click Continue.

5. Enter your system identification number in the System ID text box. 

6. Enter your activation identification number in the Activation ID text box. 

7. Click Next.

8. Follow the instructions in the Avid License Control tool, then click Next.

n Your System ID, Activation ID, and Device ID are displayed on the Activation tab, write these 
numbers down to use later. These IDs are displayed in the License Profile tab after your Avid 
software is activated.
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9. On a computer with an Internet connection, open a Web browser and navigate to 
http://avid.com/license.

10. Follow the onscreen instructions on the web page.

The website creates a license.bin file. This file contains license information needed to 
activate your Avid ISIS software.

11. Copy the license.bin file to the ISIS System Director you want to activate.

A USB flash drive is a good method of moving the license.bin file to the System Director.

12. Close the Web browser on the computer with the Internet connection. 

13. Return to the ISIS System Director where you left off in the Avid License Control tool (see 
the illustration in step 8) and click Next. 

14. Click Browse and navigate to the license.bin file on your ISIS System Director, then click 
Open.

http://avid.com/license
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The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the button 
changes to Deactivate.

15. (Option) If you are planning a dual System Director configuration, you need to repeat this 
procedure to Activate your software license on your second System Director.

n If you have purchased a “Resilient” System Director, both System Directors use the same 
System ID in a dual System Director configuration. You do need a separate Activation ID for 
each System Director.

Deactivating the License

You must deactivate your ISIS software license when replacing the System Director so you can 
use the license on your new System Director. If you need to deactivate the ISIS software you 
must have an Internet connection to deactivate the software and its options. 

Deactivating the ISIS System Director software:

1. Stop your Avid ISIS System Director.

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens. 

3. Next to the Avid ISIS software, click Deactivate.

4. Click Yes.

The system deactivates and the button changes to Activate.
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5. Click Done to close the window.

License Requirement with Host Name Change

If you want to change the host name of your System Director, you must deactivate your ISIS 
software license, delete the license binding file, and reactivate the license after changing the host 
name. 

When changing the System Director host name:

1. Deactivate the Avid License on your Avid ISIS System Director (see “Deactivating the 
License” on page 109).

2. Browse to the following location on the System Director and delete the “binding.dat” file.

c:\ProgramData\Avid\Common\binding.dat 

3. Change the System Director host name.

4. Restart the System Director.

5. Reactivate the Avid License on your Avid ISIS System Director (see “What You Need to 
Activate the ISIS Software License” on page 104).



6 Configuring the Server for CIFS Access

This chapter describes how to configure the ISIS 2000 System Director for Common Internet 
File System (CIFS) clients. The ISIS and CIFS clients share traffic on the same network port on 
the back of the server. 

c Only System Directors with a 10 Gb connection to the switch support CIFS clients. The 
recommended bandwidth setting is 100 MB/s so that there is little impact to ISIS clients.

If you have previously disabled the CIFS service because of a 1 Gb connection with the System 
Director, you need to Start the CIFS service again. Revise these instructions “Turning Off the 
CIFS Service With a 1 Gb Connected System Director” on page 79. This chapter contains the 
following sections: 

• Creating Windows Users and User Groups on the System Director

• Adding Users and Setting Permissions

• Mapping Network Workspaces on CIFS Clients

Creating Windows Users and User Groups on the 
System Director

You must add Windows users and user groups to the Avid ISIS System Director using the 
standard Windows operating system process. The following procedures are provided to help with 
that process, but for details on creating user and group accounts on the System Director, 
right-click on the Local Users and Groups folder in the left pane of the Computer Management 
window and select Help.

To create a local user account:

1. Right-click on My Computer and select Manage. 

The Computer Management Window opens.

2. Expand Configuration > “Local Users and Groups” folder in the left pane.

3. Click Users.

4. Click Action > New User.

5. Type the appropriate information in the dialog box.
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6. Select or clear the appropriate check boxes:

- User must change password at next logon

- User cannot change password

- Password never expires

- Account is disabled

7. Click Create, and then click Close.

To create a local group:

1. Right-click on My Computer and select Manage. 

The Computer Management Window opens.

2. Expand the “Local Users and Groups” folder in the left pane.

3. Click Groups.

4. Click Action > New Group from the menu bar.

5. In Group name, type a name for the new group.

6. In Description, type a description of the new group.

7. To add one or more members to the new group, click Add. 

8. In the Select Users, Computers, or Groups dialog box, under “Enter the object names to 
select,” type the name of the user account or group account that you want to add, and then 
click OK.

9. In the New Group dialog box, click Create, and then click Close.

Adding Users and Setting Permissions

The ISIS File Gateway software includes an application called the Configuration Editor that 
allows the File Gateway administrator to create a configuration file listing the authorized users 
with permission to specific workspaces. 

Before adding CIFS users, make sure the users are already Windows users listed on the ISIS 
System Director, see “Creating Windows Users and User Groups on the System Director” on 
page 111. 

To add CIFS users and workspaces:

1. On the System Director, click Start > Programs > Avid > ISIS File Gateway and select 
Configuration Editor.

The Configuration Editor window opens.
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2. If the System Login dialog box is not displayed, click the Connect button in the top toolbar 
of the Configuration Editor window. 

3. Select the ISIS System you want to connect to.

4. Type the Administrator’s password in the text box. 

n You must be an Administrator to use the Configuration Editor. You cannot type in other user 
names.

5. Click the Connect button.

6. Move the Bandwidth slider to the bandwidth speed you want available to the users, you can 
also type in the value in the text box next to the slider. 

Bandwidth can be set between 40 and 1200, the default value is 100. You cannot set separate 
bandwidth speeds to individual users.

7. Type the user_name in the User Name text box and click Add User.

User name must match the Windows user names created on the System Director.
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8. Repeat step 7 until all the users have been added.

9. With a User Name selected, select or start typing the name of the workspace you want 
shared in the Workspace Name text box. 

10. Type the name you want display on the CIFS client in the CIFS Share Name text box.

11. Click Add CIFS.

12. Continue with setting the permissions.

To set CIFS user permissions:

1. Open the Configuration Editor (if not already open), click Start > Programs > Avid > ISIS 
File Gateway and select Configuration Editor.

2. Select a user in the left pane and one or more workspaces in the right pane. 

3. Set the permissions using the Access Selection menu:

- None — no access

- Full — read, change, and full control

- Read — read permission

- Read/Write — read and change permission

4. Click Set Access.

5. Repeat steps 2 and 4 until permission have been set for all users.

6. Click Save.

The file is read immediately and you do not need to restart the System Director.

7. Click the Close button (X) in the corner of the windows to exit the application.

To set multiple user permissions to a single workspace:

1. Open the Configuration Editor (if not already open), click Start > Programs > Avid > ISIS 
File Gateway and select Configuration Editor.

2. Click CIFS Share View.

3. Select a workspace in the left pane and one or more users in the right pane. 

4. Set the permissions using the Access Selection menu:

- None — no access

- Full — read, change, and full control

- Read — read permission

- Read/Write — read and change permission

5. Click Set Access.

6. Repeat steps 3 and 5 until permission have been set for all workspaces.
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7. Click Save.

The file is read immediately and you do not need to restart the System Director.

n The file is saved as configFile.txt in C:\Program Files\Avid\ISIS 
Client\FileGateway folder. The files is overwritten each time you click Save. If you make 
changes in the Configuration Editor and want to return the last saved file, click Revert. 

8. Click the Close button (X) in the corner of the windows to exit the application.

Setting the CIFS Bandwidth

The default bandwidth for the System Director when configured for CIFS is 100 MB/s. The 
System Director is an ISIS client and all the CIFS users are clients of the CIFS server. You can 
define the System Director bandwidth from 40 MB/s to 1200 MB/s using the Configuration 
Editor, see “Adding Users and Setting Permissions” on page 112.

n Only System Directors with a 10 Gb connection to the switch supports CIFS clients. The 
recommended bandwidth setting is 100 MB/s so that there is little impact to ISIS clients.

Mapping Network Workspaces on CIFS Clients

CIFS clients should map network workspaces to their system for a convenient shortcut to the 
workspace. You can map multiple workspaces.

To map a workspace to a CIFS client (Windows):

1. Click Start > Run on the CIFS client.

2. In the Open text box, type the path of the workspace on the cooperate domain, for example 
\\FileGateway_server_name\shared_workspace_name and click OK.

3. In the Windows Explorer window that opens, click the Tools menu and select “Map Network 
Drive.”

To map a workspace to a CIFS client (Macintosh):

1. In the Apple menu, click Go > Connect to Server.

2. In the Open text box, type the path of the workspace on the cooperate domain, for example 
cifs://FileGateway_server_name/shared_workspace_name and click Connect.

3. In the Windows Explorer window that opens, click the Tools menu and select “Map Network 
Drive.”



7 Configuring the Server for FTP Access

This chapter describes how to configure the System Director to share Avid ISIS workspaces 
using File Transfer Protocol (FTP). The FTP function is done through the Microsoft® Internet 
Information Services (IIS) and the FTP Service. 

c Only System Directors with a 10 Gb connection to the switch support FTP clients. 

Once you have configured the FTP service on your ISIS 2000, Avid recommends the following 
FTP client applications. 

• Microsoft Expression Web 4 

• FileZilla

• Core FTP LE

• SmartFTP Client

For information on configuring Microsoft FTP Server Sites, see 
http://support.microsoft.com/kb/283679.

Several FTP functions and settings have been pre-configured for you in the operating system 
image of the ISIS 2000 System Director and the software. The FTP service is not started 
automatically, use the following procedures to enable the FTP server for FTP client access to the 
data on the ISIS 2000 storage. The following are FTP configurations used in the ISIS 2000 
System Director:

• The FTP Service uses port 21 and should not be changed

• In Bindings, you need to enter an virtual host name 

• In Virtual Directory, enter Alias ISIS Workspace names (for example WorkspaceA)

• An FTP directory (D:\ftproot) has been created for the alias workspaces 

• You set the access privileges to the Workspaces when you add the FTP users the Windows 
operating system 

In addition, the “Blade FTP Share” FTP site is also preconfigured on the ISIS 2000 System 
Director. The “Blade FTP Share” FTP site is used for upgrading the media drives during 
software upgrades and providing Client Manager software to ISIS clients. The Blade FTP Share 
install location is: C:\Program Files (x86)\Common Files\Avid ISIS Shared\ftp. 

http://support.microsoft.com/kb/283679
http://support.microsoft.com/kb/283679
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c Do not modify any settings in the “Blade FTP Share” FTP Site, or its sub-folders. Any 
changes to the Blade FTP Share could potentially prevent upgrades and client installers 
from working properly. 

Setup the System Director for FTP

The System Director shares the ISIS client and CIFS network traffic over the same Ethernet 
connection to the ISIS switch. Log in to the System Director as the administrator and perform the 
following.

n The default System Director password is set to is-admin. 

Creating Windows Users and User Groups on the Operating System

You must add Windows users and user groups to the Avid ISIS System Director using the 
standard Windows 2008 operating system process. The following procedure is provided to help 
with that process, but for details on creating user and group accounts on the System Director, 
right-click on the Local Users and Groups folder in the left pane of the Computer Management 
window and select Help.

To create a local user account:

1. Right-click My Computer and select Manage on the system.

The Server Manager window opens.

2. Expand Configuration and the “Local Users and Groups” folder in the left pane.

3. Click Users.

4. In the right-most pane, click Action > More Actions > New User.

5. Type the appropriate information in the dialog box.

6. Select or clear the appropriate check boxes:

- User must change password at next logon (Unchecked)

- User cannot change password (Checked)

- Password never expires (Checked)

- Account is disabled (Unchecked)

7. Click Create, and then click Close.

To create a local group:

1. Right-click My Computer and select Manage on the system.

The Server Manager window opens.
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2. Expand Configuration and the “Local Users and Groups” folder in the left pane.

3. Click Groups.

4. In the right-most pane, click Action > More Actions > New Group.

5. In Group name, type a name for the new group.

6. In Description, type a description of the new group

7. To add one or more members to the new group, click Add. 

8. In the Select Users, Computers, or Groups dialog box, under “Enter the object names to 
select,” type the name of the user account or group account that you want to add, and then 
click OK.

9. In the New Group dialog box, click Create, and then click Close.

Creating ISIS Users on the System Director

ISIS FTP users created on the Windows operating system must also be created on the ISIS 2000 
System Director using the ISIS 2000 Management Console. The ISIS client username and 
password must match the username and password on the Windows operating system. For 
instructions on creating ISIS client users, see the Avid ISIS Administration Guide. 

Creating a Virtual Host Name

Port 21 is a shared port between the ISIS FTP Share and the Blade FTP Share. A virtual host 
name must be created using a different name than the actual host name (an alias name is 
required). The following procedure describes how to create an virtual name. 

To create a virtual host name using the FTP Site Bindings:

1. Right-click My Computer and select Manage on the System Director.

The Server Manager window opens.

2. In the left pane of the Service Manager window, click the plus sign (+) to expand the Roles > 
Web Server (IIS) > Internet Information Services (IIS) Manager. 
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3. In the Connections pane, click the plus sign (+) to expand your System Director name > 
Sites > and select ISIS FTP Share. 

4. In the Actions pane, click Bindings.

5. In the Site Bindings window, select the FTP entry and click Edit.

6. Enter a virtual hostname in Host name text box.

n This hostname must not match the actual hostname of the System Director. It must be unique in 
order to share port 21 and not conflict with the Blade FTP Site. Avid highly recommends you 
keep the Port setting and IP Address as is.
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7. Click OK.

8. Click Close.

Creating Virtual Workspaces

You must create Alias names for the accessible ISIS workspaces. 

To create virtual workspaces:

1. Right-click My Computer and select Manage on the System Director.

The Server Manager window opens.

2. In the left pane of the Service Manager window, click the plus sign (+) to expand the Roles > 
Web Server (IIS) > Internet Information Services (IIS) Manager. 

3. In the Connections pane, click the plus sign (+) to expand your System Director name > 
Sites > and select ISIS FTP Share. 

4. In the Actions pane, click View Virtual Directories.

5. In the Actions pane, click Add Virtual Directories.

The Add Virtual Directory window opens.

6. Enter the Alias name of the workspace, for example: workspace_name.

7. Type the network path to the workspace in the Physical path text box (for example, 
\\hostname\workspace name).

n For consistency and ease, Avid recommends that the workspace name and alias be similar.

8. In the Add Virtual Directory dialog box, click Connect as.

The Connect As dialog box opens. 
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9. In the Connect As dialog box, select Specify user and click Set.

The Set Credentials dialog box opens. 

10. Type administrator in the User Name text box and the administrator password in the 
Password text box. 

11. Re-type the administrator password in the Confirm password text box and click OK. 

12. Click OK to close the previous dialog boxes.

The Add Virtual Directory wizard completes and the newly created Virtual Directory is 
displayed in the ISIS FTP Sites folder workspace_name. 

13. Repeat these steps to create multiple workspaces.

Log In Using the Command Prompt

The following procedure describes how to access the ISIS workspace as a Windows FTP client.

To open an FTP session:

1. On your Windows FTP client, click Start > All Programs > Accessories and select 
Command Prompt.

2. Type ftp System_Director_hostname and press Enter.

n In the following example the virtual host name is Virtual-2000.global.avidww.com and the 
username is ftpuser.
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3. Type the virtual_hostname¦ftp_user_name and press Enter.

4. Type the user name password and press Enter.

n When finished with your FTP client session type “quit” to exit the session. 



8 Avid ISIS 2000 Upgrade Guidelines

This section provides a summarized list of what tasks need to be performed when upgrading 
Avid ISIS 2000. All Avid ISIS upgrades are to be performed by Avid ISIS Avid Certified 
Support Representatives (ACSR). 

The following list provides the order in which tasks need to be performed.

• If you have not already noted the host names, passwords, IP address, and other important 
network details, see “Preupgrade Information” on page 134. Although this information 
needs to be gathered before you start, the pages that include the blank tables are at the end of 
this document.

• Do not perform an Avid ISIS system upgrade if your network is not in optimum working 
order, see “Health Check” on page 123.

• If you have documented the preupgrade information and your Avid ISIS is healthy, you can 
start the Avid ISIS system upgrade, see “Software Upgrade Process” on page 124.

• After you finish the upgrade, confirm everything is functioning properly, see “Post Upgrade 
System Verification” on page 132.

Health Check

Before any changes are made to the system, perform the following quick checks to verify that the 
system is in good working order. Do not perform an upgrade if there are any issues with the 
system. Correct all problems before performing the upgrade.

Things to check before upgrading:

1. Log into the ISIS Management Console and click Storage Elements. All Storage Elements 
should be green, investigate any error statuses. 

2. Ping the ISIS 2000 System Director and any other ISIS system on the network. The System 
Director should be accessible from any client or switch on the Avid ISIS system. 

3. Ping the default gateway from System Director. This should be accessible from any point in 
the network. You can ping directly from the Tools > Network Utilities page in the 
Management Console.
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4. (Dual System Director Configuration) Log into the System Director and open the System 
Director’s Control Panel. Both paths should be up, and standby should be receiving and 
replicating metadata. Check the Metadata Status tab in the System Director’s Control Panel. 
The date stamp in the saved and replicated fields should be current and updating frequently. 
Standby instructions only apply if there is a failover machine present.

5. Check the system event logs on the System Directors for recent error events. 

6. Perform a thorough physical inspection of the network cables looking for:

- Missing retainers, strains, sharp bends, signs of physical abuse. 

- Ensure that labels are visible, physically firmly in place, and legible. 

- Confirm that all fans and ventilation areas are free of obstructions, dirt, lint, and debris. 

- Ensure that there is clearance front and rear to allow components to be replaced without 
obstructions for their full chassis travel length. 

- Make sure cables are not zip tied to the power supplies or the switches. 

7. (Dual System Director Configuration) Perform System Director Active to Standby Failover 
— Turn off one of the System Directors and verify in the System Director Control Panel that 
the Active Mode indicator has turned red. Turn the System Director back on and see that 
Active Mode displays Standby.

8. Check the system drive status on the System Director. 

On the ISIS 2000 System Director, click Start > Programs > Intel -> Intel Rapid Storage 
Technology right-click the Intel Rapid Storage Technology icon in the task bar. The icon 
should be a green check mark when the drives are healthy. 

Software Upgrade Process

After noting the necessary network and system component information listed in “Preupgrade 
Information” on page 134 you are ready to upgrade the Avid ISIS. The following is a typical 
procedure for upgrading the ISIS 2000 software. Read the upgrade section in the ISIS ReadMe 
for upgrade instructions specific to the latest release. 

To upgrade ISIS 2000 v4.2 and earlier to v4.5 and later:

1. Download the ISIS software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

2. (If applicable) Log into Administrator account on the Standby System Director and Stop the 
Standby System Director using the ISIS Control Panel. 

3. Make a copy of your current metadata files. The following are the file names and where they 
are located: 

http://www.avid.com/US/support/downloads
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Metadata location 
D:\Program Files\Avid\ISIS System Director

- Partition0

- Partition1

- PartitionDump.bin

4. Load the ISIS software kit on the System Director. 

5. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

6. If not already selected, select ISIS 2000 System Director from the “Select Software 
Package” menu. 

7. Click Apply.

8. Follow the screen prompts accepting the defaults and License agreement.

n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the 
removal of the File Gateway software. Type Y to confirm the removal and continue with the 
upgrade.

9. Once the installation is complete, click Finish.

You are prompted now to restart the System Director. After the System Director has 
restarted, continue with the next step.

10. Upgrade your Storage Manager, using the ISIS Management Console > Storage Managers. 
Select the original Storage Manager (typically labeled SM000) and click Upgrade. 

The Upgrade Storage Managers window opens.

11. Select the .zip file for the new release, and click Upgrade.

If you have an ISIS 2000-120 configuration your upgrade is finished. Continue with this 
procedure if you have an ISIS 2000-240 configuration.

12. (ISIS 2000-240) Select the Storage Manager from the list and click Details.

The Status for the upgrade is shown in the Details pain at the right of the window. Click the 
Refresh button whenever you want the updated Status. When the Status displays “Data 
Conversion Mode,” continue with the next step.

13. (ISIS 2000-240) Double-click the IP address of the original Storage Manager in the Details 
pane to open ISIS 2000 Storage Manager Agent Web page. 

14. (ISIS 2000-240) You are asked for the password. Type se-admin.

The ISIS 2000 Storage Manager Agent page appears.

15. (ISIS 2000-240) Click Network in the left pane of the System tab. 
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16. (ISIS 2000-240) Enter an IP address in the gx0:1 and Netmask text boxes in the Data 
Interfaces section. 

Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires 
dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same 
subnet as the original IP address. 

n A second physical cable is not needed, both IP address are handled through the existing 10 Gb 
connection between Engine Controller and the switch. 

17. (ISIS 2000-240) Click Submit.

a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

b. A second dialog box appears, type se-admin. in the password box and click Reboot. 

18. (ISIS 2000-240) When the Engine has restarted, open the Storage Manager page in the 
Management Console.

n When you upgrade from v4.2 and earlier to v4.5 and later, you will notice there are now two 
Storage Managers in the Storage Managers page displaying half the capacity that was previous 
listed and the Status column displays “Data Conversion Mode.” This is a normal one-time 
behavior when you upgrade from v4.2 and earlier to v4.5 and later.
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c Do not add any new ISIS 2000 Engines to this existing Storage Group until the ISIS v4.5 
upgrade data conversion redistribution has completed.

19. Update your Avid ISIS client software.

ISIS 2000-120 to ISIS 2000-240 Engine Upgrade

The ISIS 2000-120 has 42 media drives with two drives reserved as hot spares. The drives are 
configured in the Avid ISIS-120 Engine as four RAID 6 groups (10 drives in each group) with 
two hot spares initially created in the bottom drawer. For slot configurations, see “Drive Array 
and Slot Locations” on page 25.

When you convert your ISIS 2000-120 Engine to an ISIS 2000-240, you are adding 40 media 
drives to the open slots in the Engine. The 40 new drives are configured into four more RAID 
groups (10 drives in each group) for a total of eight RAID groups in the Avid ISIS-240 Engine. 

Once you have updated your ISIS 2000-120 infrastructure to the latest ISIS software, that is 
when to update add the 40 new drives (120 TB) to the existing ISIS 2000-120 Engine and Bind 
the new Storage Manager. After the new Storage Manager is Bound, you can add additional 
ISIS 2000 Engines and Bind them. Then select all your new Storage Managers and do a single 
Add redistribution. 

The process for updating your ISIS 2000-120 to ISIS 2000-240 Engine is as follows:

To the ISIS 2000-120 Engine to an ISIS 2000-240 Engine:

1. Update your existing ISIS 2000-120 environment (including the Engine) to the latest release.

a. Download the ISIS software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

b. (If applicable) Log into Administrator account on the Standby System Director and Stop 
the Standby System Director using the ISIS Control Panel. 

c. Make a copy of your current metadata files. The following are the file names and where 
they are located: 

Metadata location 
D:\Program Files\Avid\ISIS System Director

- Partition0

- Partition1

- PartitionDump.bin

d. Load the ISIS software kit on the System Director. 

e. Double-click the Autorun.exe file in the software kit.

http://www.avid.com/US/support/downloads
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The installer detects the existing version of the installed software (if any) and displays 
the components that need to be upgraded in the splash screen. 

f. If not already selected, select ISIS 2000 System Director from the “Select Software 
Package” menu. 

g. Click Apply.

h. Follow the screen prompts accepting the defaults and License agreement.

n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the 
removal of the File Gateway software. Type Y to confirm the removal and continue with the 
upgrade.“Installing the Media Drives” on page 48.

i. Once the installation is complete, click Finish.

You are prompted to restart the System Director. 

j. After the System Director has restarted, upgrade your Storage Manager, using the ISIS 
Management Console > Storage Managers. Select the Storage Manager (typically 
labeled SM000) and click Upgrade. 

The Upgrade Storage Managers window opens.

k. Select the .zip file for the new release, and click Upgrade.

The ISIS 2000-120 upgrade is finished. 

2. Access the ISIS Management Console Storage Manager Agent Page > System tab > 
Network and note the hostname and IP addresses.

n The default Agent Administrator password is “se-admin.”

3. Stop the System Director service using the ISIS Control Panel or Launch Pad. 

Once the System Director service is stopped, you can only access the Agent page in next 
step using the Engine IP address you have just noted. 

4. Shutdown the Engine Controller using the Storage Manager Agent Web page via the Engine 
IP address: https://IP_address:5015.

a. Type the Administrator password into the password field.

The ISIS 2000 Storage Manager Agent page appears.
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b. Click the Advanced tab.

c. Select Shutdown from the left pane.

d. Type the Administrator password into the password field and click Shutdown. 

e. Allow 1 minute for the buffers to clear and turn off the power to the Engine (two power 
supply switches).

5. Insert your new-unused ISIS drives into the open drive slots in the ISIS 2000 Engine 
according to the “ISIS 2000-240 Media Drive Configuration” on page 25. For instructions 
on installing media drives, see “Installing the Media Drives” on page 48.

If you have one or more used drives, you must clear the foreign configuration after they are 
installed in the Engine, see “Clearing Foreign Configurations on Used Drives” on page 131.

6. Power on the ISIS Engine and wait a couple minutes to let the drives come up to speed. 

7. Start the System Director service using the ISIS Control Panel or Launch Pad. 

8. Open the Storage Manager window, using the ISIS Management Console > Storage 
Managers. 

9. Select the original Storage Manager from the list and click Details.

10. Double-click the IP address of the original Storage Manager in the Details pane to open 
ISIS 2000 Storage Manager Agent Web page. 

11. You are asked for the password. Type se-admin.

The ISIS 2000 Storage Manager Agent page appears.

12. Click Network in the left pane of the System tab. 
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13. Enter an IP address in the gx0:1 and Netmask text boxes in the Data Interfaces section. 

Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires 
dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same 
subnet as the original IP address. 

n A second physical cable is not needed, both IP address are handled through the existing 10 Gb 
connection between Engine Controller and the switch. 

14. Click Submit.

a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

b. A second dialog box appears, type se-admin. in the password box and click Reboot. 

15. When the Engine has restarted, open the Storage Managers page in the Management 
Console.

c Do not add any new ISIS 2000 Engines to this existing Storage Group until the ISIS v4.5 
upgrade data conversion redistribution has completed.

16. Access the Storage Manager Agent Web page for the new Storage Manager. 

17. Click RAID Diagnostics > Create RAID Config in the left pane of the Advanced tab. 
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This creates the RAID groups and could take several minutes, wait until a message informs 
you that the configuration has completed. 

18. Bind your new Storage Manager, using the ISIS Management Console > Storage Managers 
page. For binding instructions, see “Binding the Storage Managers” on page 78. 

n After the new Storage Manager is Bound, you can add additional ISIS 2000 Engines and Bind 
them. Then select all your new Storage Managers and do a single Add redistribution. For Add 
redistribution instructions see the Avid ISIS Administration Guide.

19. Update the software on your Avid ISIS clients.

Clearing Foreign Configurations on Used Drives

If installing used drives into your ISIS 2000 Engine, use the following procedure to clear the 
configuration and make the used drive into a raw spare.

To replace a drive with a drive that is not raw:

1. To open the Storage Manager Agent, do one of the following. For more information see the 
Avid ISIS Administration Guide.

t From the Storage Managers tool, select an IP address from the IP Addresses panel of the 
Details panel, and click the Info button. 

t From the Storage Elements tool, select an IP address from the IP Addresses panel of the 
Details panel, and click the Info button. 

t From the System Director desktop, click the “Storage Manager Agent Page” button on 
the ISIS Launch Pad. 

2. Type the Administrator password into the password field.

n The default Agent Administrator password is “is-admin.”

3. Click the Advanced tab.

If the System Status Panel in the Management Console reports a foreign disk or no spare. 
Use this function to clear the foreign configuration and create a spare disk. This function 
requires the Administrator password.

c Resetting a disk is a destructive operation which will permanently delete all data currently 
stored on the disk.

4. Select Clear Foreign Config from the left pane.

5. Type the Administrator password into the password field. 
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Post Upgrade System Verification

After upgrading a system it is important to do a series of checks to verify that all upgraded 
components are functioning optimally.

To verify the upgrade:

1. Verify network connectivity for all components:

a. Ping all Engines.

b. Ping System Director from any client.

c. Ping the virtual System Director.

2. Verify the System Director is functioning properly by checking the following:

a. Check if any new errors are getting generated in the event logs.

b. Lights in System Director’s Control Panel should be green, some lights will be blue.

c. Metadata should be replicating between the two System Directors. The Standby should 
be toggling between receiving and replicated. Check the Metadata Status tab on the 
standby. The date stamp in the saved and replicated fields should be current and 
updating frequently. 

d. Check the RAID status on the System Director.

On the System Director, click Start > Programs > Intel -> Intel Rapid Storage 
Technology right-click the Intel Rapid Storage Technology icon in the task bar. The icon 
should be a green check mark when the drives are healthy. 

3. Perform System Director Active to Standby Failover — Turn off one of the System 
Directors and verify in the System Director Control Panel that the Active Mode indicator has 
turned red. Turn the System Director back on and see that Active Mode displays Standby.

4. Run PathDiag on a client. To set PathDiag Tool:

a. Do one of the following:

- (Windows) Select Start > All Programs > AvidUnityISIS > PathDiag.

- (Macintosh) Select Go > Applications, and then double-click the AvidUnityISIS 
folder.

b. Click Start > Avid Unity ISIS Program group> Path Diag. 
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c. Click Setup.

d. Set “Path to Test” to a mounted ISIS workspace letter. (Check in my computer if not 
sure) Make sure its an ISIS workspace and not the internal C: drive. 

e. Set the duration 10 minutes. 

f. Click Custom Test and set the following parameters:

g. Click Ok and Start.

- 1-Gb clients that are not bandwidth limited should expect at least 65 MB/sec in the 
Path Diag tool.

Custom Test 
Settings

1 Gb client
(not bandwidth limited)

10 Gb Client
(not bandwidth limited)

File Access Method Automatically select Automatically select

Reads vs Writes Writes, then Reads (Sequential) Writes, then Reads (Sequential)

Transfer Size 4096 16384

Transfer Rate Unlimited Unlimited

Max File Size 1000 1000
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- 10-Gb clients that are not bandwidth limited should expect at least 500 MB/sec for 
reads and at least 200 MB/sec for writes in the Path Diag tool.

5. While Path Diag is running check the system to make sure that there are no Network 
Degraded status indications. Check the following:

a. In the ISIS Management Console, click Storage Elements. All drives should be green 
and not displaying any Network Degraded states.

b. Check the drives by browsing to the Storage Element web page and verify you have a 
green indicator. Click Refresh in the Management Console page to update the page. 

6. Check your ISIS 2000 clients in Zone 2 and 3 using Path Diag. 

a. Run a Path Diag client over each switch.

b. Run a couple of Zone 3 path diag clients and verify consistent performance.

n ISIS 2000 does not support Zone 1 clients. A Zone 3 client might not have the bandwidth of a 
Zone 2 client. 

Preupgrade Information

Gather the following information before the upgrade. This information is critical to 
troubleshooting an Avid ISIS. 

• Current Avid ISIS software version

• Avid ISIS Administrator password

• Number of Avid ISIS Engines 

• Drive size: 3 TB____ (currently only supports 3 TB drives)

• Number of Storage Groups 

• Number and type of editing clients: (Windows or Macintosh, and using what zones) 

• Number of AirSpeeds

• Other workgroup server details (for example Interplay; host names, passwords, and 
versions)

Zone 2 Switch Information

Note the following switch information:

• Switch manufacturer and model (Cisco/Foundry)

• Number of switches

• Location of configuration files
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System Director Information

Note the following System Director information:

Virtual Network Name and IP Addresses

1 Gb port IP address

10 Gb port IP address

Virtual ISIS Name

System Director

Host name

Administrator Password

IP address

ISIS IP Address 

Default Gateway

First failover IP address

Second failover IP address

System Director 2

Host name

Administrator Password

IP Address

Left ISIS IP Address

Left Default Gateway 

Right ISIS IP Address 

Right Default Gateway 

First failover IP address

Second failover IP address
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ISIS Engine Information

Fill out the following Engine IP address information for the on site equipment.

On Site Spares

List all Avid ISIS spare parts that are onsite:

Engine #1, Serial Number

Engine IP:

Engine #2, Serial Number

Engine IP:

Spare Components and Cables

Part Quantity Firmware Version (if known)

Drives

XFP, X2, and SFP+ 
(used with external switches)

N/A

Intel® network boards

10-GB fiber cable N/A

CAT5e/6/7 cable N/A

Xenpack® (if Cisco)

3rd party switches

Additional Parts Available
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Spares Checklist

Use the following list to assure that you have the correct parts onsite when performing any Avid 
ISIS upgrade. This can be a mix of customer spares and parts brought onsite by upgrade 
technicians.

• 2 — drives

• 1 — SFP+ 

Additional spares for a comprehensive spares parts list:

• If Cisco switches are in use: 1 Xenpack, 1 SC-LC cable

• If Force10 switches are in use: 1 additional SFP+, 1 LC-LC cable 



9 Avid ISIS Recommended Maintenance

The following maintenance recommendations are not meant to be a troubleshooting guide but 
more of a care and monitoring checklist for Avid ISIS. Typically the Avid ISIS does not need to 
be power cycled. All components of the ISIS stack can individually be replaced or restarted 
without interfering with the operation of ISIS stack. 

c Power cycling the entire stack (all the components at the same time) could risk the stability 
of the ISIS stack. 

For information on using the tools described in this section, see the Avid ISIS Administration 
Guide. 

Minimum Storage Space Requirement

The recommended amount of space you must maintain for background functionality and failures 
is 5% of free space in each Storage Group. In other words, you should not fill Storage Group 
more than 95% full. Exceeding 95% used space can produce severe performance issues in some 
situations. 

To calculate the right amount of free space, log into the ISIS management Console and navigate 
to the Storage Group window. For each Storage Group, take the Effective number and multiply 
by 0.05. This will be your recommended free space in GBs. To assure that your Storage Group 
never exceeds the recommended amount of space, create a new workspace in this Storage Group 
with the recommended free space and label it “Headroom” and do not give anyone access to this 
workspace. 

Daily Maintenance 

The following contains a list of items you should do on a daily basis. It is estimated to take 15 
minutes to perform these functions.

• Check the Storage Elements status: Open the ISIS Management Console and click Storage 
Elements.

- You should see a green circle beside the Storage Elements in the Name column

- Check the Status column for errors or Network Degraded 
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The Status column in the Storage Elements report the status of the storage element 
logged by the System Director. (The Status line in the Details area reports the same 
information.) When the storage element maintains a working status, the Management 
Console displays no entries in the Status field. If a problem arises, or when the status of 
the Storage Element changes, the Management Console updates the Storage Elements 
dialog box. 

• Start the Management Console and check the Error, Warning and Info tabs in the System 
Status Console for errors.

Information is displayed in blue and errors display as red or yellow components with a 
warning icon.

• Check System Director Control Panel for errors, make sure there are no red indicators in the 
status box. 

- Check for green indicators beside the “System Director is running”

- Check that a blue or green indicator is displayed beside “Replicated” on the Active 
System Directory

- If the event log indicator is not green, check the Windows Event logs on the Active 
System Director

• Check System Director Control Panel on the Standby System Director for errors. 

- Verify the Standby System Director is “Started” and in “Standby” Mode. Check for 
green indicators beside the “System Director is running” and “Both paths are up”

- Check that a blue or green indicator is displayed beside “Receiving” 
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- If the event log indicator is not green, check the Windows Event logs on the Standby 
System Director 

• Check that the Avid ISIS Workspaces have “Free Space” available: Open the ISIS 
Management Console and click Workspaces, see “Minimum Storage Space Requirement” 
on page 138.

Weekly Maintenance

The following contains a list of items you should do on a weekly basis. It is estimated to take 30 
minutes to perform these functions.

• Review Windows Event logs on the System Directors

• Check the network connections using the Management Console > Tools > ISIS Toolbox > 
Connection Analyzer. All Storage Elements should be green.

• Check the RAID status on the System Director.

On the System Director, click Start > Programs > Intel -> Intel Rapid Storage Technology 
right-click the Intel Rapid Storage Technology icon in the task bar. The icon should be a 
green check mark when the drives are healthy. 

• Make sure you have at least one 5% worth of free space in the Storage Group, see 
“Minimum Storage Space Requirement” on page 138. 

Saving ISIS Metadata

This procedure describes how to save the metadata stored on the system drives in the ISIS 
System Director. This procedure would typically only be needed in the event of a hardware 
replacement where both system drives or the System Director server itself will be replaced in an 
active ISIS installation. 

Regardless of how many Engines you have, all the metadata for all the media drives, in all of the 
Engines, are saved on the System Director. The Engines do not store any metadata. 

To save the System Director metadata:

1. Stop the System Director service using the ISIS Control Panel. 

n The System Director is constantly writing metadata. Metadata files are always open and locked, 
so the best way to copy the metadata files is to stop the System Director service so the files are 
closed.

2. Copy the Partition0 and Partition1 files from the following location on the System Director:

D:\Program Files\Avid\ISISSystemDirector
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n There is also a PartitionDump.bin file. This file is also helpful when identifying the data on 
the media drives. If possible, include this file with the two Partition metadata files.

The following are a couple suggested ways of saving the Partition0 and Partition1 
PartitionDump.bin files.

- Use a USB flash drive that has the capacity for the Partitionx files (at least a 4 GB USB 
is recommended).

- Create a network share on a client system on the network and copy the Partitionx files to 
that shared folder. 

3. Verify that you have the current copy of the Metadata by comparing the date in the Metadata 
tab of the ISIS control Panel.

4. Start the System Director service using the ISIS Control Panel.

Available Utilities

The following is a list of headings in the Avid ISIS Administration Guide that describe other 
utilities and tools for monitoring and troubleshooting.

• Avid ISIS System Director Control Panel

• ISIS Management Console

- Changing the Administration Password

- Setting up Error Notification

- Avid ISIS Snapshot Tool

- Using the Profile Tool

• System Statistics

• System Logging

- Accessing the Logging Window

- Viewing Event Logs

• Avid ISIS Connection Analyzer Tool

• Avid ISIS Log Aggregator Tool

• Avid ISIS Disk Analyzer Tool 
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• Avid ISIS Agents

- Agent Tools

- Log Viewer Tool

• System Director event message meanings

Client Manager Maintenance

If you suspect a poor connection between your client system and a mounted workspace, you can 
test the Avid ISIS shared storage network connection between each client system and the shared 
storage network using the Avid PathDiag tool. This tool informs you if there is sufficient 
read/write throughput for read and write operations needed by the client system. For more 
information on using the Avid PathDiag tool see, Avid ISIS Client Manger Guide. This guide also 
describes the following Administrative tasks:

• Clearing Cached Data

• Using Logs and Messages

Status Indicators and Troubleshooting

If the LEDs on the Engine or drives are indicating a problem, identify the problem using the 
information under, “Status LEDs” on page 144. 

Complete Server Room Shutdown

There is no requirement to power cycle the entire Avid infrastructure but, if the need arises to 
turn off all the equipment (such as a relocating the server room), turn off the components in the 
following order. When turning on the component, use the reverse order.

To shut down the entire Avid network (server room):

1. Shutdown all Avid editing system and attached media I/O equipment, for example Avid 
Mojo and Avid Adrenalines.

2. Shutdown all capture and playout servers such as AirSpeeds.

3. Shutdown CaptureManager Server.

4. Shutdown Interplay Transfer Server.

5. Shutdown Avid Interplay Media Services and Providers.

6. Shutdown Interplay Engine and Avid Interplay Archive Engine.

7. Shutdown Media Indexers — Do not stop the Media Indexer while it is indexing storage.

8. Shutdown Systems running Interplay Framework Multicast Repeaters.

9. Shutdown Systems running the Interplay Framework Lookup Service.
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10. Invoke a Failover on your Avid ISIS 5500 | 5000 and ISIS 7500 | 7000 System Directors.

11. Shutdown Standby Avid ISIS System Director.

12. Shutdown Active Avid ISIS System Director.

13. Shutdown Avid ISIS Engines.

14. Shutdown the network switches.

n Power up the entire rack of equipment in reverse order and verify all clients have mounted the 
necessary ISIS Workspaces.



10 Status LEDs

This chapter provides an explanation of the light-emitting diodes (LEDs) located on the different 
sections of the Avid ISIS 2000 Engines. The following sections are included:

• Status LEDs

• Hardware Faults

• Front Panel LEDs

• Drawer LEDs

• Power Supply LEDs

• Cooling Module LEDs

• Media Drive LED

• Engine Controller LEDs

• Thermal Sensors

n When the Engine is powered on, all LEDs are lit for a short period to ensure that they are 
working. This does not indicate a fault unless the LEDs remain lit after a few seconds.

Hardware Faults

LED colors are used consistently throughout the Engine and its components for indicating status:

• Green – good or positive indication.

• Flashing green/amber – non-critical condition.

• Amber – fault.

Ensure that you have obtained a replacement module before removing any faulty module. 

c If the Engine is powered up and you remove a module, replace it immediately. If the system 
is used with any modules missing for more than a few seconds, the Engine can begin to 
overheat, causing power failure and data loss.

c Observe all conventional ESD precautions when handling Engine modules and 
components. 
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If the System Director and ISIS Engine are not communicating:

• Check that the network cables from the Engine and the System Director are cabled to the 
same ISIS switch.

• Check the indicators on the Engine Controller (see “Engine Controller LEDs” on page 151).

• Verify that the device driver for the operating system are operating properly.

Front Panel LEDs

The front panel LEDs displays the aggregated status of all the modules and indicate the 
following functions:

Cooling Module LEDs  

LED Description

Unit Identification Display Usually shows the identification number for the Engine, but can be used 
for other purposes.
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Drawer LEDs

The drawer LEDs indicate the following functions:

Power On/Standby LED Amber if the system is in standby. Green if the system has full power.

Module Fault LED Amber indicates a fault in a power supply, cooling module or Engine 
Controller. Check the drawer LEDs to see if a drive fault is indicated (see 
“Drawer LEDs” on page 146).

Logical Status LED Amber indicates a fault from something other than GEM (usually a media 
drive fault, host bus adapter, or RAID controller). Check the drawer LEDs 
to see if a drive fault is indicated (see “Drawer LEDs” on page 146)

Drawer 1 Fault LED Amber if there is a drive, cable or sideplane fault in drawer 1. Open the 
drawer and check the media drive LEDs for faults.

Drawer 2 Fault LED Amber if there is a drive, cable or sideplane fault in drawer 2. Open the 
drawer and check the media drive LEDs for faults.

Cooling Module LEDs (Continued)  

LED Description
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Drawer LEDs  

LED Description

Sideplane OK/Power Good Green if the sideplane card is working and there are no power problems.

Sideplane Fault Amber if a drive has failed. Replace the drive.

Logical Fault Flashes amber if one or more arrays are in an impacted state.

Cable Fault Amber if the cabling between the drawer and the back of the Engine has 
failed. 

Activity Bar Graph Shows the amount of data I/O from zero to six segments lit. When no 
segments are lit, there is no data I/O activity. When all six segments lit, the 
maximum data I/O activity.
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Power Supply LEDs

When you first encounter a problem with the power supply, check for:

• Missing or damaged power cords 

• Incorrect or ungrounded circuits

• Proper power is supplied to the Engine

The power supply LEDs indicate the following functions:

n When the Engine is powered on, all LEDs are lit for a short period to ensure that they are 
working. This does not indicate a fault unless the LEDs remain lit after a few seconds.

n If a power supply’s firmware is being programmed and the download fails, the power supply 
LEDs will flash.

Power Supply LEDs  

Power Supply 
Fail (Amber)

AC Missing 
(Amber) Power (Green) Status

Off Off Off No AC power to either power supply.

On On Off Power supply present, but not supplying 
power or power supply alert state (usually due 
to critical temperature).

Off Off On AC present and switch on. This power supply 
is providing power.

Off Off Flashing AC present and power supply in standby 
(other power supply is providing power).
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Cooling Module LEDs

The Cooling Module LEDs indicate the following functions:

Flashing Flashing Off Power supply firmware downloading. If the 
download fails, the power supply LEDs will 
flash.

Off On Off AC power missing, power supply in standby 
(other power supply is providing power).

On On On Software has lost communication with the 
power supply.

On — Off Power supply has failed. Replacing Power 
Supply, see “Power Supply Replacement” on 
page 165.

Power Supply LEDs (Continued)  

Power Supply 
Fail (Amber)

AC Missing 
(Amber) Power (Green) Status
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Media Drive LED

Each media drive has a single amber drive fault LED as shown in the following illustration. 
When lit, this indicates a drive failure – the drive should be replaced as soon as possible.

Cooling Module LEDs  

Led Description

Module Ok Constant green indicates that the fan is working correctly. If the green 
LED is off, the fan has failed. Replace cooling module, see “Cooling 
Module Replacement” on page 164.

Battery Fault Battery backup is not used in this product.

Fan Fault Amber indicates that a fan has failed. Replace cooling module, see 
“Cooling Module Replacement” on page 164. 
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Engine Controller LEDs

The LEDs on the Engine Controller are shown in the following illustration and table.
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Management Console Error Messages

The following sections suggest actions to perform on selected error messages in the Management 
Console. For information on all error messages, see the Avid ISIS Administration Guide. 

Missing Spare Drive Message

The “Missing spare drive” state from the Management Console can be caused by the following 
reasons:

• A legitimate media drive failure

• Drive was disconnected and reconnected while system was running.

• Attempting to replace a failed drive with a previously used drive.

A media drive failure and disconnecting a media drive causes the system to “fail” the drive and 
start rebuilding with the hot spare. For details on how to replace media drives, see “Media Drive 
Replacement” on page 159.

Engine Controller LEDs  

LED Description

ID Constant green if the Engine Controller is operating correctly. 

Fault This LED is not lit when the Engine Controller is operating correctly. the 
LED is constant amber if the Engine Controller is faulty. To replace the 
Engine Controller, see “Engine Controller Replacement” on page 166.

OK Power Constant green if the Engine Controller is operating correctly. Flashing 
green indicates an Engine Controller error.

SAS LEDs SAS connections to the Engine Controller are not supported. Any LED 
activity is not relevant to the ISIS 2000 operation. 
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To recover from a failed media drive:

1. Physically remove the failed drive (the drawer and drive Fault LED should be lit).

2. Insert the replacement drive.

3. After a short time, the Storage Manager makes the new drive a spare and clears the state (this 
could take a few minutes).

To recover from a removed/reconnected media drive or a previously used media drive 
(from another ISIS 2000 Engine was added as a replacement spare):

1. Open Storage Manager Agent.

2. Click Advanced > Disk Tools > Clear Foreign Config.

3. Enter password and click Clear.

4. After a short time, the Storage Manager makes the problematic disk spare and clears the 
state (this could take a few minutes)

Invalid Drive — Foreign Disk Message

The “Invalid drive - Foreign disk” status in the Management Console denotes that a physical disk 
is connected in the Engine, but is not either raw or already part of the existing ISIS configuration. 
This can happen if a disk has an existing file system or was moved from a running system. 

To recover from a removed/reconnected media drive or a previously used media drive 
(from another ISIS 2000 Engine was added as a replacement spare):

1. Open Storage Manager Agent.

2. Click Advanced > Disk Tools > Clear Foreign Config.

3. Enter password and click Clear.

4. After a short time, the Storage Manager should make the problematic disk spare and clears 
the state (this could take a few minutes)

Disk Performance Degraded Message

The “Disk performance degraded” status can appear for the following reasons:

• Failed physical disk

• Disks reporting too many long I/Os

For a failed disk, the status typically includes “Missing spare drive,” see “Missing Spare Drive 
Message” on page 152.
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To check for poorly performing disks:

1. Open Storage Manager Agent.

2. Click Statistics > Storage Manager > Disk.

Invalid Number of Disks Message

The “Invalid number of disks” status is an indication that the Storage Manage does not see the 
correct number of RAID arrays (or disks) for the Storage Manager. 

To check the RAID configuration:

1. Open Storage Manager Agent.

2. Click Advanced > RAID Diagnostics.

t Click Verify RAID Config.

t Click Show RAID Config.

t Click Show RAID Status.

Depending on your ISIS 2000 Engine configuration you should have four or eight arrays. 

If you do not have the correct number of arrays, make sure all drives are there (and in the 
correct slots for the ISIS 2000 configuration) You might need to do use the “Delete and 
Recreate” command in the Advanced tab to recover once all drives are available.

No RAID Arrays Exist

The RAID sets should be configured on install. The reason this might not have happened is that 
some or all of the drives were not present at install time. 

To manually build the RAID sets:

1. Open Storage Manager Agent.

2. Click Advanced > Destructive RAID Tools > Delete and Recreate.

3. Enter password and click Recreate.

The RAID sets start rebuilding and restarts the Storage Manager.

Not All RAID Arrays Are Active

In most cases the array attempted to start but could not and is left in an “inactive” state. This 
typically happens if multiple drives are not available at startup or all disconnect at the same time. 
In most cases restarting the offending arrays fixes this problem. To recovery from this is to use 
the “Repair Config” button.
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To repair the configuration: 

1. Open Storage Manager Agent.

2. Click Advanced > RAID Tools > Repair Config.

3. Enter password and click Repair.

The RAID sets start rebuilding and restarts the Storage Manager.

Thermal Sensors

Thermal sensors throughout the Engine and its components monitor the thermal health of the 
storage system. Exceeding the limits of critical values cause the over-temperature alarm to occur.

Thermal Monitoring and Control

The Engine uses extensive thermal monitoring and takes a number of actions to ensure 
component temperatures are kept low and also to minimize acoustic noise. Air flow is from the 
front to the rear of the Engine.

The following table provides a description of the ISIS 2000 Engine thermal alarm.

Engine Thermal Monitoring and Control

Symptom Cause Action

If the ambient air is below 25 
°C and the fans increase in 
speed. Any restriction of 
airflow can cause the internal 
temperature to rise.

n This is not a fault 
condition.

The first stage in the thermal 
control process is for the 
fans to automatically 
increase in speed when a 
thermal threshold is reached. 
This can be caused by higher 
ambient temperatures in the 
local environment and be 
perfectly normal.

n This threshold 
changes according to 
the number of drives 
and power supplies 
fitted.

• Check the installation for any airflow 
restrictions at either the front or rear of 
the Engine. A minimum gap of 25 mm 
at the front and 50 mm at the rear is 
recommended.

• Check for dust build-up. Clean as 
appropriate.

• Check for excessive re-circulation of 
heated air from rear to the front. Use of 
the Engine in a fully enclosed rack is not 
recommended. 

• Check that all blank modules are in 
place.

• Reduce the ambient temperature.
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Thermal Alarm

The following table provides a description of the ISIS 2000 Engine thermal alarm.

The ISIS 2000 Thermal Audio Alarm

Symptom Cause Action

Front panel module fault 
LED is amber.

Fan fail LED is lit on one or 
more cooling modules.

The internal temperature has 
exceeded a pre-set threshold.

• Check that the local ambient 
environment temperature is within 
specification (see “Environment” on 
page 190). 

• Check the installation for any airflow 
restrictions at either the front or rear of 
the Engine. A minimum gap of 25 mm 
at the front and 50 mm at the rear is 
recommended. 

• Check for dust build-up. Clean as 
appropriate.

• Check for excessive re-circulation of 
heated air from rear to the front. Use of 
the Engine in a fully enclosed rack is not 
recommended.

• If possible shutdown the Engine and 
investigate the problem.



11 Adding and Replacing Hardware

This chapter provides procedures for adding and replacing components in your Avid ISIS. Avid 
ISIS hardware additions and replacements are to be performed by Avid ISIS Avid Certified 
Support Representatives (ACSR). 

Do not add any hardware if there are any issues with the system. Correct all problems before 
adding new hardware and making changes to the system, perform quick checks to verify that the 
system is in good working order, see “Health Check” on page 123.

The following components can be hot-swapped by the user in the field without removing the 
Engine from its rack:

• Media Drive Replacement

• Cooling Module Replacement

• Power Supply Replacement

• Replacing an Internal System Director Drive

c Do not lift the Engine by the handles on the power supply units, cooling modules or Engine 
Controllers – they are not designed to take the weight.

c Always have available a replacement or blank module before removing the old module. 
When you replace a module, you must never leave a bay empty or drive drawer open more 
than 10 minutes. 

c It is recommended that you use a suitable anti-static wrist or ankle strap and observe all 
conventional ESD precautions when handling plug-in modules and components. 

Continuous Operation During Replacement 

Your hardware or software Engine management application determines the capability of 
replacing a failed disk without loss of access to any file system on the Engine. Engine access and 
use during this period is uninterrupted.

If an Engine contains two power supplies, one of them can maintain power to the system while 
the other is replaced.
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Media Drive Drawer

This section describes how to open the media drive drawer and replace a media drive. The 
procedure is the same for both drawer 1 and drawer 2. 

To open a drive drawer:

1. Make sure the anti-tamper locks are not engaged. The red arrows on the locks will point 
inwards if the locks are disengaged. Unlock them if necessary by rotating them 
counterclockwise using a screwdriver with a torx T20 bit.

2. Push the drawer latches inward and hold them.

3. Pull the drawer all the way out until it locks open.
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To close a drive drawer:

1. Pull and hold both of the white latches on the sides of the drawer.

2. Push the drawer in slightly.

3. Release the white latches.

4. Push the drawer all the way back into the Engine, making sure it clicks in place.

Media Drive Replacement

When a RAID media drive fails, the ISIS automatically replaces the failed drive in the RAID set 
with the hot spare. You can identify the failed drive by locating the drawer on the front that has a 
drive fault LED lit, see “Engine Control Panel” on page 19. When you have a failed drive, the 
Status section in the Management Console displays amber and states the drive set is rebuilding 
with the percentage of how much of the RAID set rebuild has completed. You can remove a 
failed media drive whenever the LED has indicated that the drive has failed. The rebuild process 
does not need to be completed before the failed drive can be removed. The status remains yellow 
until the rebuild is finished and a new hot spare has been inserted. When the new hot spare is 
inserted, the ISIS 2000 automatically makes the raw drive into a spare.

c When replacing a failed media drive in the ISIS 2000-120, you must install the replacement 
drive in the slot where you removed the failed drive. Do not install replacement drives in 
the slots identified as “Not Used” in the illustrations shown in “ISIS 2000-120 Media Drive 
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Configuration” on page 26. 

n You do not need to stop the System Director to replace a single drive. 

As long as you have a spare drive in the Engine the RAID controller automatically starts 
repairing a RAID group using the spare when:

• The RAID controller identifies a drive has failed.

• A media drive has been physically pulled from the Engine (without being identified using 
one of the two previous conditions).

Removing a Media Drive

The procedure for replacing media drives is the same for both drawer 1 and drawer 2. 

To remove a media drive:

1. Make sure the anti-tamper locks are not engaged. The red arrows on the locks will point 
inwards if the locks are disengaged. Unlock them if necessary by rotating them 
counterclockwise using a screwdriver with a torx T20 bit.

2. Open the appropriate drawer, see “Media Drive Drawer” on page 158.

3. Locate the drive to be replaced, by looking for the amber LED on the drive that indicates a 
fault see “Media Drive LED” on page 150.
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4. Push the drive carrier latch in the direction shown in the following illustration to unlock the 
drive.



Media Drive Replacement

162

5. Pull the drive upwards and out of the drawer.

n If you are not going to replace the drive immediately, close the drawer so that correct airflow 
and cooling are maintained in the Engine.

Replacing a Media Drive

When the new media drive is inserted, the ISIS 2000 automatically makes the new drive into a 
hot spare. 

To insert a media drive:

1. If the appropriate drawer is not already open, open it using the instructions in section see 
“Media Drive Drawer” on page 158.

2. Lower the Media Drive into the slot, with the drive capacity label facing towards you.

3. Push the media drive downwards and hold it down while sliding the drive carrier plate in the 
direction shown in the following figure. This locks the drive in place.

Make sure the drive is securely locked into place before closing the drawer.
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4. Close the drawer see “Media Drive Drawer” on page 158.

The new drive now becomes the hot spare.

Forcing a Foreign Drive to Become a Spare

If the new media drive is not automatically imported as a hot spare and the System Status Panel 
in the Management Console reports a foreign disk or no spare, use the following steps to clear 
the foreign configuration and create a spare disk. This function requires the Administrator 
password.

To clear a drive that displays as a foreign drive:

1. Open the Storage Manager Agent, do one of the following. For more information see the 
Avid ISIS Administration Guide.

t From the Storage Managers tool, select an IP address from the IP Addresses panel of the 
Details panel, and click the Info button. 

t From the Storage Elements tool, select an IP address from the IP Addresses panel of the 
Details panel, and click the Info button. 

2. Type the Administrator password into the password field.

n The default Agent Administrator password is “se-admin.”

3. Click the Advanced tab.

c Resetting a disk is a destructive operation which permanently delete all data currently 
stored on the disk.

4. Select Clear Foreign Config from the left pane.
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5. Type the Administrator password into the password field right pane and click Clear. 

Cooling Module Replacement

This section describes how to replace the cooling module. 

n You should have a replacement module to insert before removing a module. When the Engine 
power is left on, a new cooling module should be inserted within two minutes of the removal of 
the defective cooling module.

To remove a cooling module:

1. Identify the cooling module to be removed. If the module has failed, the fan fault LED will 
be lit amber.

2. Push down and hold the red release latch (1) and pull the module out by its handle (2).
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To insert a cooling module:

1. Position the cooling module so that the red release latch and handle are on the right-hand 
side.

2. Slide the cooling module into its slot until the latch clicks in place. The Engine will 
automatically detect and make use of the new unit.

Power Supply Replacement

This section describes how to replace the power supply. 

n You should have a replacement module to insert before removing a module. When the Engine 
power is left on, a new power supply should be inserted within two minutes of the removal of the 
defective power supply. 

n Do not lift the Engine by the handles on the power supply units, cooling modules or Engine 
Controllers – they are not designed to take the weight. 

To remove a power supply:

1. Identify the power supply to be removed. If the module has failed, the fan fault LED will be 
lit amber.

2. Push the red release latch to the right and hold it (1), then pull the module out by its 
handle (2). 
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To insert a power supply:

1. Position the power supply so that the red release latch and handle are on the left-hand side.

2. Slide the power supply into its slot until the latch clicks in place. The Engine will 
automatically detect the new unit.

Engine Controller Replacement

This section describes how to replace the Engine Controller. If the Engine Controller has failed, 
the fault LED will be lit red.

n You should have a replacement module to insert before removing a module. When the Engine 
power is left on, a new Engine Controller should be inserted within two minutes of the removal of 
the defective Engine Controller.
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c The Engine Controller module is only supported in the left slot (as seen from the rear of the 
Engine). Do not install the Engine Controller in the right slot, the software will not run.

To remove a Engine Controller:

1. If the Engine Controller is still accessible through the ISIS Management Console Agent 
Page, log into the ISIS Management Console Storage Manager Agent Page > System tab > 
Network and note the hostname, IP address, and other important network details.

n The default Agent Administrator password is “se-admin.”

If the Engine Controller is not accessible through the ISIS interface, continue with step 2 and 
skip to 4; removing the cables and pulling out the Engine controller.

Leave the ISIS Management Console Storage Manager Agent Page open, you need it access 
the Agent Page in step 3.

2. Stop the System Director service using the ISIS Control Panel or Launch Pad. 

Once the System Director service is stopped, you can only access the Agent page in step 3 
using the Engine IP address you have just noted. 

3. Shutdown the Engine Controller using the Storage Manager Agent Web page via the Engine 
IP address: https://IP_address:5015.

a. Type the Administrator password into the password field.

The ISIS 2000 Storage Manager Agent page appears.

b. Click the Advanced tab.

c. Select Shutdown from the left pane.
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d. Type the Administrator password into the password field and click Shutdown. 

e. Allow 1 minute for the buffers to clear and turn off the power to the Engine (two power 
supply switches).

4. Make note of the locations of all Ethernet cables (1-Gb, 10-Gb) and disconnect them from 
the failed Engine Controller.

5. Pinch the latch on the Engine Controller and pull the handle towards you (1). 

This will lever the controller out of its connector on the midplane.

6. Pull the Engine Controller out of the Engine (2).

7. Install and configure the new Engine Controller as described in the following procedure.

To insert an Engine Controller:

1. Position the Engine Controller so that the release latch is at the bottom.

2. Open the release latch and rotate it to its most open position.

3. Slide the Engine Controller into its slot until it will go no further.

4. Close the latch until it clicks in place. 

This will lever the Engine Controller into its connector on the midplane. The Engine 
automatically detects the new unit.
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5. Reconnect the Ethernet cables to the new Engine Controller (if necessary, refer to the notes 
you made before removing the cables). 

6. Using a System Director (or computer running a Windows operating system), connect an 
Ethernet cable between the 1 Gb network port of the System Director and the management 
port of the Engine Controller (left 1 Gb Ethernet port).

7. Open a browser and navigate to the ISIS 2000 Storage Manager Agent Web page via the 
following address: https://192.168.0.10:5015.

8. You are asked for the default password. Type se-admin.

9. Click Network in the left pane of the System tab. 

The ISIS 2000 Storage Manager Agent page appears.

10. Type the following into the Basic Network Configuration window:

- Type the Hostname you want for you Engine Controller.
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- (Option) If using a Gateway, select the Default Gateway checkbox and enter the 
IP addresses of your default gateway.

- Enter the IP addresses of the Engine Controller and Netmask in the Data Interfaces text 
boxes. 

11. Upgrade to the ISIS Storage Manager to match the version on your System Director, see 
“Installing Software on the Engine” on page 73.

12. Verify that the Storage Manager is online with a green icon with no Status displayed in the 
Management Console > Storage Manager page. 

n If any Status errors are listed, call Avid Customer Support.

13. Verify that the Storage Element is online with a green icon with no Status displayed in the 
Management Console > Storage Element page. 

14. Verify that media is available to the ISIS clients. 

Engine Replacement

Use the following procedure when replacing an ISIS Engine. For purposes of this procedure, the 
Engine to be replaced is referred to as “failed Engine” and the replacement Engine as “new 
Engine.”

To replace an ISIS Engine:

1. If the Engine Controller is still accessible through the ISIS Management Console Agent 
Page, log into the ISIS Management Console Storage Manager Agent Page > System tab > 
Network and note the hostname, IP address, and other important network details.

n The default Agent Administrator password is “se-admin.”

If the Engine Controller is not accessible through the ISIS interface, continue with step 2 and 
skip to 4; removing the cables and pulling out the Engine controller.

Leave the ISIS Management Console Storage Manager Agent Page open, you need it access 
the Agent Page in step 3.

2. Stop the System Director service using the ISIS Control Panel or Launch Pad. 

Once the System Director service is stopped, you can only access the Agent page in step 3 
using the Engine IP address you have just noted. 

3. Shutdown the Engine Controller using the Storage Manager Agent Web page via the Engine 
IP address: https://IP_address:5015.

a. Type the Administrator password into the password field.

The ISIS 2000 Storage Manager Agent page appears.
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b. Click the Advanced tab.

c. Select Shutdown from the left pane.

d. Type the Administrator password into the password field and click Shutdown. 

e. Allow 1 minute for the buffers to clear and turn off the power to the Engine (two power 
supply switches).

4. Make note of the locations of all Ethernet cables (1-Gb, 10-Gb) and disconnect them from 
the failed Engine Controller.

5. Switch both power switches to off position on the rear of the failed ISIS 2000 Engine.

6. Disconnect all 1-Gb, 10-Gb (optical), and power cables from the failed Engine.

7. Carefully remove all the media drives from both drawers and put them in a safe place (see 
“Removing a Media Drive” on page 160).

c As a precaution, Avid recommends you record the slot location of the removed drives and 
reinstall them in the same slots. 

8. Carefully remove the Engine Controller from the failed Engine and put it in a safe place (see 
“Engine Controller Replacement” on page 166).

9. Carefully remove both power supplies from the failed Engine and put them in a safe place 
(see “Power Supply Replacement” on page 165).

10. Carefully remove the five cooling modules from the failed Engine and put them in a safe 
place (see “Cooling Module Replacement” on page 164).

11. Remove the failed Engine from the rack.

12. Install the new Engine into the rack (without the drives, modules, and power supplies).
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13. Carefully reinsert all media drives into the same drawers (and slots if possible) they were 
removed from.

14. Carefully reinsert the two power supplies.

15. Carefully reinsert the five cooling modules.

16. Carefully reinsert the Engine Controller.

c The Engine Controller module is only supported in the left slot (as seen from the rear of the 
Engine). Do not install the Engine Controller in the right slot, the software will not run.

n When re-using the original Engine Controller that was in this ISIS environment, you do not need 
to reconfigure Engine Controller. The IP address and ISIS software should be recognized by the 
ISIS System Director and environment. 

17. Reconnect all 1-Gb, 10-Gb (optical), and power cables to the new Engine.

18. Power-on the new Engine.

Give the new Engine at least 2 minutes to initialize.

n If any of the LEDs indicate an error, call Avid Customer Support.

19. Verify that the Storage Manager is online with a green icon with no Status displayed in the 
Management Console > Storage Manager page. 

n If any Status errors are listed, call Avid Customer Support.

20. Verify that the Storage Element is online with a green icon with no Status displayed in the 
Management Console > Storage Element page. 

21. Verify that media is available to the ISIS clients. 

Replacing an Internal System Director Drive

There are two system drives installed in the Avid ISIS System Directors. The two drives are 
mirrored and accessible from the front of the System Director. If you have a failure on either one 
of the two system drives you can pull the failed drive out of the System Director and install a 
replacement without turning off the Avid ISIS System Director. The Avid ISIS continues to run 
properly if one of the two system drives are removed.

As soon as you install a replacement system drive into the vacant system drive slot, the system 
begins the process of creating a mirror of the original drive on the new drive. All Avid ISIS 
operations continue to run uninterrupted.
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To replace the System Director drive:

1. Remove the failed drive from the front of the System Director by releasing the drive latch on 
the front of the drive and pulling the drive from the chassis.

2. Insert the new drive completely into the open drive slot and close the drive latch.

The new drive initiates and completes the repair with no other intervention.

Saving ISIS Metadata

This procedure describes how to save the metadata stored on the system drives in the ISIS 
System Director. This procedure would typically only be needed in the event of a hardware 
replacement where both system drives or the System Director server itself will be replaced in an 
active ISIS installation. 

All the metadata for all the media drives in the Engine are saved in the System Director. The 
Engines do not store any metadata. 

To save the System Director metadata:

1. Stop the System Director service using the ISIS Control Panel. 

n The System Director is constantly writing metadata. Metadata files are always open and locked, 
so the best way to copy the metadata files is to stop the System Director service so the files are 
closed.

2. Copy the Partition0 and Partition1 files from the following location on the System Director:

D:\Program Files\Avid\ISIS System Director\

n There is also a PartitionDump.bin file. This file is also helpful when identifying the data on 
the media drives. If possible, include this file with the two Partition metadata files.

The following are a couple suggested ways of saving the Partition0 and Partition1 
PartitionDump.bin files.

- Use a USB flash drive that has the capacity for the Partitionx files (4 GB recommended).

- Create a network share on a client system on the network and copy the Partitionx files to 
that shared folder. 

3. Verify that you have the current copy of the Metadata by comparing the date in the Metadata 
tab of the ISIS control Panel.

4. Start the System Director service using the ISIS Control Panel.
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Replacing System Drives in the System Director

When moving the systems drives from one System Director to another, the order in which you 
replace these drives in the new System Director should not matter. Although it would be good 
practice to mark the system drives as to the left and right drives and replace them back in the 
same order in the new System Director.

To replace a single failed system drive:

1. Open the Intel Rapid Storage Technology application:

 Start > Programs > Intel > Intel Rapid Storage Technology

2. Click the Manage button in the application. 

A. Run hardware scan button
B. Disk icons
C. Status line

3. Pull the failed drive out of the System Director and install a replacement without turning off 
the System Director. 

Once the drive is installed, use the Intel Rapid Storage Technology application to initiate the 
rebuild operation as described in the following steps. 

AA

BB

CC
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4. Click the Run hardware scan button (identified as A in the above illustration) to refresh the 
RAID data to the current state. 

5. The volume icon has two smaller disk icons attached to it - one for each disk of the RAID 
set. Perform one of the following operations: 

- If the disk has previously been part of the RAID set, the disk appears as an icon attached 
to the Volume 0 icon and the application immediately begins the rebuild. You can 
monitor the status, in this case the status line displays “Rebuilding x% complete.”

- If the replacement disk has never been part of this RAID set, the disk icons display a list 
of available disks. The Status line will display “Degraded,” and the words “rebuild to 
another disk” is underlined. Click on the underlined text.

6. A window opens that offers a choice of drives to add to the array. Click on the one drive that 
needs to be added to the RAID set. The rebuild operation begins immediately. 

You can use the Status line to monitor the status of the rebuild. The top of the screen says 
Manage Volume, and the status line says “Rebuilding x% complete.”

n You can perform other work while the rebuild completes.

To replace both system drives:

1. If both system drives fail, shut down the system, and unplug the power cords.

2. Remove both system drives.

3. Install new system drives into the two system drive slots.

4. Replace the power cords and restart the system.

5. Enter the Intel RAID BIOS by pressing CTRL+I when the text MATRIX RAID BIOS 
appears on the screen.

6. Choose Create the new RAID set. This will create the system drive mirror.

a. Change RAID type from RAID 0 Stripe to RAID 1 Mirror (volume name and capacity 
can be left at the defaults).

b. Select Create RAID, answer yes to the “are you sure” messages.

c. The RAID set (Volume 0) should be shown as online with the two physical disks (port0 
and 1) listed below as array members.

d. Exit the RAID BIOS and allow the system to restart.

7. Turn on your System Director and reimage your system drives which includes loading the 
Windows operating system, see “Using the Product Recovery USB for 64-bit System 
Directors” on page 184.

8. Use the same IP addresses previously assigned.

9. Install the Avid ISIS software on the new system drives, see “Software Installation” on 
page 64. Remember to select the appropriate option between the System Director software.
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10. Stop the System Director service using the ISIS Control Panel.

11. (Option) If this is your System Director copy your last saved Partition0 and Partition1 files 
to the following location on the System Director: Include the PartitionDump.bin file if you 
saved them too. 

D:\Program Files\Avid\ISIS System Director\

12. Start the Management Console and verify that all workspaces are listed. If not, call customer 
support before continuing.

Moving the Metadata to a New System Director

Use the following procedure if you need to move the Metadata from one Avid ISIS System 
Director to another Avid ISIS System Director. 

To move the System Director Metadata:

1. Stop the old System Director service using the ISIS Control Panel. 

2. Copy the Partition0 and Partition1 files from the following location on the System Director:

D:\Program Files\Avid\ISIS System Director\

n There is also a PartitionDump.bin file. This file is also helpful when identifying the data on 
the media drives. If possible, include this file with the two Partition metadata files.

The following are a couple suggested ways of moving the Partition files.

- Use a USB flash drive that has the capacity to move the Partition files.

- Create a network share on a client system on the network and copy the Partition files to 
that shared folder. From the new System Director copy the Partition files into the 
temporary folder.

3. Verify that you have the current copy of the PartitionDump.bin file from the old System 
Director.

4. Start the new Avid ISIS 2000 System Director server and load the System Director software.

5. Stop the new System Director service using the ISIS Control Panel.

6. Configure the virtual name and IP address on the new System Director to match the old 
System Director.

Configure the virtual name in the ISIS System Director Control Panel and IP address using 
the Network Configuration Tool.

n It is acceptable to change the IP address scheme of the new System Director. It is not 
recommended that you change the virtual ISIS name.
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c If using the same IP addresses as the old System Director, make sure to shut down the old 
System Director first to prevent an IP conflict.

7. Copy the Partition0 and Partition1 files (and PartitionDump.bin file if copied) into the 
following location on the new System Director:

D:\Program Files\Avid\ISIS System Director\

8. Start the new System Director service using the ISIS Control Panel.

9. Verify that the System Director is now running. Start the Management Console and verify 
that all workspaces are listed. If not, call customer support before continuing.

Network Switch Replacement

If replacing a switch in the ISIS environment, the following are a few suggestions you need to 
consider before removing the switch. 

• Have a backup copy of the switch configuration file.

• Disable any Link Aggregation that might be set in your ISIS 7500 | 7000 environment. This 
prevents odd network behavior and the inevitable trunking errors.

• Disable any trunking to other switches before removing the switch. Any trunking involved 
with the switch would be part of the configuration file and would help when reconfiguring 
the trunk on the new switch. 

• You do not have to shutdown the System Director or Engines when replacing a switch, 
particularly if you have a redundant switch configuration.

To replace a switch you will need a console connection to the switch and a tftp server. The 
following are high level steps that assumes the failed switch is still capable of making a tftp 
backup. If the switch is completely dead, the configuration will need to either be restored from a 
previous backup or manually configured.

To capture the switch configuration file:

1. Copy the startup configuration of the failed switch to the tftp server.

2. Install the replacement switch.

3. Configure a temporary interface on the new switch to connect to the tftp server (best to use a 
no switchport interface with IP address on same subnet as TFTP server).

4. Copy the backup copy of the old switch startup configuration to the new switch (copy tftp 
startup-config).

5. Reload the switch configuration and old switch configuration should be restored on the new 
switch.
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The specific commands will be different between Cisco and Force10 but they all should be 
in the switch configuration guide.

If a TFTP server is not available:

t Use a console/telnet client such as PUTTY to list the configuration and copy it to a text file, 
which can then be pasted back into the new switch and save to NVRAM.

n The PUTTY scroll back buffer needs to be increased from the default 200 to at least 2000. If you 
increase it to 50000 and make the screen longer and wider you can capture “show tech-support” 
output,

To replace a switch:

1. Disconnect all network cables. 

2. Pull out the power cables from the back of the switch.

3. Replace the failed switch with a new switch in the rack.

4. Replace the power cables in the back of the switch to power the switch on.

5. (Option) If you have transceivers in the failed switch, move the working transceivers into the 
new switch.
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6. (Option) If you have modified Avid’s default Force10 switch configuration, you need to use 
your terminal emulation program or telnet into switch.

Avid ships Force10 switches configured for ISIS 5500 | 5000 configurations. Any changes 
you have made to the default configuration would have to be reapplied. 

Avid provides sample Cisco switch configurations in the ISIS software kit. Any changes you 
have made need to be reapplied. 

7. Reconnect all network cables in the front of the switch.

Adding an ISIS 2000 Engine to Your Infrastructure

Up to five ISIS 2000 Engines are supported in the ISIS 2000 environment, you must be at ISIS 
v4.5 or later to support multiple Engines. The media drives in each Engine can be bound into one 
or two Storage Groups or a single Storage Group for multiple Engines. All Engines work off of 
the System Director. 

n  ISIS 2000 system configurations that include multiple Engines can use either a 1 Gb or 10 Gb 
connection between the System Director and the switch. If using CIFS clients a 10 Gb 
connection between the System Director and the switch is required, see “Connecting Network 
Cables with a 10 Gb System Director Connection” on page 60. 

After noting the necessary network and system component information listed in “Preupgrade 
Information” on page 134, you are ready to upgrade and add Engines to your ISIS environment. 
The following is a typical procedure, review the ISIS ReadMe for any specific instructions to the 
latest release. 

To add ISIS 2000 Engines to your ISIS 2000 infrastructure:

1. Download the ISIS software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

2. Upgrade your exiting ISIS 2000 infrastructure to the latest release as described in “Software 
Upgrade Process” on page 124. 

3. Rack Engine in proper position (see “Rack-Mounting the Equipment” on page 32).

4. Install media drives, cooling modules, power supplies, and Engine Controllers (starting with 
“Installing the Media Drives” on page 48).

5. Apply power to the Engine (see “Connecting Power to Equipment” on page 52).

6. Assign an IP address to the Engine (see “Setting-Up the Network Address On the Engine” 
on page 55).

Repeat step 3 to 6 for each addition ISIS 2000 Engine you are adding to the infrastructure.

http://www.avid.com/US/support/downloads
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7. Connect a 10 Gb optical network cable to left 10 Gb port (as seen from the rear of the 
Engine) on the Engine Controller of the ISIS 2000 Engine. No other 10 Gb port on the 
Engine has been configured for this connection.

The 10 Gb port on the ISIS 2000 Engine Controller requires an SFP+ transceiver.

The following example shows the physical connections between a System Director, Engine, 
and a Force10 S4810 switch. 

Multiple Engines Network Connections

8. Connect the other end of your network cable to the appropriate port on your ISIS 2000 
switch. 

Depending on the type of switch you have, an X2 or SFP+ transceiver might be needed for 
the switch port.
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n The Force10 S4810 switches need SFP+ transceivers with an LC to LC cable connection. The 
Cisco 4900M switches need an X2 transceiver for the SC type connector with an LC to SC cable 
connection. 

9. Repeat steps 7 and 8 for each ISIS 2000 Engine you are adding (up to five ISIS 2000 
Engines are supported). 

10. Modify the switch configuration file for the additional Engines. For information on 
configuring switches, see the Avid Network and Switch Guide. 

11. Select the new Storage Manager in the list.

12. Click Upgrade.

The Upgrade Storage Managers window opens.

13. Select the .zip file, and click Upgrade.

The Storage Manager installation takes approximately 10 minutes.

n Once the Storage Manager upgrade has completed, the software automatically starts building 
the RAID sets in the ISIS 2000 Engines. Due to the size and number of drives in the Engine, the 
RAID configuration takes a couple days to complete. Clients can use the ISIS 2000 system during 
this time although, the more client activity on the Engine, the longer it takes to finish the RAID 
configuration.

14. Select the new Storage Manager from the list and click Details.

Upgrade .zip file

Upgrade
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n The Status for the upgrade is shown in the Details pain at the right of the window. Click the 
Refresh button whenever you want the updated upgrade Status. When the Status is empty, the 
upgrade is complete.

15. Double-click the IP address of the Storage Manager in the Details pane to open ISIS 2000 
Storage Manager Agent Web page. 

16. You are asked for the password. Type se-admin.

The ISIS 2000 Storage Manager Agent page appears.

17. Click Network in the left pane of the System tab. 

18. Enter an IP address in the gx0:1 and Netmask text boxes in the Data Interfaces section. 

Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires 
dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same 
subnet as the original IP address. 

n A second physical cable is not needed, both IP address are handled through the existing 10 Gb 
connection between Engine Controller and the switch. 
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19. Click Submit.

a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

b. A second dialog box appears, type se-admin. in the password box and click Reboot. 

20. When the Engine has restarted, open the Storage Managers page in the Management 
Console.

c Do not add any new ISIS 2000 Engines to this existing Storage Group if the ISIS v4.5 
upgrade data conversion redistribution has not completed.

21. Bind your new Storage Managers, using the ISIS Management Console > Storage Managers 
page. For binding instructions, see “Binding the Storage Managers” on page 78. 

Repeat steps 11 to 21 for each new ISIS 2000 Engine you are adding.

n After the new Storage Managers are Bound, you can add additional ISIS 2000 Engines and Bind 
them. Then select all your new Storage Managers and do a single Add redistribution. For Add 
redistribution instructions see the Avid ISIS Administration Guide.



12 Using the Product Recovery USB for 
64-bit System Directors

This section describes the procedures to recover your Avid ISIS system drive by reinstalling 
Windows Storage Server 2008 R2 and Avid specific additions and changes.

This procedure restores only the Windows operating system and the hardware drivers. It does not 
restore the Avid ISIS software. The Avid ISIS software must be reinstalled separately, after the 
operating system recovery is complete. The version number of the image can be found in the 
C:\IMAGE.TXT file on the root directory of the system drive.

c The Avid ISIS ships with a blank 16GB USB drive is used to create a bootable recovery 
drive. This will be used when the server Operating System needs to be re-imaged. For 
information on creating see “Creating a Product Recovery USB Flash Drive” on page 184.

n After reimaging the server the Administrator password is set to is-admin.

You might need to reinstall the Windows Storage Server 2008 R2 operating system on your Avid 
ISIS System Director if you are directed to do so by Avid Customer Support. The reinstallation 
offers you two options:

• Perform a Windows Storage Server 2008 R2 installation to the entire system. This replaces 
all the data from all the available partitions on your system drive. You can perform this 
operation if you are initializing your system drive.

c You lose metadata if you restore all the partitions of the drive.

• Perform this operation to replace only the operating system on your system drive. Typically 
this removes the first partition (C:); the other partitions are not changed. 

Creating a Product Recovery USB Flash Drive

Avid highly recommends you copy the image to the 16 GB USB flash drive provided with your 
Avid ISIS as part of your initial setup. The following procedure describes how to create the 
product recovery USB flash drive. The product recovery image is included in the C:\Image folder 
of the system drive. 
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Once you have created the bootable USB flash drive using the Product Recovery tool, use the 
USB flash drive to reinstall the operating system image (and associated drivers) to the original 
state as when it was shipped from Avid. 

c When you perform a full product recovery of the Avid ISIS system drive using the product 
recovery USB flash drive, you lose the product recovery image in the C:\Image folder of the 
system drive.

To create a product recovery USB flash drive:

1. Locate the 16 GB USB flash drive Avid provided with the Avid ISIS and insert it into the 
front USB port.

2. Click “Create Recovery USB Drive” from the installer splash screen or double-click the 
AvidRecoveryImageTool.exe file included in the software installer kit from the following 
location:

\AvidISISUtilities\

n A direct link to this file is included in the software install splash screen (Create Recovery USB 
Drive).

The Avid USB recovery image creator window opens.

3. Click Select Image to locate the product recovery image from the C:\Image folder of the 
Avid ISIS system drive (you need to browse to the location of the .ari file). 
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4. Select the .ari file.

The Scan button becomes active when you select the image file. The “Select USB flash 
drive” menu lists USB devices that are installed and capable of accepting the image file. If 
the inserted USB flash drive does not appear in the drop down menu, verify the capacity of 
the USB flash drive.

5. Click Scan.

6. Select the USB flash drive from the “Select USB flash drive” menu.

The Write image button becomes active when you select the USB flash drive. 

7. Click Write image.

n Creating the product recovery image on the USB flash drive can take 18 to 45 minutes depending 
on the capabilities of the USB flash drive. 

8. Click OK to acknowledge the warning about losing all previous data on the USB flash drive.

The Write image button becomes a Cancel button when the image is being created. If you 
cancel the write image process, the process starts over from the beginning on the next 
undertaking. 

9. Click Ok when process is completed.

10. The USB flash drive appears in the taskbar as an icon. Remove the USB flash drive as 
follows:

a. Double-click the USB icon in the taskbar. A pop-up menu appears with a list of attached 
USB devices.

a. Select the USB flash drive with the product recovery image.

b. Click Stop.

c. Click OK to remove the selected USB device.

d. Remove the USB flash drive from the Avid ISIS.

Reinstalling the Windows Storage Server 2008 R2 
Operating System

To reinstall the Windows Storage Server 2008 R2 operating system from the Avid Product 
Recovery flash drive:

1. Make sure all clients stop any activity and unmount their workspaces.

2. All clients need to exit Client Manager.

3. Locate the Product Recovery Image USB flash drive with the Avid ISIS image.
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4. Use the System Director Control Panel to stop the System Director.

5. Insert USB flash drive into the USB port in the system.

n You must enter the BIOS with USB flash drive plugged-in to set correct drive boot order.

6. Select Start > Shut Down. 

The Shut Down Windows dialog box opens.

7. Select Restart, and click OK. 

The Windows Storage Server 2008 R2 operating system restarts.

8. Press the Delete key several times during startup until you see “Entering Setup.”

9. Set the USB Drive to boot first. Navigate to the Boot tab > Hard Disk Drives > 1st Drive and 
select the default USB setting detected by the BIOS. The 2nd Drive setting changes to the 
“RAID: Intel Volume.”

n Depending on the manufacturer of the USB flash drive, the USB selection in the BIOS changes.

10. Select the Advanced tab > CPU Configuration, make sure the hyper thread option “Intel HT 
Technology” is [Disabled].

11. Select the Advanced tab > APM Configuration, make sure “Restore on Power Loss” is set to 
[Last State].

12. Press F10 to Exit and Save your changes.

The system continues to start from the USB flash drive.

Wait until two windows appear, click on the blue window and select one of the available 
options:

- Recover the OS partition only.

- Recover the entire system disk.

- Exit without doing a recovery.

13. At the prompt, type the number of the operation you want to perform: 

t If you type 1 or 2, a warning screen opens, informing you that you are about to recover 
the operating system. Continue with step 14.

t If you type 3, the recovery quits to the Main menu. You need to type 3 again to get to 
command window. Press Ctrl+Alt+Delete to quit in any of these windows. 

14. A yellow screen appears type Y.

15. A red screen appears type Y.

The reimaging takes 20 to 30 minutes.
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c Do not remove the USB flash drive while performing the product recovery. If you remove 
the USB flash drive an error is displayed stating it cannot write the Ghosterr.txt file. If the 
USB flash drive was removed, you cannot continue the process by re-installing the USB 
flash drive. You would have to start the recovery process from the beginning.

16. A gray screen prompts you to reboot. Type R, and quickly remove the USB flash drive from 
the system.

Configure the operating system as described in the following section. The Apply Computer 
Setup message is displayed for 3 to 5 minutes.

Configuring the System Drive Using Windows 2008 
Storage Server Setup

After you recover the Windows Storage Server 2008 R2 operating system, several system 
parameters are set including a system Disk Check. The system restarts, and you are prompted to 
enter the Windows activation key. This number is on the Windows Certificate located on the 
System Director top cover. You need this Windows number in the following procedure. 

To set up the Windows operating system:

1. (If removed) Reconnect all the network Ethernet cables.

2. After the system has restated, select the country, time, and keyboard settings and click Next. 

3. When the Product Key screen opens, type the Product Key from the Certificate of 
Authenticity in the Product Key text box. The certificate is on the top of the Avid ISIS 
System Director. 

c The Product Key Authenticity is verified with Microsoft through an Internet connection. If 
you do not have the Avid ISIS connected to an in-house network, you need to phone in your 
Product Key and get an Authenticity number back from Microsoft.

The Windows Storage Server 2008 R2 Setup utility starts, and the a dialog box opens 
showing the License Agreement screen.

4. Click Next. 

5. Select “I accept the license terms.”

6. Click Next. 

7. Log on as Administrator and is-admin as the password.

8. After log on, customize the system and local settings. See the Windows documentation for 
more information.

t Customize the system and local settings.
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t You might want to create a new system administrator name and password.

t Company Name and Organization.

t Date and Time Settings.

t Network Workgroup and Computer Domain settings.

c When the operating system is restored in the Avid ISIS Engine, a unique computer host 
name is created based on the MAC ID of the system board. Each time you re-image your 
Avid ISIS Engine, the same name will be generated. If you have changed the computer host 
name of your Avid ISIS Engine, you need to reapply your computer host name again. 

9. Start the system and install Avid ISIS software, see “Loading the Software” on page 65.



13 Specifications and Notices

This section provides information on the dimensions and weight, the environmental, the 
electrical, and the power cord specifications for the Avid AS3000 when used as the ISIS 2000 
System Director. It also recommends the use of an Uninterruptible Power Supply and supported 
network cabling.

Dimensions and Weight

The following table lists the dimensions and weight.

Environment

The following table lists the environmental specifications.

Component Dimensions and Weight  

Component Height Width Depth Weight

AS3000 System 
Director

1.75 in (44.4 mm) 19 in (482.6 mm) 27 in (685.8 mm) 40.0 lb (18.1 kg)
with drives installed

ISIS 2000 Engine 8.75 in 
(222.3mm)

19 in (482.6 mm) 36 in (915 mm) 287.5 lb (130.4 kg)
with 84 drives 
installed

Environmental Specifications  

Component
Operating 
Temperature

Operating
Humidity

Storage 
Temperature

AS3000 System Director 41°F to 95°F 
(5°C to 35°C)

5% to 95% (at 38°C) 
non-condensing

–4°F to 140°F 
(–20°C to 60°C)

ISIS 2000 Engine 41°F to 95°F 
(5°C to 35°C)

20% to 80% 
non-condensing

–40°F to 158°F 
(–40°C to 70°C)
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Electrical

The power cable that comes with the ISIS 2000 Engine is a C19 to 20 power cable. The C19 end 
is a female connector which plugs into the power supply on the Engine. The C20 end is a male 
connector, used to plug into a Power Distribution Unit (PDU) with C19 style connectors. The 
following table lists the electrical specifications.

Uninterruptible Power Supply (UPS)

Avid highly recommends you create a separate derived power system for your ISIS 2000 System 
Director. This provides protection against sudden power surges or losses that could cause you to 
lose files or experience data corruption.The power outlets need to be from the same distribution 
panel. This helps prevent ground loops that can be caused by plugging equipment into power 
sources with different ground potentials. Make sure there is adequate, dedicated power for the 
UPSs.

w You should have all the electrical work at your site done by a licensed electrician. The 
electrical changes must meet country, state, and local electrical codes.

The ISIS 2000 System Director supports UPS devices that are connected using network 
connections, USB connections, and serial connections. Install the software from the UPS 
manufacturer for advanced shutdown behavior, calibrate the UPS device. These software 
packages also allow for a connected Windows server to send alerts to other Windows servers to 
perform actions.

If your ISIS 2000 System Director is connected to a network, network policy settings might also 
prevent you from completing this procedure. Make sure there is adequate power and the correct 
receptacle type for each hardware component, the rack power strips, and the UPSes. Do not use 
extension cords to plug in any of the hardware components. 

Electrical Specifications  

Component Voltage Frequency Watts (Max. U.S.)

 AS3000 System Director 100 to 240 Vac

Two hot-swap redundant 
AC power supplies

50 to 60 Hz 650 W

 ISIS 2000 Engine 208 to 240 Vac

Two hot-swap redundant 
AC power supplies

50 to 60 Hz 2800 W
9554 BTU
13 amps (maximum)
10 amps (typical)
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Supported Cabling

Avid supports the following cable types for connecting an ISIS 2000 System Director system.

n If you need run your cable greater distances, call Avid Customer Support for supported cable 
and accessory information. 

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length

Ethernet network cable, 
Cat 5e, Cat 6, Cat 6a or 
Cat 7

Connects:

Ethernet shared storage clients

System Directors and clients 
to 1 Gb ports on an ISS

Avid Interplay servers to 
shared storage networks 

Avid AirSpeed capture and 
playback servers to shared 
storage networks

Avid ISIS management port 
to a laptop

RJ45 connector

100 Meters; If using CAT5e the cable must be 
rated for 350 MHz for maximum length. 

The minimum GigE cable length for Avid 
network products is 6 feet or 2 meter.
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Optical cables Connects:

1 Gb switch port to 1 Gb 
client

• Windows – Intel Pro 1000 
PF

• Macintosh – Small Tree 
PEG2F

10-Gb port of switch to 
optical 10-Gb port on the Avid 
ISIS Engine.

ISS 10-Gb optical port to 
switch port

ISS 10-Gb optical port to 
10-Gb Ethernet Client

10-Gb Client to 10 Gb Switch 
port

10-Gb Ethernet switch to 
10-Gb Ethernet Switch

ISS to 10-Gb adapter in 
Move/Copy service

The maximum length for optical Ethernet 
cables is limited by the core diameter 
(measured in microns) and modal bandwidth 
(in units of MHz*km). 

Avid supports multi-mode fiber (MMF) cable 
using 850 nm transceivers (1000BASE-SX 
short distances). Specifications for these cables 
can be found in the ISO 11801 structured 
cabling document.

• OM1 (62.5/125) —

- 100 Mb Ethernet, up to 2000 meters 
(FX)

- 1 Gb Ethernet, 275 meters (SX)

- 10 Gb Ethernet, 33 meters (SR)

• OM2 (50/125) — 

- 100 Mb Ethernet, up to 2000 meters 
(FX)

- 1 Gb Ethernet, 550 meters (SX)

- 10 Gb Ethernet, 82 meters (SR)

• OM3 (50/125) — 

- 100 Mb Ethernet, up to 2000 meters 
(FX)

- 1 Gb Ethernet, 550 meters (SX)

- 10 Gb Ethernet, 300 meters (SR)

• OM4 (50/125) — 

- 100 Mb Ethernet, up to 2000 meters 
(FX)

- 1 Gb Ethernet, 1000 meters (SX)

- 10 Gb Ethernet, 550 meters (SR)

Avid supports single-mode fiber cable using 
1310 nm transceivers (long distances):

• SMF ITU G.652.A/B 9 micron cable up to 
10 km

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length
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c When connecting to the 10 Gb port, it is important to follow two rules: 
– Ensure that the cable has the required modal bandwidth for the distance of the run.
– Make sure that all multimode cables between an switch port and the other end of the cable 
run are of the same diameter (for example, 50/125 um or 62.5/125 um).

w Single mode transceivers are Class 1 laser product per IEC 60825-1 Amendment 2(2001) and 
IEC 60825-2 1997. Operating this product in a manner inconsistent with intended usage and 
specification may result in hazardous radiation exposure. 

Avid ISIS 
X2 optical transceivers

Transceiver used in:

Cisco C4948-10GE and 
C4900M

SC connector

X2 = Cisco X2-10GB-SR for MMF 
X2 = Cisco X2-10GB-LR for SMF

n The minimum cable length for -LR and 
-SR transceivers is 2 meters.

Avid ISIS 
XFP optical transceivers

Transceiver used in:

Force10 S25N and S25P 
switches and 
ISIS 7500 | 7000 ISS 1000

LC connector

XFP = 10G-XFP-SR for MMF
XFP = 10G-XFP-LR for SMF

XFP = 10G-XFP-SR 
or Picolight XXL-SC-S45-21 for MMF

XFP = 10G-XFP-LR 
or Bookham 10G-BASE-LR for SMF

n The minimum cable length for -LR and 
-SR transceivers is 2 meters.

Avid ISIS 
SFP+ optical 
transceivers

Transceiver used in:

Force10 S25P and S60 optical 
switches and ISIS ISS2000

LC connector

• SFP+ multi-mode short range (SR) 850nm

JDSU – PLRXPL-SC-S43-21-N
JDSU – PLRXPL-SC-S43-22-N
Avago – AFBR-700SDZ
Avago – AFBR-703SDZ

• SFP+ long range (LR)

Finisar FTLX1471D3BCL for SMF
Avago AFCT-701SDZ for SMF
JDSU JSH-01LWAA1 for SMF

n The minimum cable length for -LR and 
-SR transceivers is 2 meters.

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length
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Cisco C4948E SPF+ – 10G-SR for MMF 
SPF+ – 10G-LR for SMF

n The minimum cable length for -LR and 
-SR transceivers is 2 meters.

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length



A Safety and Regulatory Information

This document contains safety and regulatory information for Avid hardware.

• Warnings and Cautions

• FCC Notice

• Canadian Notice (Avis Canadien)

• LED Safety Notices

• European Union Declaration of Conformity

• Disposal of Waste Equipment by Users in the European Union

• Argentina Conformity

• Australia and New Zealand EMC Regulations

• Japan EMC Regulations

• Korean EMC Regulations

• Taiwan EMC Regulations

Warnings and Cautions

c This equipment is intended only for installation in a RESTRICTED ACCESS LOCATION.

c Never install equipment if it appears damaged.

c Disconnect the power cord before servicing unit.

c Only perform the services explicitly described in this document. For services or procedures 
not outlined in this document, speak with authorized Avid service personnel.

c Follow all warnings and cautions in the procedures.

c Operate the device within its marked electrical ratings and product usage instructions.

c If you need to replace a battery in an Avid hardware unit, be sure to use the correct battery 
type. There might be a risk of explosion if a battery is replaced by an incorrect type. 
Dispose of used batteries according to the manufacturer's instructions.
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c For products with a power switch the main power switch should remain accessible after 
installation.

(Hebrew Warnings and Cautions)

FCC Notice
Part 15 of the Federal Communication Commission Rules and Regulations has established Radio 
Frequency (RF) emission limits to provide an interference free radio frequency spectrum. Many 
electronic devices produce RF energy incidental to their intended purpose. 

Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which 
case the user will be required to correct the interference at personal expense.
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Modifications

The FCC requires the user to be notified that any changes or modifications made to Avid 
hardware that are not expressly approved by Avid Technology may void the user’s authority to 
operate the equipment.

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI 
connector hoods in order to maintain compliance with FCC Rules and Regulations.

Canadian Notice (Avis Canadien)

Class A Equipment

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.

LED Safety Notices

Avid hardware might contain LED or Laser devices for communication use. These devices are 
compliant with the requirements for Class 1 LED and Laser Products and are safe in the intended 
use. In normal operation the output of these laser devices does not exceed the exposure limit of 
the eye and cannot cause harm.

Standard to which conformity is declared: (Class 1 LED Product per IEC 60825-1:2007)
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(Hebrew LED Safety Notices)

European Union Declaration of Conformity

Declaration of conformity
Konformitätserklärung
Déclaration de conformité
Declaración de Confomidad
Verklaring de overeenstemming
Dichiarazione di conformità

We/Wir/Nous/WIJ/Noi:

Avid Technology
75 Network Drive
Burlington, MA, 01803 USA

European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.
Sandyford Industrial Estate
Unit 38, Carmanhall Road
Dublin 18, Ireland
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declare under our sole responsibility that the product,
erklären, in alleniniger Verantwortung,daß dieses Produkt,
déclarons sous notre seule responsabilité que le produit,
declaramos, bajo nuestra sola responsabilidad, que el producto,
verklaren onder onze verantwoordelijkheid, dat het product,
dichiariamo sotto nostra unica responsabilità, che il prodotto,

Product Name(s): ISIS 2000

Model Number(s): 7020-30088-XX

Product Option(s): This declaration covers all options for the above product(s).

to which this declaration relates is in conformity with the following standard(s) or other 
normative documents.
auf das sich diese Erklärung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n) 
übereinstimmt.
auquel se réfère cette déclaration est conforme à la (aux) norme(s) ou au(x) document(s) 
normatif(s).
al que se refiere esta declaración es conforme a la(s) norma(s) u otro(s) documento(s) 
normativo(s).
waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt.
a cui si  riferisce questa dichiarazione è conforme alla/e seguente/i norma/o documento/i 
normativo/i.

The requirements of the European Council:

Safety: Directive 2006/95/EC

UL 60950-1, 2nd edition
CAN/CSA-C22.2 No. 60950-1-07; 2007
IEC 60950-1, 2nd edition
EN 60950-1:2006

EMC: Directive 2004/108/EC

EN55022:2006 /A1:2007
EN55024:1998 /A1:2001 /A2:2003
EN61000-3-2:2006
EN61000-3-3:2008

Issued In Burlington MA, USA 2010
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Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not be disposed of 
with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing 
it over to a designated collection point for the recycling of waste electrical and electronic 
equipment. The separate collection and recycling of your waste equipment at the time of disposal 
will help conserve natural resources and ensure that it is recycled in a manner that protects 
human health and the environment. For more information about where you can drop off your 
waste equipment for recycling, please contact your local city recycling office or the dealer from 
whom you purchased the product.

Argentina Conformity

Made in USA

Australia and New Zealand EMC Regulations

Ken Hopkins
Avid Technology (Aust) Pty Ltd
c/o – Elliot House
Suite 810, Level 8
140 Arther St
North Sydney
NSW – 2060
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Japan EMC Regulations

Class A Equipment

This is a Class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take corrective actions. VCCI-A

Korean EMC Regulations

Class A Equipment

Please note that this equipment has obtained EMC registration for commercial use. In the event 
that it has been mistakenly sold or purchased, please exchange it for equipment certified for 
home use.

Taiwan EMC Regulations
Taiwan EMC Regulations BSMI Class A EMC Warning
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Warning Statement

1. UV ray radiation

- Following statement or equivalent:

- Following marking or other equivalent marking:

2. Operator touchable area protection

Operation manual should have following statement and statement should be shown on 
device, or put on similar sentence:

3. Heat-related hazards

Injury may result from high temperatures under normal operating conditions, causing:

- Burns due to contact with hot accessible parts

- Degradation of insulation and of safety-critical components

- Ignition of flammable liquids

Examples of measures to reduce risks include:

- Taking steps to avoid high temperature of accessible parts

- Avoiding temperatures above the ignition point of liquids

- Provision of marking to warn USERS where access to hot parts is unavoidable

High temperature warning marking — you may use the following high temperature warning 
marking:
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4. Mechanical hazards

Injury may result from:

- Sharp edges and corners

- Moving parts which have the potential to cause injury

- Equipment instability

- Flying particles from imploding cathode ray tubes and exploding high pressure lamps

Examples of measures to reduce risks include:

- Rounding of sharp edges and corners

- Guarding

- Provision of SAFETY INTERLOCKS

- Providing sufficient stability to free-standing equipment

- Selecting cathode ray tubes and high pressure lamps that are resistant to implosion and 
explosion respectively

- Provision of markings to warn USERS where access is unavoidable

5. Radiation

Injury to USERS and to SERVICE PERSONS may result from some forms of radiation 
emitted by equipment.

Examples are sonic (acoustic), radio frequency, infra-red, ultraviolet and ionizing radiation, 
and high intensity visible and coherent light (lasers).

Examples of measures to reduce risks include:

- Limiting the energy level of potential radiation sources

- Screening radiation sources

- Provision of SAFETY INTERLOCKS

- Provision of markings to warn USERS where exposure to the radiation hazard is 
unavoidable

6. Chemical hazards

Injury may result from contact with some chemicals or from inhalation of their vapors and 
fumes.
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Examples of measures to reduce risks include:

- Avoiding the use of constructional and consumable materials likely to cause injury by 
contact or inhalation during intended and normal conditions of use

- Avoiding conditions likely to cause leakage or vaporization

- Provision of markings to warn USERS about the hazards

7. Safety warning statement for equipment that is under hazardous voltages

8. Equipment with touch current exceeding 3.5 mA

One of the following labels, or a label with similar wording, shall be affixed adjacent to the 
equipment AC MAINS SUPPLY connection:

9. An EUT that provides TELECOMMUNICATIONS NETWORK connection ports for 
connection of multiple items of other telecommunications equipment shall not create a 
hazard for USERS and TELECOMMUNICATIONS NETWORK SERVICE 
PERSONS due to summation of TOUCH CURRENT
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10. Replaceable batteries

If an equipment is provided with a replaceable battery, and if replacement by an incorrect 
type could result in an explosion (for example, with some lithium batteries), the following 
applies:

- If the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking 
close to the battery or a statement in both the operating and the servicing instructions

- If the battery is placed elsewhere in the equipment, there shall be a marking close to the 
battery or a statement in the servicing instructions

The marking or statement shall include the following or similar text:
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11. Warning to service persons

Suitable markings shall be provided on the equipment or a statement shall be provided in the 
servicing instructions to alert a SERVICE PERSON to a possible hazard, where both of the 
following conditions exist:

- Where a fuse is used in the neutral of single-phase equipment either permanently 
connected or provided with a non-reversible plug

- Where, after operation of the fuse, parts of the equipment that remain energized might 
represent a hazard during servicing

The following or similar wording is regarded as suitable:
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After 188
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Chassis See Engine
Checklist
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preupgrade 134
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Clear foreign disk configuration 128, 131, 163, 167, 170
Clearance 34
Client

architecture 27
installers 83
operating systems 15

Client Manager
auto-connect 87
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connecting from Zone clients 88
documentation 12, 65
Preferences dialog box 88

Client Manager maintenance 142
Complete shutdown 142
Components, space for changing 34
Configure

FTP 116
System Director Control Panel 72, 93, 97, 103
virtual name 72, 93, 97, 103
Windows operating system 188

Configure the Virtual Addresses 96, 99
Connecting cables 34
Connector

USB 16
Control panel

System Director 72, 93, 97
Control panel, System Director 16, 20, 139
Cooling module

described 21
Cooling modules

location 21
Create

New Active file system 73, 95, 98
Workspaces 79

Create New Active 72, 93, 97, 103
Create spare disk

Advanced tab
Create spare disk 128, 131, 163, 167, 170

Crossover connection validation 100

D
Daily maintenance 138
Deactivate License software 109
Device ID 105
Dimensions 190
Documentation

client software 12, 65
Drive

activity 17
flash 184

Dump metadata 72, 93, 97, 103

E
EIA rack units 33, 42

Enclosure Management 157
Enclosure storage 25

Upgrade 127
Engine

configurations 25
described 18
front view 19
media drive slots 25
power supplies 21
rear view 21
replacement 170
upgrade 127

Engine Controller
Controller, Engine 21
Engine Controller shutdown 129, 168, 171

Engine Post Configuration 70
Environmental requirements 190
ESD precautions 144
European Union notice 199

F
Failover

binding order 101
described 18

Fan LED 156
Fans 21, 22
Fault indicator LEDs 21
FCC notice 197
Flash drive

recovery 184
USB 65

Flash software 84
Format foreign disks 131
Format foreign disks See Clear foreign config
Foundry 194
Front panel controls, System Director 16, 19
FTP, configure 116

G
Green LEDs 17, 21
Groups, RAID 25

H
Hardware Faults 144
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Health check 123, 157
Health Monitor 101
Host 88
Host name change, System Director 110

I
Indicator

fault 23
Indirect license activation 107
Initial slot configuration 25
Install software 65
Installation, in a rack 33
Installer

splash screen 65
Installer kit 65
Intel Network Connections 68
Internal

space for changing drives 34
Interplay Framework 101
ISIS Client Installers 69, 69
ISIS SNMP Extension Agent 69

J
JDSU 194
JDSU, SFP+ 194

K
KVM switch 54

L
Launch pad icon 81, 102
LED 144

fan 156
power supply 23
system drive 17
system ID 17, 20
system status 17, 21

Length, cable 192
License key

activation 71
License software

activation 105
deactivate 109

host name change 110
Loading software 65
Log in 78

M
Macintosh clients 82
Maintenance

check system health 123, 157
Client Manager 142
daily 138
weekly 140

Management Console
bind 78
password 55, 78

Maximum
storage 24

Maximum length 192
Micron cable 193
Modal bandwidth 193
Module locations 21
Monitor

VGA connector 54
Multi-mode fiber cable 193
Myricom Network Connection 68

N
Network

activity LEDs 17
zones 29

Network connection
binding order 101

New Zealand EMC regulations 201
NMI (non-maskable interrupt) button 17, 20, 23
No spare, import disk 128, 131, 163, 167, 170

O
Online support 12
Operating system

clients 15
configure 188
reinstall 186

Operating system password 184
Optical cable 193
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P
Packets received 100
Password

agent page 56, 76, 125, 129, 163, 182
Management Console 55, 78
operating system 184
System Director 15, 55, 117

PathDiag Tool 132
Power

button 17, 20, 23
cord connection 53
specifications 191

Power supply
described 22
location 21

Power switch 23
Preferences (Client Manager) 88
Preupgrade information 134
Product recovery, flash drive 184

R
Rack

installation 41
mounting instructions 33
position 35
rack units 35
requirements 34

Rack-mount
installation 33, 42
requirements 34

RAID 6 groups 25
Rear panel, System Director 17
Received packets 100
Recommended maintenance 138
Recovery flash drive 184
Red LED 17
Regulatory information 197
Reinstall Windows 186
Remote Host 88
Replace

engine 170
switch 178

Requirements for rack mounting 34

S
Safety information 197
Server room shutdown 142
Servicing, space for 34
SFP+ 194
Shutdown 129, 168, 171
Shutdown server room 142
Slot

storage configuration 25
storage upgrade configuration 127

Software
Flash 84
installer described 67, 67, 68
license 105
loading 65

Software upgrade 124, 179
Space for changing components 34
Specifications

dimensions and weights 190
environmental 190
power 191

Splash screen 65
Status messages

storage elements 139
Stop System Director 72, 93, 97, 103
Stop/Start server 72
Storage Blade

password 55
Storage drive

function 18
slot positions 19

Storage elements 24
See also Storage blade
status 139

Storage Groups
size 24

Storage limit 24
Storage Manager Agent

default password 128, 131, 167, 170
password 163

Supported cables 192
Switch

KVM 54
replacement 178
VLAN for ISIS 2000 29, 71

System 17
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drive LED 17
fault indicator 23
ID LED 17
power supply LED 23
reset button 17, 20
status LED 17, 21
unit ID LED 20

System Director
2U rack size 15
Control Panel 72, 93, 97, 103, 139
Create New Active file system 73, 95, 98
front control panel 16, 20
front panel 16, 19
host name change 110
log in 78
password 15, 55, 78, 117
rear panel 17
recovery 184
second 18
software 68
stop/start service 72

System disk 16, 19
System error 17, 21
System ID 105

T
Taiwan EMC regulations 202
Task bar icon 81, 102
Thermal

alarm 156
monitoring 155

Training services 13
Transceivers 194, 194
Troubleshooting 12

check health 123, 157
recommended maintenance 138

U
Upgrade

media drives 116
post upgrade verification 132
preupgrade checklist 134
procedure 124, 179
software 124, 179

USB (universal serial bus)

connector 16
flash drive 65, 184
keyboard and mouse 54
port described 16
software installer 65
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